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Regulatory Compliance

Thermo Fisher Scientific performs complete testing and evaluation of its products to ensure full compliance with 
applicable domestic and international regulations. When the system is delivered to you, it meets all pertinent 
electromagnetic compatibility (EMC) and safety standards as described below.

EMC Directive 89/336/EEC as amended by 92/31/EEC and 93/68/EEC
EMC compliance has been evaluated by TUV Rheinland of North America.

Low Voltage Safety Compliance
Compliance with safety issues is declared under Thermo Fisher Scientific sole responsibility.
This device complies with Low Voltage Directive 73/23/EEC and harmonized standard EN 61010-1:2001.

Changes that you make to your system may void compliance with one or more of these EMC and safety standards. 
Changes to your system include replacing a part or adding components, options, or peripherals not specifically 
authorized and qualified by Thermo Fisher Scientific. To ensure continued compliance with EMC and safety 
standards, replacement parts and additional components, options, and peripherals must be ordered from 
Thermo Fisher Scientific or one of its authorized representatives.

FCC Compliance Statement

EN 55011 1998, A1; 1999, A2: 2002 EN 61000-4-3 2002

EN 61000-3-2 1995, A1; 1998, A2; 1998, A14; 2000 EN 61000-4-4 1995, A1; 2000, A2; 2001

EN 61000-3-3 1995; A1; 2001 EN 61000-4-5 1995, A1; 2001

EN 61326-1 1997; A1; 1998, A2; 2001, A3; 2003 EN 61000-4-6 1996, A1; 2001

EN 61000-4-2 2001 EN 61000-4-11 1994, A1; 2001

CISPR 11 1998, A1; 1999, A2; 2002

FCC Class A, CFR 47 Part 15 and Part 18, 2005

THIS DEVICE COMPLIES WITH PART 15 OF THE FCC RULES. OPERATION IS SUBJECT TO 
THE FOLLOWING TWO CONDITIONS: (1) THIS DEVICE MAY NOT CAUSE HARMFUL 
INTERFERENCE, AND (2) THIS DEVICE MUST ACCEPT ANY INTERFERENCE RECEIVED, 
INCLUDING INTERFERENCE THAT MAY CAUSE UNDESIRED OPERATION.



Notice on Lifting and Handling of
Thermo Fisher Scientific San Jose Instruments

For your safety, and in compliance with international regulations, the physical handling of this Thermo Fisher 
Scientific San Jose instrument requires a team effort to lift and/or move the instrument. This instrument is too heavy 
and/or bulky for one person alone to handle safely.

Notice on the Proper Use of
Thermo Fisher Scientific San Jose Instruments

In compliance with international regulations: Use of this instrument in a manner not specified by Thermo Fisher 
Scientific San Jose could impair any protection provided by the instrument.

Notice on the Susceptibility 
to Electromagnetic Transmissions

Your instrument is designed to work in a controlled electromagnetic environment. Do not use radio frequency 
transmitters, such as mobile phones, in close proximity to the instrument.

CAUTION Read and understand the various precautionary notes, signs, and symbols contained inside 
this manual pertaining to the safe use and operation of this product before using the device.



WEEE Compliance

This product is required to comply with the European Union’s Waste Electrical & Electronic 
Equipment (WEEE) Directive 2002/96/EC. It is marked with the following symbol:

Thermo Fisher Scientific has contracted with one or more recycling or disposal companies in each 
European Union (EU) Member State, and these companies should dispose of or recycle this product. 
See www.thermo.com/WEEERoHS for further information on Thermo Fisher Scientific’s compliance 
with these Directives and the recyclers in your country.

WEEE Konformität

Dieses Produkt muss die EU Waste Electrical & Electronic Equipment (WEEE) Richtlinie 2002/96/EC 
erfüllen.  Das Produkt ist durch folgendes Symbol gekennzeichnet:

Thermo Fisher Scientific hat Vereinbarungen mit Verwertungs-/Entsorgungsfirmen in allen EU-
Mitgliedsstaaten getroffen, damit dieses Produkt durch diese Firmen wiederverwertet oder entsorgt 
werden kann. Mehr Information über die Einhaltung dieser Anweisungen durch Thermo Fisher 
Scientific, über die Verwerter, und weitere Hinweise, die nützlich sind, um die Produkte zu 
identifizieren, die unter diese RoHS Anweisung fallen, finden sie unter  www.thermo.com/
WEEERoHS. 

http://www.thermo.com/WEEERoHS
http://www.thermo.com/WEEERoHS
http://www.thermo.com/WEEERoHS
http://www.thermo.com/WEEERoHS


Conformité DEEE

Ce produit doit être conforme à la directive européenne (2002/96/EC) des  Déchets d'Equipements 
Electriques et Electroniques (DEEE). Il est marqué par le symbole suivant:

Thermo Fisher Scientific s'est associé avec une ou plusieurs compagnies de recyclage dans chaque état 
membre de l’union européenne et ce produit devrait être collecté ou recyclé par celles-ci. Davantage 
d'informations sur la conformité de Thermo Fisher Scientific à ces directives, les recycleurs dans votre 
pays et les informations sur les produits Thermo Electron qui peuvent aider la détection des substances 
sujettes à la directive RoHS sont disponibles sur www.thermo.com/WEEERoHS. 

http://www.thermo.com/WEEERoHS
http://www.thermo.com/WEEERoHS


CA
U

TI
O

N
 S

ym
bo

l
CA

U
TI

O
N

VO
RS

IC
H

T
AT

TE
N

TI
O

N
PR

EC
A

UC
IO

N
AV

VE
RT

EN
ZA

El
ec

tr
ic

 S
ho

ck
: T

hi
s 

in
st

ru
m

en
t u

se
s 

hi
gh

 v
ol

ta
ge

s 
th

at
 c

an
 c

au
se

 p
er

so
na

l 
in

ju
ry

. B
ef

or
e 

se
rv

ic
in

g,
 s

hu
t d

ow
n 

th
e 

in
st

ru
m

en
t a

nd
 d

is
co

nn
ec

t t
he

 in
st

ru
m

en
t 

fro
m

 li
ne

 p
ow

er
. K

ee
p 

th
e 

to
p 

co
ve

r o
n 

w
hi

le
 o

pe
ra

tin
g 

th
e 

in
st

ru
m

en
t. 

Do
 n

ot
 

re
m

ov
e 

pr
ot

ec
tiv

e 
co

ve
rs

 fr
om

 P
CB

s.

El
ek

tr
os

ch
oc

k:
 In

 d
ie

se
m

 G
er

ät
 w

er
de

n 
Ho

ch
sp

an
nu

ng
en

 v
er

w
en

de
t, 

di
e 

Ve
rle

tz
un

ge
n 

ve
ru

rs
ac

he
n 

kö
nn

en
. V

or
 

W
ar

tu
ng

sa
rb

ei
te

n 
m

uß
 d

as
 G

er
ät

 
ab

ge
sc

ha
lte

t u
nd

 v
om

 N
et

z g
et

re
nn

t 
w

er
de

n.
 B

et
re

ib
en

 S
ie

 W
ar

tu
ng

sa
rb

ei
te

n 
ni

ch
t m

it 
ab

ge
no

m
m

en
em

 D
ec

ke
l. 

N
eh

m
en

 
Si

e 
di

e 
Sc

hu
tz

ab
de

ck
un

g 
vo

n 
Le

ite
rp

la
tte

n 
ni

ch
t a

b.

Ch
oc

 é
le

ct
ri

qu
e:

 L’
in

st
ru

m
en

t u
til

is
e 

de
s 

te
ns

io
ns

 c
ap

ab
le

s 
d’

in
fli

ge
r d

es
 b

le
ss

ur
es

 
co

rp
re

lle
s.

 L’
in

st
ru

m
en

t d
oi

t ê
tre

 a
rrê

té
 e

t 
dé

br
an

ch
é 

de
 la

 s
ou

rc
e 

de
 c

ou
ra

nt
 a

va
nt

 
to

ut
 in

te
rv

en
tio

n.
 N

e 
pa

s 
ut

ili
se

r 
l’i

ns
tru

m
en

t s
an

s 
so

n 
co

uv
er

cl
e.

 N
e 

pa
s 

el
en

sv
er

 le
s é

tu
is

 p
ro

te
ct

eu
rs

 d
es

 ca
rte

s d
e 

ci
rc

ui
ts

 im
pr

im
és

.

D
es

ca
rg

a 
el

éc
tr

ic
a:

 E
st

e 
in

st
ru

m
en

to
 

ut
ili

za
 a

lta
s 

te
ns

io
ne

s,
 c

ap
ac

es
 d

e 
pr

od
uc

ir 
le

si
on

es
 p

er
so

na
le

s.
 A

nt
es

 d
e 

da
r s

er
vi

ci
o 

de
 m

an
te

ni
m

ie
nt

o 
al

 
in

st
ru

m
en

to
, é

st
e 

de
be

ra
 a

pa
ga

rs
e 

y 
de

sc
on

ec
ta

rs
e 

de
 la

 lí
ne

a 
de

 a
lim

en
ta

ci
on

 
el

éc
tri

ca
. N

o 
op

er
e 

el
 in

st
ru

m
en

to
 s

in
 s

us
 

cu
bi

er
ta

s e
xt

er
io

re
s q

ui
ta

da
s.

 N
o 

re
m

ue
va

 
la

s 
cu

bi
er

ta
s 

pr
ot

ec
to

ra
s 

de
 la

s 
ta

rje
ta

s 
de

 c
irc

ui
to

 im
pr

es
o.

Sh
oc

k 
da

 fo
lg

or
az

io
ne

. L
’a

pp
ar

ec
ch

io
 è

 
al

im
en

ta
to

 d
a 

co
rre

nt
e 

ad
 a

lta
 te

ns
io

ne
 

ch
e 

pu
o 

pr
ov

oc
ar

e 
le

si
on

i f
is

ic
he

. P
rim

a 
di

 
ef

fe
ttu

ar
e 

qu
al

si
as

i i
nt

er
ve

nt
o 

di
 

m
an

ut
en

zio
ne

 o
cc

or
re

 sp
eg

ne
re

 e
d 

is
ol

ar
e 

l’a
pp

ar
ec

ch
io

 d
al

la
 li

ne
a 

el
et

tri
ca

. N
on

 
at

tiv
ar

e 
lo

 s
tru

m
en

to
 s

en
za

 lo
 s

ch
er

m
o 

su
pe

rio
re

. N
on

 to
gl

ie
re

 i 
co

pe
rc

hi
 a

 
pr

ot
ez

io
ne

 d
al

le
 s

ch
ed

e 
di

 c
irc

ui
to

 
st

am
pa

to
 (P

CB
).

Ch
em

ic
al

: T
hi

s 
in

st
ru

m
en

t m
ig

ht
 c

on
ta

in
 

ha
za

rd
ou

s 
ch

em
ic

al
s.

 W
ea

r g
lo

ve
s 

w
he

n 
ha

nd
lin

g 
to

xi
c,

 c
ar

ci
no

ge
ni

c,
 m

ut
ag

en
ic

, 
or

 c
or

ro
si

ve
 o

r i
rri

ta
nt

 c
he

m
ic

al
s.

 U
se

 
ap

pr
ov

ed
 c

on
ta

in
er

s 
an

d 
pr

op
er

 
pr

oc
ed

ur
es

 to
 d

is
po

se
 w

as
te

 o
il.

Ch
em

ik
al

ie
n:

 D
ie

se
s 

Ge
rä

t k
an

n 
ge

fä
hr

lic
he

 C
he

m
ik

al
ie

n 
en

th
al

te
n.

 Tr
ag

en
 

Si
e 

Sc
hu

tz
ha

nd
sc

hu
he

 b
ei

m
 U

m
ga

ng
 m

it 
to

xi
sc

he
n,

 k
ar

zin
og

en
en

, m
ut

ag
en

en
 o

de
r 

ät
ze

nd
en

/r
ei

ze
nd

en
 C

he
m

ik
al

ie
n.

 
En

ts
or

ge
n 

Si
e 

ve
rb

ra
uc

ht
es

 Ö
l 

en
ts

pr
ec

he
nd

 d
en

 V
or

sc
hr

ift
en

 in
 d

en
 

vo
rg

es
ch

rie
be

ne
n 

Be
hä

lte
rn

.

Ch
im

iq
ue

: D
es

 p
ro

du
its

 c
he

m
iq

ue
s 

da
ng

er
eu

x 
pe

uv
en

 s
e 

tro
uv

er
 d

an
s 

l’i
ns

tru
m

en
t. 

Pr
ot

ed
 d

os
 g

an
ts

 p
ou

r 
m

an
ip

ul
er

 to
us

 p
ro

du
its

 c
he

m
iq

ue
s 

to
xi

qu
es

, c
an

cé
rig

èn
es

, m
ut

ag
èn

es
, o

u 
co

rro
si

fs
/ir

rit
an

ts
. U

til
is

er
 d

es
 ré

ci
pi

en
ts

 
et

 d
es

 p
ro

cé
du

re
s 

ho
m

ol
og

ué
es

 p
ou

r s
e 

dé
ba

rra
ss

er
 d

es
 d

éc
he

ts
 d

’h
ui

le
.

Q
uí

m
ic

a:
 E

l i
ns

tru
m

en
to

 p
ue

de
 c

on
te

ne
r 

pr
od

uc
to

s 
qu

im
ic

os
 p

el
ig

ro
so

s.
 U

til
ic

e 
gu

an
te

s 
al

 m
an

ej
ar

 p
ro

du
ct

os
 q

ui
m

ic
os

 
tó

xi
co

s,
 c

ar
ci

no
ge

no
s,

 m
ut

ag
en

os
 o

 
co

rro
si

vo
s/

irr
ita

nt
es

. U
til

ic
e 

re
ci

pi
en

te
s 

y 
pr

oc
ed

im
ie

nt
os

 a
pr

ob
ad

os
 p

ar
a 

de
sh

ac
er

se
 d

el
 a

ce
ite

 u
sa

do
.

Pr
od

ot
ti 

ch
im

ic
i. 

Po
ss

ib
ile

 p
re

se
nz

a 
di

 
so

st
an

ze
 c

hi
m

ic
he

 p
er

ic
ol

os
e 

ne
ll’

ap
pa

re
cc

hi
o.

 In
do

ss
ar

e 
de

i g
ua

nt
i p

er
 

m
an

eg
gi

ar
e 

pr
od

ot
ti 

ch
im

ic
i t

os
si

ci
, 

ca
nc

er
og

en
i, 

m
ut

ag
en

i, 
o 

co
rro

si
vi

/ir
rit

an
ti.

 U
til

izz
ar

e 
co

nt
en

ito
ri 

ap
ro

vo
 e

 se
gu

ire
 la

 p
ro

ce
du

ra
 in

di
ca

ta
 p

er
 

lo
 s

m
al

tim
en

to
 d

ei
 re

si
du

i d
i o

lio
.

H
ea

t: 
Be

fo
re

 s
er

vi
ci

ng
 th

e 
in

st
ru

m
en

t, 
al

lo
w

 a
ny

 h
ea

te
d 

co
m

po
ne

nt
s 

to
 c

oo
l.

H
itz

e:
 W

ar
te

n 
Si

e 
er

hi
tz

te
 K

om
po

ne
nt

en
 

er
st

 n
ac

hd
em

 d
ie

se
 s

ic
h 

ab
ge

kü
hl

t h
ab

en
.

H
au

te
 T

em
pe

ra
tu

re
: P

er
m

et
tre

 a
ux

 
co

m
po

sa
nt

s 
ch

au
ffé

s 
de

 re
fro

id
ir 

av
an

t 
to

ut
 in

te
rv

en
tio

n.

A
lta

s 
te

m
pe

ra
tu

ra
s:

 P
er

m
ita

 q
ue

 lo
p 

co
m

po
ne

nt
es

 s
e 

en
frí

en
, a

nt
e 

de
 e

fe
ct

ua
r 

se
rv

ic
io

 d
e 

m
an

te
ni

m
ie

nt
o.

Ca
lo

re
. A

tte
nd

er
e 

ch
e 

i c
om

po
ne

nt
i 

ris
ca

ld
at

i s
i r

af
fre

dd
in

o 
pr

im
a 

di
 

ef
fe

ttu
ra

re
 l’

in
te

rv
en

to
 d

i m
an

ut
en

zio
ne

.

Fi
re

: U
se

 ca
re

 w
he

n 
op

er
at

in
g 

th
e 

sy
st

em
 

in
 th

e 
pr

es
en

ce
 o

f f
la

m
m

ab
le

 g
as

es
.

Fe
ue

r: 
Be

ac
ht

en
 S

ie
 d

ie
 e

in
sc

hl
äg

ig
en

 
Vo

rs
ic

ht
sm

aB
na

hm
en

, w
en

n 
Si

e 
da

s 
Sy

st
em

 in
 G

eg
en

w
ar

t v
on

 e
nt

zü
nd

ba
re

n 
Ga

se
n 

be
tre

ib
en

.

In
ce

nd
ie

: A
gi

r a
ve

c 
pr

éc
au

tio
n 

lo
rs

 d
e 

l’u
til

is
at

io
n 

du
 s

ys
tè

m
e 

en
 p

ré
se

nc
e 

de
 

ga
z i

nf
la

m
m

ab
le

s.

Fu
eg

o:
 Te

ng
a 

cu
id

ad
o 

al
 o

pe
ra

r e
l 

si
st

em
a 

en
 p

re
se

nc
ia

 d
e 

ga
se

s 
in

fla
m

ab
le

s.

In
ce

nd
io

. A
do

tta
re

 le
 d

ov
ut

e 
pr

ec
au

zio
ni

 
qu

an
do

 si
 u

sa
 il

 si
st

em
a 

in
 p

re
se

nz
a 

di
 g

as
 

in
fia

m
m

ab
ili

.

Ey
e 

H
az

ar
d:

 E
ye

 d
am

ag
e 

co
ul

d 
oc

cu
r 

fro
m

 s
pl

at
te

re
d 

ch
em

ic
al

s 
or

 fl
yi

ng
 

pa
rti

cl
es

. W
ea

r s
af

et
y 

gl
as

se
s 

w
he

n 
ha

nd
lin

g 
ch

em
ic

al
s 

or
 s

er
vi

ci
ng

 th
e 

in
st

ru
m

en
t.

Ve
rle

tz
un

gs
ge

fa
hr

 d
er

 A
ug

en
: 

Ve
rs

pr
itz

te
 C

he
m

ik
al

ie
n 

od
er

 k
le

in
e 

Pa
rti

ke
l k

ön
ne

n 
Au

ge
nv

er
le

tz
un

ge
n 

ve
ru

rs
ac

he
n.

 Tr
ag

en
 S

ie
 b

ei
m

 U
m

ga
ng

 m
it 

Ch
em

ik
al

ie
n 

od
er

 b
ei

 d
er

 W
ar

tu
ng

 d
es

 
Ge

rä
te

s 
ei

ne
 S

ch
ut

zb
ril

le
.

D
an

ge
r p

ou
r l

es
 y

eu
x:

 D
ex

 p
ro

je
ct

io
ns

 
ch

im
iq

ue
s,

 li
qu

id
es

, o
u 

so
lid

es
 p

eu
ve

nt
 

êt
re

 d
an

ge
re

us
es

 p
ou

r l
es

 ye
ux

. P
or

te
r d

es
 

lu
ne

tte
s 

de
 p

ro
te

ct
io

n 
lo

rs
 d

e 
to

ut
e 

m
an

ip
ul

at
io

nd
e 

pr
od

ui
t c

hi
m

iq
ue

 o
u 

po
ur

 
to

ut
e 

in
te

rv
en

tio
n 

su
r l

’in
st

ru
m

en
t.

Pe
lig

ro
 p

ar
 lo

s 
oj

os
: L

as
 s

al
ic

ad
ur

as
 d

e 
pr

od
uc

to
s 

qu
ím

ic
os

 o
 p

ar
tic

ul
as

 q
ue

 
sa

lte
n 

br
us

ca
m

en
te

 p
ue

de
n 

ca
us

ar
 

le
si

on
es

 e
n 

lo
s 

oj
os

. U
til

ic
e 

an
te

oj
os

 
pr

ot
ec

to
re

s 
al

 m
ni

pu
la

r p
ro

du
ct

os
 

qu
ím

ic
os

 o
 a

l d
ar

le
 s

er
vi

ci
o 

de
 

m
an

te
ni

m
ie

nt
o 

al
 in

st
ru

m
en

to
.

Pe
ri

co
lo

 p
er

 la
 v

is
ta

. G
li 

sc
hi

zz
i d

i 
pr

od
ot

ti 
ch

im
ic

i o
 d

el
le

 p
ar

tic
el

le
 p

re
se

nt
i 

ne
ll’

ar
ia

 p
ot

re
bb

er
o 

ca
us

ar
e 

da
nn

i a
lla

 
vi

st
a.

 In
do

ss
ar

e 
oc

ch
ia

li 
pr

ot
et

tiv
i q

ua
nd

o 
si

 m
an

eg
gi

an
o 

pr
od

ot
ti 

ch
im

ic
i o

 s
i 

ef
fe

ttu
an

o 
in

te
rv

en
ti 

di
 m

an
ut

en
zio

ne
 

su
ll’

ap
pa

re
cc

hi
o.

G
en

er
al

 H
az

ar
d:

 A
 h

az
ar

d 
is

 p
re

se
nt

 th
at

 
is

 n
ot

 in
cl

ud
ed

 in
 th

e 
ab

ov
e 

ca
te

go
rie

s.
 

Al
so

, t
hi

s 
sy

m
bo

l a
pp

ea
rs

 o
n 

th
e 

in
st

ru
m

en
t t

o 
re

fe
r t

he
 u

se
r t

o 
in

st
ru

ct
io

ns
 

in
 th

is
 m

an
ua

l.

A
llg

em
ei

ne
 G

ef
ah

r: 
Es

 b
es

te
ht

 e
in

e 
w

ei
te

re
 G

ef
ah

r, 
di

e 
ni

ch
t i

n 
de

n 
vo

rs
te

he
nd

en
 K

at
eg

or
ie

n 
be

sc
hr

ie
be

n 
is

t. 
Di

es
es

 S
ym

bo
l w

ird
 im

 H
an

db
uc

h 
au

Be
rd

em
 d

az
u 

ve
rw

en
de

t, 
um

 d
en

 
Be

nu
tz

er
 a

uf
 A

nw
ei

su
ng

en
 h

in
zu

w
ei

se
n.

D
an

ge
r g

én
ér

al
: I

nd
iq

ue
 la

 p
ré

se
nc

e 
d;

un
 ri

sq
ue

 n
’a

pp
ar

te
na

nt
 p

as
 a

ux
 

ca
té

go
rie

s 
ci

té
es

 p
lu

s 
ha

ut
. C

e 
sy

m
bo

le
 

fig
ur

e 
ég

al
em

en
t s

ur
 l’

in
st

ru
m

en
t p

ou
r 

re
nv

oy
er

 l’
ut

ili
sa

te
ur

 a
ux

 in
st

ru
ct

io
ns

 d
u 

pr
és

en
t m

an
ue

l.

Pe
lig

ro
 g

en
er

al
: S

ig
ni

fic
a 

qu
e 

ex
is

te
 u

n 
pe

lig
ro

 n
o 

in
cl

ui
do

 e
n 

la
s 

ca
te

go
ria

s 
an

te
rio

re
s.

 E
st

e 
si

m
bo

lo
 ta

m
bi

én
 se

 u
til

iza
 

en
 e

l i
ns

tru
m

en
to

 p
ar

 re
fe

rir
 a

l u
su

ar
io

 a
 

la
s 

in
st

ru
cc

io
ne

s 
co

nt
en

id
as

 e
n 

es
te

 
m

an
ua

l.

Pe
ri

co
lo

 g
en

er
ic

o.
 P

er
ic

ol
o 

no
n 

co
m

pr
es

o 
tra

 le
 p

re
ce

de
nt

i c
at

eg
or

ie
. 

Qu
es

to
 s

im
bo

lo
 è

 u
til

izz
at

o 
in

ol
tre

 
su

ll’
ap

pa
re

cc
hi

o 
pe

r s
eg

na
la

re
 a

ll’
ut

en
te

 
di

 c
on

su
lta

re
 le

 is
tru

zio
ni

 d
es

cr
itt

e 
ne

l 
pr

es
en

te
 m

an
ua

le
.

W
he

n 
th

e 
sa

fe
ty

 o
f a

 p
ro

ce
du

re
 is

 
qu

es
tio

na
bl

e,
 co

nt
ac

t y
ou

r l
oc

al
 Te

ch
ni

ca
l 

Su
pp

or
t o

rg
an

iza
tio

n 
fo

r T
he

rm
o 

Fi
sh

er
 

Sc
ie

nt
ifi

c 
Sa

n 
Jo

se
 P

ro
du

ct
s.

W
en

n 
Si

e 
si

ch
 ü

be
r d

ie
 S

ic
he

rh
ei

t e
in

es
 

Ve
rfa

hr
en

s 
im

 u
nk

la
re

n 
si

nd
, s

et
ze

n 
Si

e 
si

ch
, b

ev
or

 S
ie

 fo
rtf

ah
re

n,
 m

it 
Ih

re
r 

lo
ka

le
n 

te
ch

ni
sc

he
n 

Un
te

rs
tü

tz
un

gs
or

ga
ni

sa
tio

n 
fü

r T
he

rm
o 

Fi
sh

er
 S

ci
en

tif
ic

 S
an

 J
os

e 
Pr

od
uk

te
 in

 
Ve

rb
in

du
ng

.

Si
 la

 sû
re

té
 d

’u
n 

pr
oc

éd
ur

e 
es

t i
nc

er
ta

in
e,

 
av

an
t d

e 
co

nt
in

ue
r, 

co
nt

ac
te

r l
e 

pl
us

 
pr

oc
he

 S
er

vi
ce

 C
lie

nt
èl

e 
po

ur
 le

s 
pr

od
ui

ts
 

de
 T

he
rm

o 
Fi

sh
er

 S
ci

en
tif

ic
 S

an
 J

os
e.

Cu
an

do
 la

 c
er

tid
um

br
e 

ac
er

ca
 d

e 
un

 
pr

oc
ed

im
ie

nt
o 

se
a 

du
do

sa
, a

nt
es

 d
e 

pr
os

eg
ui

r, 
po

ng
as

e 
en

 c
on

ta
ct

o 
co

n 
la

 
Of

ic
in

a 
de

 A
si

st
en

ci
a 

Te
cn

ic
a 

lo
ca

l p
ar

a 
lo

s 
pr

od
uc

to
s 

de
 T

he
rm

o 
Fi

sh
er

 S
ci

en
tif

ic
 

Sa
n 

Jo
se

.

Qu
an

do
 e

 in
 d

ub
bi

o 
la

 m
is

ur
a 

di
 s

ic
ur

ez
za

 
pe

r u
na

 p
ro

ce
du

ra
, p

rim
a 

di
 c

on
tin

ua
re

, s
i 

pr
eg

a 
di

 m
et

te
rs

i i
n 

co
nt

at
to

 c
on

 il
 

Se
rv

izi
o 

di
 A

ss
is

te
nz

a 
Te

cn
ic

a 
lo

ca
le

 p
er

 i 
pr

od
ot

ti 
di

 T
he

rm
o 

Fi
sh

er
 S

ci
en

tif
ic

 S
an

 
Jo

se
.



CA
U

TI
O

N
 S

ym
bo

l
CA

U
TI

O
N

El
ec

tr
ic

 S
ho

ck
: T

hi
s 

in
st

ru
m

en
t u

se
s 

hi
gh

 v
ol

ta
ge

s 
th

at
 c

an
 c

au
se

 p
er

so
na

l 
in

ju
ry

. B
ef

or
e 

se
rv

ic
in

g,
 s

hu
t d

ow
n 

th
e 

in
st

ru
m

en
t a

nd
 d

is
co

nn
ec

t t
he

 in
st

ru
m

en
t 

fro
m

 li
ne

 p
ow

er
. K

ee
p 

th
e 

to
p 

co
ve

r o
n 

w
hi

le
 o

pe
ra

tin
g 

th
e 

in
st

ru
m

en
t. 

Do
 n

ot
 

re
m

ov
e 

pr
ot

ec
tiv

e 
co

ve
rs

 fr
om

 P
CB

s.

Ch
em

ic
al

: T
hi

s 
in

st
ru

m
en

t m
ig

ht
 c

on
ta

in
 

ha
za

rd
ou

s 
ch

em
ic

al
s.

 W
ea

r g
lo

ve
s 

w
he

n 
ha

nd
lin

g 
to

xi
c,

 c
ar

ci
no

ge
ni

c,
 m

ut
ag

en
ic

, 
or

 c
or

ro
si

ve
 o

r i
rri

ta
nt

 c
he

m
ic

al
s.

 U
se

 
ap

pr
ov

ed
 c

on
ta

in
er

s 
an

d 
pr

op
er

 
pr

oc
ed

ur
es

 to
 d

is
po

se
 w

as
te

 o
il.

H
ea

t: 
Be

fo
re

 s
er

vi
ci

ng
 th

e 
in

st
ru

m
en

t, 
al

lo
w

 a
ny

 h
ea

te
d 

co
m

po
ne

nt
s 

to
 c

oo
l.

Fi
re

: U
se

 ca
re

 w
he

n 
op

er
at

in
g 

th
e 

sy
st

em
 

in
 th

e 
pr

es
en

ce
 o

f f
la

m
m

ab
le

 g
as

es
.

Ey
e 

H
az

ar
d:

 E
ye

 d
am

ag
e 

co
ul

d 
oc

cu
r 

fro
m

 s
pl

at
te

re
d 

ch
em

ic
al

s 
or

 fl
yi

ng
 

pa
rti

cl
es

. W
ea

r s
af

et
y 

gl
as

se
s 

w
he

n 
ha

nd
lin

g 
ch

em
ic

al
s 

or
 s

er
vi

ci
ng

 th
e 

in
st

ru
m

en
t.

G
en

er
al

 H
az

ar
d:

 A
 h

az
ar

d 
is

 p
re

se
nt

 th
at

 
is

 n
ot

 in
cl

ud
ed

 in
 th

e 
ab

ov
e 

ca
te

go
rie

s.
 

Al
so

, t
hi

s 
sy

m
bo

l a
pp

ea
rs

 o
n 

th
e 

in
st

ru
m

en
t t

o 
re

fe
r t

he
 u

se
r t

o 
in

st
ru

ct
io

ns
 

in
 th

is
 m

an
ua

l.

W
he

n 
th

e 
sa

fe
ty

 o
f a

 p
ro

ce
du

re
 is

 
qu

es
tio

na
bl

e,
 co

nt
ac

t y
ou

r l
oc

al
 Te

ch
ni

ca
l 

Su
pp

or
t o

rg
an

iza
tio

n 
fo

r T
he

rm
o 

Fi
sh

er
 

Sc
ie

nt
ifi

c 
Sa

n 
Jo

se
 P

ro
du

ct
s.



C

Contents
Preface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .xiii
About This Guide. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .xiii
Related Documentation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .xiii
Safety and Special Notices  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .xiii
Contacting Us  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .xiv

Assistance  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .xiv
Changes to the Manual and Online Help  . . . . . . . . . . . . . . . . . . . . . . . . . . .xiv

Chapter 1 Introduction  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
Ion Polarity Modes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
Ionization Techniques . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3

Electrospray Ionization  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4
Atmospheric Pressure Chemical Ionization . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
Atmospheric Pressure Photoionization. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
Nanospray Ionization  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

Scan Power and Scan Modes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
MS Scan Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
MS/MS Scan Mode. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
MSn Scan Mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

Scan Types  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
Full Scan . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
Selected Ion Monitoring . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
Selected Reaction Monitoring . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
Consecutive Reaction Monitoring . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
ZoomScan . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

Data Types  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
Profile Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
Centroid Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

Experiment Types . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
General MS or MSn Experiments  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
Data-Dependent Experiments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
Ion Mapping Experiments. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
Ion Tree Experiments  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
Thermo Scientific LCQ Fleet Hardware Manual ix



Contents

x

Chapter 2 Functional Description. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .21
Liquid Chromatography System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

Autosampler  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
Liquid Chromatography Pump and Column. . . . . . . . . . . . . . . . . . . . . . . . . 23

Syringe Pump . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
Divert/Inject Valve  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
Mass Spectrometer (MS) Detector. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26

Manual Controls and LED Indicators . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26
API Source  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
Ion Optics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
Mass Analyzer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
Ion Detection Systems. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
Vacuum System and API Source Gas Hardware  . . . . . . . . . . . . . . . . . . . . . . 41
Cooling Fans . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
Electronic Assemblies  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47

Data System  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54
Software and Computer Hardware Requirements . . . . . . . . . . . . . . . . . . . . . 55
Data System/ MS Detector and Local Area Network Interface  . . . . . . . . . . . 55
Printer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55

Chapter 3 Daily Operation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .57
Before Operating the LCQ Fleet . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57

Checking the Helium and Nitrogen Supplies  . . . . . . . . . . . . . . . . . . . . . . . . 58
Checking the ESI Fused-Silica Sample Tube for Elongation . . . . . . . . . . . . . 58
Checking the System Vacuum Levels. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59
Checking the Disk Space . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60

After Operating the LCQ Fleet . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61
Flushing the Sample Transfer Line, Sample Tube, and API Probe. . . . . . . . . 61
Placing the System in Standby Mode. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63
Flushing the Ion Sweep Cone and Ion Transfer Capillary . . . . . . . . . . . . . . . 63
Purging the Oil in the Forepump  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66
Emptying the Solvent Waste Bottle . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66

Chapter 4 MS Detector Maintenance  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .67
Overview of Maintenance Procedures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68
Tools and Supplies  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
Frequency of Cleaning. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71
API Source Maintenance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72

Flushing the Sample Transfer Line, Sample Tube, and API Probe. . . . . . . . . 72
Flushing the Ion Sweep Cone and Ion Transfer Capillary . . . . . . . . . . . . . . . 72
Checking the Vacuum Pressure in the Ion Trap  . . . . . . . . . . . . . . . . . . . . . . 73
Cleaning the Ion Transfer Capillary and Ion Sweep Cone . . . . . . . . . . . . . . . 73
Maintaining the Internal Components of the Ion Source Interface . . . . . . . . 76
LCQ Fleet Hardware Manual Thermo Scientific



Contents
Cleaning the Q00-L0 RF Lens  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 87
Removing the Q00-L0 RF Lens from the Vacuum Manifold  . . . . . . . . . . . . 87
Disassembling the Q00-L0 RF Lens  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89
Cleaning the Q00-L0 RF Lens Components . . . . . . . . . . . . . . . . . . . . . . . . . 89
Reassembling the Q00-L0 RF Lens . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90
Reinstalling the Q00-L0 RF Lens  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90

Cleaning the Q0 and Q1 Ion Guides  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91
Removing the Top Cover of the MS Detector . . . . . . . . . . . . . . . . . . . . . . . . 91
Removing the Top Cover Plate of the Vacuum Manifold . . . . . . . . . . . . . . . 92
Removing the Q0 and Q1 Ion Guides. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 94
Cleaning the Q0 and Q1 Ion Guides. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 96
Reinstalling the Q0 and Q1 Ion Guides  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 96
Cleaning the Ion Detection System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 99
Reinstalling the Top Cover Plate of the Vacuum Manifold . . . . . . . . . . . . . 100
Reinstalling the Top Cover of the MS Detector  . . . . . . . . . . . . . . . . . . . . . 100

Maintaining the Mass Analyzer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 101
Removing the Mass Analyzer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 101
Disassembling the Mass Analyzer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102
Cleaning the Mass Analyzer Parts  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103
Reassembling the Mass Analyzer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 104
Reinstalling the Mass Analyzer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105

Replacing the Electron Multiplier . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105
Calibrating the Electron Multiplier . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108
Replacing the Turbomolecular Pump Cartridge  . . . . . . . . . . . . . . . . . . . . . . . 109
Cleaning the Fan Filter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 110

Chapter 5 System Shutdown, Startup, and Reset  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .111
Shutting Down the System in an Emergency. . . . . . . . . . . . . . . . . . . . . . . . . . 111
Placing the System in Standby Mode. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 112
Shutting Down the System Completely. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 113
Starting the System after a Complete Shutdown . . . . . . . . . . . . . . . . . . . . . . . 115

Starting the LC Pump . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 115
Starting the Data System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 115
Starting the MS Detector  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 115
Starting the Autosampler . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 116
Setting Up Conditions for Operation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 117

Resetting the MS Detector  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 117
Resetting the Tune and Calibration Parameters to their Default Values  . . . . . 118
Resetting the Data System. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 119

Using Windows XP to Reset the Data System . . . . . . . . . . . . . . . . . . . . . . . 119
Using the Reset Button on the PC to Reset the Data System. . . . . . . . . . . . 119

Turning Off Selected MS Detector Components  . . . . . . . . . . . . . . . . . . . . . . 120
Thermo Scientific LCQ Fleet Hardware Manual xi



Contents

xii
Chapter 6 Diagnostics and PCB and Assembly Replacement. . . . . . . . . . . . . . . . . . . . . . . .123
Running the LCQ Fleet Diagnostics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123

Calibrating the Multipole RF and the Main RF. . . . . . . . . . . . . . . . . . . . . . 124
Running the Diagnostics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 129

Replacing a Fuse . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 130
Replacing Power Supplies . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 131
Replacing PCBs in the MS Detector . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 133

Chapter 7 Replaceable Parts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .135
MS Detector . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 136

ESI Source. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 137
APCI Source . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 140
Ion Source Interface  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 144
Q00 RF Lens. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 147
Q0 and Q1 Ion Guides . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 148
Mass Analyzer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 149
Electron Multiplier  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 150
Coil Module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 150
Divert/Inject Valve  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 150
Syringe Pump . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 150
Turbomolecular Pump  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 150
Forepump . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 151
Pressure Gauges . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 151
Vacuum Accessories. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 151
Vacuum Manifold O-Rings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 151
Vent Valve. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 152
Power Supplies  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 153
Printed Circuit Boards (PCBs)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 153
Cables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 153
Fans. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 154

Manuals  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 154
MS Accessory Kit  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 155
Special LXQ/LCQ Fleet Trap Accessory Kit . . . . . . . . . . . . . . . . . . . . . . . . . . 156
Metal Needle Kits . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 156
Fittings, Ferrules, Sample Loops, Unions, and Tubing  . . . . . . . . . . . . . . . . . . 156
Chemicals Kit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 157
LCQ Fleet Hardware Manual Thermo Scientific



P

Preface

About This Guide
This guide describes the modes of operation and principle hardware components of your 
LCQ Fleet system. In addition, this manual provides instructions for cleaning and 
maintaining your LCQ Fleet MS detector. The LCQ Fleet represents the latest refinement in 
the LCQ series of Thermo Scientific MS instruments for full-scan MSn performance.

Related Documentation
In addition to this guide, Thermo Scientific provides the following documents for the LCQ 
Fleet MS detector:

• LCQ Fleet Preinstallation Requirements Guide

• LCQ Fleet Getting Connected Guide

• LCQ Fleet Getting Started Guide

• Ion Max and Ion Max-S API Ion Source Hardware Manual

The instrument control software also provides online Help.

Safety and Special Notices
Make sure you follow the precautionary statements presented in this guide. The safety and 
other special notices appear in boxes.

Safety and special notices include the following:

CAUTION  Highlights hazards to humans, property, or the environment. Each 
CAUTION notice is accompanied by an appropriate CAUTION symbol. 

IMPORTANT  Highlights information necessary to prevent damage to software, loss of 
data, or invalid test results; or may contain information that is critical for optimal 
performance of the system.
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xiv
Contacting Us
There are several ways to contact Thermo Scientific. 

Assistance

For new product updates, technical support, and ordering information, contact us in one of 
the following ways:

Visit Thermo Scientific on the Web

www.thermo.com/finnigan

Contact Technical Support

Phone: 1-800-685-9535
Fax: 1-561-688-8736
E-mail: TechSupport.C+MS@thermofisher.com
Knowledge base: http://www.thermokb.com

Find software updates and utilities to download at http://mssupport.thermo.com.

Contact Customer Service

For ordering information in the U.S. and Canada:
Phone: 1-800-532-4752
Fax: 1-561-688-8731
Web site: www.thermo.com/finnigan

Changes to the Manual and Online Help

To suggest changes to this guide or to the online Help, use one of the following:

• Fill out a reader survey online at www.thermo.com/lcms-techpubs.

• Send an e-mail message to the Technical Publications Editor at 
techpubs.finnigan-lcms@thermofisher.com.

Note  Highlights information of general interest.

Tip  Helpful information that can make a task easier.
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Introduction

Welcome to the LCQ™ Fleet MS detector. The LCQ Fleet is a member of the Thermo 
Scientific family of mass spectrometers. 

The LCQ Fleet MS detector, shown in Figure 1, is a 3D quadrupole ion trap mass 
spectrometer that includes a syringe pump, a divert/inject valve, and the Ion Max-S API ion 
source. 

Figure 1. LCQ Fleet MS detector

This chapter provides an introduction to the LCQ Fleet MS detector and contains the 
following sections:

• Overview

• Ion Polarity Modes

• Ionization Techniques

• Scan Power and Scan Modes

• Scan Types

• Data Types

• Experiment Types
Thermo Scientific LCQ Fleet Hardware Manual 1
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Overview
In a typical LC/MS analysis, the liquid chromatograph (LC) portion of the system separates a 
mixture into its chemical components that the mass spectrometer detects and identifies by the 
mass spectrometer. The LC pump produces a solvent stream (the mobile phase) that passes 
through an LC column (containing the stationary phase) under high pressure. An 
autosampler introduces a measured quantity of sample into this solvent stream. As the solvent 
stream passes through the LC column, the sample separates into its chemical components. 
The rate at which the components of the sample elute from the column depends on their 
relative affinities to the mobile phase and the solid particles that make up the column packing. 
As the separated chemical components exit the LC column, they pass through a transfer line 
and enter the MS detector where they are ionized and analyzed. As the MS detector analyzes 
the ionized components and determines their mass-to-charge m/z ratios, it sends a data stream 
to the data system computer. In addition to supplying information about the mass-to-charge 
ratios of ionized compounds, the LCQ Fleet MS detector can also supply structural 
information by performing MSn experiments.

With the LCQ Fleet MS detector, you have two additional ways to introduce a sample into 
the MS detector: infusion and flow injection. To introduce a sample by infusion, you connect 
the built-in syringe pump directly to the API source of the MS detector. To introduce a 
sample by flow injection, you connect a sample loop, a syringe fitting, and an LC pump to the 
divert/inject valve. After you fill the sample loop with sample, you switch the position of the 
divert/inject valve, which places the contents of the sample loop in the path of the solvent 
flow produced by the LC pump.

The LCQ Fleet MS detector consists of an atmospheric pressure ionization (API) source, ion 
optics, a mass analyzer, and an ion detection system. The ion optics, mass analyzer, and ion 
detection system and part of the API source are enclosed in a vacuum manifold. Ionization of 
the sample takes place in the API source. The specific method used to ionize the sample is 
referred to as the ionization technique. The ion optics transmit the ions produced in the API 
source into the mass analyzer, where they are trapped in stable orbits by a time-varying electric 
field. The polarity of the potentials applied to the API source and ion optics determines 
whether positively charged ions or negatively charged ions are transmitted to the mass 
analyzer. You can set up data acquisition methods for the LCQ Fleet to analyze positively or 
negatively charged ions or to switch between these polarity modes during a single run.

The lenses in the API source and ion optics act as a gate to start and stop the transmission of 
ions from the API source to the mass analyzer. An automatic gain control (AGC) controls the 
function of these lenses and sets them to transmit the optimum number of ions to the mass 
analyzer.

The mass analyzer measures the mass-to-charge ratios of the ions produced in the API source. 
Selected ions are ejected from the mass analyzer and reach the ion detection system where 
they produce a signal. The detection system electronics then amplify this signal for analysis by 
the LCQ Fleet data system.
LCQ Fleet Hardware Manual Thermo Scientific
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The data system serves as the user interface to the MS detector, autosampler, LC, and syringe 
pump. Refer to the online Help for more information on the LCQ Fleet data processing and 
instrument control software.

Each sequence of loading the mass analyzer with ions followed by mass analysis of the ions is 
called a scan. The LCQ Fleet uses several different scan modes and different scan types to 
load, fragment, and eject ions from the mass analyzer. The ability to vary the scan mode and 
scan type, as well as the ionization and ion polarity modes, gives the user greater flexibility in 
the instrumentation for solving complex analytical problems.

Ion Polarity Modes
You can operate the LCQ Fleet in two ion polarity modes: positive or negative. The LCQ 
Fleet controls whether positive ions or negative ions are transmitted to the mass analyzer for 
mass analysis by changing the polarity of the potentials applied to the API source and ion 
optics. The ion optics are located between the API source and the mass analyzer.

The information obtained from a positive-ion mass spectrum is different from and 
complementary to that obtained from a negative-ion spectrum. Thus, the ability to obtain 
both positive-ion and negative-ion mass spectra aids you in the qualitative analysis of your 
sample. You can choose the ion polarity mode and ionization technique to obtain maximum 
sensitivity for the particular analysis of interest.

Ionization Techniques
You can operate the LCQ Fleet using any of following four ionization techniques: 

• Electrospray Ionization (ESI) 

• Atmospheric Pressure Chemical Ionization (APCI)

• Atmospheric Pressure Photoionization (APPI)

• Nanospray Ionization (NSI)

Figure 2 shows the ranges of applicability (molecular weight as a function of polarity) of three 
of the ionization techniques being discussed: atmospheric pressure photoionization (APPI), 
atmospheric pressure chemical ionization (APCI), and electrospray ionization (ESI).

Note   Because the APCI, ESI, APPI, and NSI techniques use the same ion source 
interface (that is, the portion of the API source that is under vacuum), you can switch 
between these four ionization techniques in just a few minutes. Switching ionization 
techniques merely involves switching the probes and does not break the vacuum.
hermo Scientific LCQ Fleet Hardware Manual 3
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Figure 2. Molecular weight ranges of ionization techniques

Electrospray Ionization 

The electrospray ionization (ESI) technique transforms ions in solution into ions in the gas 
phase1. ESI can be used to analyze many samples that previously were not suitable for mass 
analysis (for example, heat-labile compounds or high molecular weight compounds). ESI can 
be used to analyze any polar compound that makes a preformed ion in solution. The term 
preformed ion can include adduct ions. For example, polyethylene glycols can be analyzed 
from a solution containing ammonium acetate, because of adduct formation between the 
NH4

+ ions in the solution and oxygen atoms in the polymer. With ESI, the range of 
molecular masses that can be analyzed by the LCQ Fleet is greater than 100000 u, due to 
multiple charging. ESI is especially useful for the mass analysis of polar compounds, which 
include: biological polymers (for example, proteins, peptides, glycoproteins, and nucleotides); 
pharmaceuticals and their metabolites; and industrial polymers (for example, polyethylene 
glycols).

In ESI, ions are produced and analyzed as follows:

1. The sample solution enters the ESI needle, to which a high voltage is applied.

2. The ESI needle sprays the sample solution into a fine mist of droplets that are electrically 
charged at their surface.

3. The electrical charge density at the surface of the droplets increases as solvent evaporates 
from the droplets.

ESI

APCI

10,000

10

100

1,000

MW

NONPOLAR IONICPOLARITY

APPI

1 Refer to the following papers for more information on the electrospray ionization process: Fenn, J. B.; Mann, M.; 
Meng, C. K.; Wong, S. F.; Whitehouse, C. M. Mass Spectrom. Reviews 1990, 9, 37; Smith, R. D.; Loo, J. A.; 
Edmonds, C. G.; Barinaga, C. J.; Udseth, H. R. Anal. Chem. 1990, 62, 882; Ikonomou, M. G.; Blades, A. T.; 
Kebarle, P. Anal. Chem. 1991, 63, 1989.
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4. The electrical charge density at the surface of the droplets increases to a critical point, 
known as the Rayleigh stability limit. At this critical point, the droplets divide into 
smaller droplets because the electrostatic repulsion is greater than the surface tension. The 
process is repeated many times to form very small droplets.

5. The electrostatic repulsion between the sample ions in these very small, highly-charged 
droplets causes the sample ions to be ejected into the gas phase.

6. The sample ions pass through an ion transfer capillary, enter the MS detector and are 
analyzed.

In the LCQ Fleet the ESI needle is 60 degrees to the axis of the ion transfer capillary that 
carries ions to the MS detector. This geometry keeps the ion transfer capillary clean. The ion 
sweep cone serves as a mechanical barrier that keeps large droplets and particulates from 
entering the ion transfer capillary. Figure 3 shows the steps in the formation of ions from 
highly-charged droplets and the relationship between the ESI probe and the ion transfer 
capillary.

Figure 3. ESI process in the positive ion polarity mode
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You can use the ESI probe in either positive or negative ion polarity mode.The polarity of the 
preformed ions in solution determines the ion polarity mode of choice; that is, acidic 
molecules form negative ions in solution, and basic molecules form positive ions. The ejection 
of sample ions from droplets is facilitated if the ionic charge and surface charge of the droplet 
are of the same polarity. Thus, a positively charged needle is used to analyze positive ions and 
a negatively charged needle is used to analyze negative ions.

Sample ions can carry a single charge or multiple charges. The number of charges carried by 
the sample ions depends on the structure of the analyte of interest and the carrier solvent. (In 
ESI, the buffer and the buffer strength both have a noticeable effect on sensitivity. Therefore, 
it is important to choose these variables correctly.) With higher molecular weight proteins or 
peptides, the resulting mass spectrum consists typically of a series of peaks corresponding to a 
distribution of multiply charged analyte ions.

The ESI process is affected by droplet size, surface charge, liquid surface tension, solvent 
volatility, and ion solvation strength. Large droplets with high surface tension, low volatility, 
strong ion solvation, low surface charge, and high conductivity prevent good electrospray.

Organic solvents, such as methanol (CH3OH), acetonitrile CH3CN), and isopropyl alcohol 
[(CH3)2CHOH], are superior to water for ESI. Volatile acids, such as acetic acid 
(1% vol/vol) and formic acid (0.1% vol/vol), and volatile bases, such as ammonium 
hydroxide and triethanolamine (TEA), are also good for ESI. Use volatile salts, such as 
ammonium acetate or ammonium formate at concentrations below 10 mM. Strong acids and 
bases, mineral acids, and nonvolatile salts, such as those containing potassium or sodium, are 
detrimental.

To ensure a good electrospray:

• Keep salts out of the solvent system.

• Use the lowest possible HPLC flow rates.

• Use organic/aqueous solvent systems and volatile acids and bases.

• Optimize the pH of the solvent system.

Atmospheric Pressure Chemical Ionization

Atmospheric pressure chemical ionization (APCI) is a soft ionization technique. APCI is used 
to analyze nonpolar compounds and compounds of medium polarity that are relatively low in 
molecular weight and have some volatility.

In APCI, ions are produced and analyzed as follows:

1. The APCI nozzle sprays the sample solution into a fine mist of droplets.

2. The droplets are vaporized in a high temperature tube (the vaporizer). 
LCQ Fleet Hardware Manual Thermo Scientific
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3. A high voltage is applied to a needle located near the exit end of the tube. The high 
voltage creates a corona discharge that forms reagent ions through a series of chemical 
reactions with solvent molecules and nitrogen sheath gas.

4. The reagent ions react with sample molecules to form sample ions.

5. The sample ions pass through an ion transfer capillary, enter the MS detector, and are 
analyzed.

In the LCQ Fleet, the sample tube in the APCI nozzle is 60 degrees to the axis of the ion 
transfer capillary that carries ions to the MS detector. This geometry keeps the ion transfer 
capillary clean. The ion sweep cone serves as a mechanical barrier that keeps large droplets and 
particulates from entering the ion transfer capillary. 

APCI is a gas phase ionization technique. Therefore, the gas phase acidities and basicities of 
the analyte and solvent vapor play an important role in the APCI process.

In the positive-ion mode, sample ionization occurs in a series of reactions that start with the 
electron-initiated cation formation. Typical examples of primary, secondary, and adduct ion 
formation include:

Primary ion formation

e− + N2  → N2
+. + 2e−

Secondary ion formation

N2
+. + H2O → N2 + H2O+.

H2O+. + H2O → H3O+ + HO.

Proton transfer

H3O+ + M → (M+H)+ + H2O

In the negative-ion mode, (M-H)− is typically formed by the abstraction of a proton by OH−.

APCI is used to analyze small molecules with molecular masses up to 2000 u. APCI is not 
affected by minor changes in most variables, such as changes in buffer or buffer strength.

Figure 4 shows the APCI process in the positive-ion polarity mode.
hermo Scientific LCQ Fleet Hardware Manual 7
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Figure 4. APCI process in the positive ion polarity mode
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positive-ion mode produces a stronger ion current. This is especially true for molecules with 
one or more basic nitrogen (or other basic) atoms. Exceptions to this general rule are 
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negative ions than positive ions.

While, in general, fewer negative ions are produced than positive ions, negative ion polarity is 
sometimes the mode of choice. This is because the negative ion polarity mode sometimes 
generates less chemical noise than does the positive mode. Thus, selectivity might be better in 
the negative ion mode than in the positive ion mode.
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In APPI, ions are produced and analyzed as follows:

1. The nozzle sprays the sample solution into a fine mist of droplets.

2. The droplets are vaporized in a high temperature tube (the vaporizer). 

3. The analyte molecule interacts with the light from the PhotoMate™ light source. The 
analyte molecule M is ionized to a molecular ion M+ if the ionization potential of the 
analyte is less than the photon energy hν:

M + hν → M+

4. In the presence of protic solvents, the analyte ion may extract a hydrogen to form an MH+ 
ion:

M+ + S → MH+ + S[-H]

5. The analyte ions pass through the ion transfer capillary, enter the MS detector, and are 
analyzed.

Molecules including steroids, basic-drug entities, and pesticides have ionization potentials 
below the threshold, and protonated molecules are generated in the LC/MS experiment. APPI 
reduces fragmentation because only a small amount of energy is deposited in the molecule. 
Molecules, such as nitrogen in the sheath, sweep, and auxiliary gas; and the simple solvents 
used for LC/MS are not ionized because their ionization potentials are greater than the 
photon energy. The result is selective ionization of analyte versus background. See Figure 5 
and Figure 6.

Figure 5. Energetics of photoionization
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Figure 6. Selective photoionization 

The light source is a krypton lamp that emits photons with energies of 10.0 and 10.6 eV. 
Molecules with ionization potentials less than 10 eV ionize to form MH+, while those with 
greater ionization potentials do not. The ionization potentials of typical compounds and 
solvents are listed below. Compounds and solvents with an ionization potential below 10 eV 
appear in red.
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Nanospray Ionization

Nanospray ionization (NSI) is a technique for performing electrospray ionization on amounts 
of liquid as small as 1 μL for time periods of greater than 30 minutes. Stable mass spectra can 
be obtained for very small amounts of biomolecules such as proteins, peptides, 
oligonucleotides, and oligosaccharides.

For more information on NSI, refer to the manual that came with your NSI source.

Scan Power and Scan Modes
Ions produced in the ion source are often referred to as parent ions. To produce a mass 
spectrum, the mass analyzer varies its DC and RF voltages to sequentially eject ions from the 
trap based on their m/z values. Alternatively, by varying the RF voltages of the mass analyzer, 
the LCQ Fleet can first eject all ions, except for several selected parent ions, and then collide 
these ions with the helium that is present in the mass analyzer. This helium is known as buffer 
gas. The collisions can cause the selected parent ions, also known as precursor ions, to 
fragment into product ions, which can then be sequentially ejected from the trap based on 
their m/z values to produce a mass spectrum.

The number of stages of mass analysis is represented as MSn where n is the scan power. Each 
stage of mass analysis includes an ion selection step. The LCQ Fleet supports scan powers of 
n = 1 to n = 10. As you raise the scan power, you can obtain more structural information 
about the analyte.

The scan powers supported by the LCQ Fleet in its standard configuration are as follows:

• MS Scan Mode (n = 1)

• MS/MS Scan Mode (n = 2)

• MSn Scan Mode (n = 3 to 10)

MS Scan Mode

The mass spectrometry (MS) scan mode corresponds to a single stage of mass analysis (that is, 
a scan power of n = 1). The MS scan mode only involves parent ions, and no fragmentation of 
the parent ions occurs. The MS scan mode can be a full scan experiment or a selected ion 
monitoring (SIM) experiment (see “Selected Ion Monitoring” on page 13).

MS/MS Scan Mode

The MS/MS scan corresponds to two stages of mass analysis (n = 2 scan power). In an 
MS/MS scan, parent ions are fragmented into product ions. An MS/MS scan can be a full 
scan experiment or a selected reaction monitoring (SRM) experiment (see “Selected Reaction 
Monitoring” on page 14).
hermo Scientific LCQ Fleet Hardware Manual 11



1 Introduction
Scan Types

12
MSn Scan Mode

An MSn scan involves three to ten stages of mass analysis (n = 3 to n = 10 scan power). 
[However, the term can also be applied to one stage of mass analysis (with n = 1) or to two 
stages of mass analysis (with n = 2).] An MSn scan can be either a full scan experiment or a 
consecutive reaction monitoring (CRM) experiment (see “Consecutive Reaction Monitoring” 
on page 14).

Scan Types 
You can operate the LCQ Fleet in the following scan types:

• Full Scan

• Selected Ion Monitoring (SIM)

• Selected Reaction Monitoring (SRM)

• Consecutive Reaction Monitoring (CRM)

• ZoomScan

Full Scan

A full scan provides a full mass spectrum of each analyte or parent ion. With full scan, in the 
last step of mass analysis (ion scan-out) the mass analyzer is scanned from the first mass to the 
last mass without interruption.

A full scan provides more information about an analyte than does selected ion monitoring 
(SIM) or selected reaction monitoring (SRM). A full scan does not provide the sensitivity that 
the other scan types can achieve.

The full scan type includes the following:

• Single-Stage Full Scan

• Two-Stage Full Scan

Single-Stage Full Scan

The single-stage full scan has one stage of mass analysis (where n = 1 scan power). With 
single-stage full scan, the ions formed in the ion source are stored in the mass analyzer. These 
ions are then sequentially scanned out of the mass analyzer to produce a full mass spectrum.
LCQ Fleet Hardware Manual Thermo Scientific
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Use single-stage full scan experiments to determine the molecular weight of unknown 
compounds or the molecular weight of each component in a mixture of unknown 
compounds. For example, you need a full scan to determine the molecular weight of each 
component of a mixture of unknown compounds, because you do not know what masses to 
expect from the mixture.

To use the SIM or SRM scan type, you need to know what ions you are looking for before 
you can perform an experiment. Thus, for SIM or SRM you can use a full scan to determine 
the identity of an analyte and obtain its mass spectrum. Then you can use SIM or SRM for 
routine quantitative analysis of the compound.

Two-Stage Full Scan

The two-stage full scan has two stages of mass analysis (where n = 2 scan power). In the first 
stage, the ions formed in the ion source are stored in the mass analyzer. Then ions of one 
mass-to-charge ratio (the parent ions) are selected, and all other ions are ejected from the mass 
analyzer. The parent ions are excited and collide with background gas that is present in the 
mass analyzer. The collisions of the parent ions cause them to fragment to produce one or 
more product ions. 

In the second stage of mass analysis, the product ions are stored in the mass analyzer. Then 
they are sequentially scanned out of the mass analyzer to produce a full product ion mass 
spectrum.

The two-stage full scan gives you more information about a sample than does SRM but does 
not yield the speed that SRM can achieve. With a two-stage full scan, you spend more time 
monitoring the product ions than you do with SRM. Thus, the two-stage full scan provides 
greater information but at a lower speed than SRM does.

To use the SRM scan you must know which parent and product reaction ions to observe. To 
obtain this information you could use a one-stage full scan to determine the parent mass 
spectrum and a two-stage full scan to determine the product mass spectrum for the parent 
ions of interest. For subsequent routine quantitative analysis you would use an SRM scan type 
based on the one-stage and two-stage full scan results.

Selected Ion Monitoring

Selected ion monitoring (SIM) is a single-stage (where n = 1 scan power) technique in which 
you monitor a particular ion or set of ions. In the SIM scan, ions formed in the ion source are 
stored in the mass analyzer. Ions of one or more mass-to-charge ratios are then selected, and 
all other ions are ejected from the mass analyzer. The selected ions are then sequentially 
scanned out of the mass analyzer to produce a SIM mass spectrum.

Use SIM experiments to detect small quantities of a target compound in a complex mixture 
when you know the mass spectrum of the target compound. SIM is useful in trace analysis 
and in the rapid screening of a large number of samples for a target compound.
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Because a SIM scan monitors only a few ions, SIM provides lower detection limits and greater 
speed than a single-stage full scan analysis. SIM achieves lower detection limits, because more 
time is spent monitoring significant ions that are known to occur in the mass spectrum of the 
target sample. SIM achieves greater speed because it only monitors a few ions of interest; 
regions of the spectrum that are empty or have no ions of interest are not monitored.

SIM can improve the detection limit and decrease analysis time, but it can also reduce target 
compound specificity. This is because SIM analysis only monitors particular ions. Thus, any 
compound that produces the ion or ions being monitored would appear to be the target 
compound. Verify that the ions being monitored with SIM are from the target compound 
and nothing else; otherwise you can obtain false positive results.

Selected Reaction Monitoring

Selected reaction monitoring (SRM) is a two-stage (n = 2 scan power) technique in which 
parent ion and product ion pairs are monitored. 

In the first stage of mass analysis, the ions formed in the ion source are stored in the mass 
analyzer. Ions of one mass-to-charge ratio (the parent ions) are selected and all other ions are 
ejected from the mass analyzer. The parent ions are then excited so that they collide with 
background gas that is present in the mass analyzer. The collisions of the parent ions cause 
them to fragment to produce one or more product ions.

In the second stage of mass analysis, the product ions are stored in the mass analyzer. Ions of 
one or more mass-to-charge ratios are selected and all other ions are ejected from the mass 
analyzer. The selected ions are then sequentially scanned out of the mass analyzer to produce 
an SRM product ion mass spectrum.

Like SIM, SRM allows for very rapid analysis of trace components in complex mixtures. 
However, because you are monitoring pairs of ions (one product ion for each parent ion), the 
specificity obtained in SRM can be much greater than that obtained in SIM. Thus, you are 
very unlikely to get a false positive result with SRM. To get a false positive result, the 
interfering compound must form a parent ion of the same mass-to-charge ratio as the selected 
parent ion from the target compound. The compound must also fragment to form a product 
ion of the same mass-to-charge ratio as the selected product ion from the target compound.

Consecutive Reaction Monitoring

Consecutive reaction monitoring (CRM) is the multi-stage (n = 3 to n = 10 scan power) 
analog of SIM (n = 1) and SRM (n = 2), that monitors a multistep reaction path. In the first 
stage of mass analysis, the ions formed in the ion source are stored in the mass analyzer. Ions 
of one mass-to-charge ratio (the parent ions) are selected and all other ions are ejected from 
the mass analyzer. The parent ions are then excited so that they collide with background gas 
that is present in the mass analyzer. The collisions of the parent ions cause them to fragment 
to produce one or more product ions.
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In the second stage of mass analysis, the product ions are stored in the mass analyzer. Product 
ions of one mass-to-charge ratio are then selected and all other ions are ejected from the mass 
analyzer. The selected product ions now become the new parent ions for the next stage of 
mass analysis. The new parent ions are excited so that they collide with background gas. The 
collisions of the new parent ions cause them to fragment producing one or more new product 
ions.

In the third stage of mass analysis, the new product ions are stored in the mass analyzer. This 
process is repeated up to seven more times until the final product ions of interest are 
produced. 

In the nth stage of mass analysis, the final product ions are stored in the mass analyzer. Ions of 
one or more mass-to-charge ratios are selected and all other ions are ejected from the mass 
analyzer. The selected ions are then sequentially scanned out of the mass analyzer to produce a 
CRM final product ion mass spectrum.

In CRM, the specificity increases as the number of consecutive reactions that you monitor 
increases. However, the sensitivity decreases as the number of consecutive reactions that you 
monitor increases—especially if many fragmentation pathways are available to the ion.

ZoomScan

Determining of the mass of an ion from its mass-to-charge ratio can be complicated if the 
charge state of the ion is unknown. ZoomScan is a high resolution MS scan in which the 
LCQ Fleet performs a high resolution scan to determine the charge state and molecular mass 
of an ion. The LCQ Fleet conducts a high resolution scan of 10 u width and evaluates the
12C /13C isotopic separation of a specified ion or ions. If the isotopic peaks are 1 u apart, the 
ion has a charge state of ±1. If the isotopic peaks are 0.5 u apart, the ion has a charge state of 
±2. If the isotopic peaks are 0.33 u apart, the ion has a charge state of ±3, and so on. You can 
then determine the molecular weight of the ion from a knowledge of the charge state and 
mass-to-charge ratio of the ion. You can conduct a ZoomScan analysis of up to ten ions by 
specifying the mass-to-charge ratios of the ions that you want to examine.

Data Types
You can acquire and display mass spectral data (intensity versus mass-to-charge ratio) with the 
LCQ Fleet in one of two data types:

• Profile Data

• Centroid Data
hermo Scientific LCQ Fleet Hardware Manual 15
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Profile Data 

With profile data you can see the shape of the peaks in the mass spectrum. Each atomic mass 
unit is divided into approximately 15 sampling intervals. The intensity of the ion current is 
determined at each of the sampling intervals. The intensity at each sampling interval is 
displayed with the intensities connected by a continuous line. In general, the profile scan data 
type is used when you tune and calibrate the MS detector so that you can easily see and 
measure mass resolution.

Centroid Data 

With centroid data the mass spectrum is displayed as a bar graph. In this scan data type, the 
intensities of each set of 15 sampling intervals are summed. This sum is displayed versus the 
integral center of mass of the 15 sampling intervals. The disk space requirements for centroid 
data are about one-tenth of what is required for profile data. Consequently, data processing 
for centroid data is faster than that for profile data.

Experiment Types
You can perform several types of experiments with the LCQ Fleet. The experiments are 
grouped into the following categories:

• General MS or MSn Experiments

• Data-Dependent Experiments 

• Ion Mapping Experiments 

• Ion Tree Experiments 

You specify which type of experiment you want to perform in the Xcalibur Instrument Setup 
window, and then save it in an instrument method (.meth) file. 

General MS or MSn Experiments

A General MS or MSn experiment is best used for the quantitative analysis of known 
compounds. However, you can also use a General experiment to collect qualitative data for 
structural analysis. Xcalibur includes an Instrument Method template in Instrument Setup so 
that you can get started with a General MS or MSn experiment. 

Note  Procedures for these experiments are beyond the scope of this manual. If you need 
more information, refer to the online Help. 
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In a General MS quantitation experiment, you must specify the mass range of your analyte(s) 
of interest, a parent (precursor ion) that fragments into distinctive product ions, and the 
mass-to-charge ratios of all the parent ions of interest. The LCQ Fleet can then collect data on 
the ions in the range or on the product ions of the parent ion(s) that you specify.

If you use a General experiment to collect data for qualitative (structural) analysis, you specify 
the scan mode (MS through MSn) for which you want data in the Scan Event Settings group 
box. If you specify MS/MS or MSn, you select the parent ion(s) for which you want data in 
the Set Parent List dialog box. The LCQ Fleet then collects distinct qualitative information 
for structural analysis or for spectral reference. 

The LCQ Fleet can generate reproducible, product-specific spectra, even from laboratory to 
laboratory. Consequently, you can use reference spectra that are generated with the LCQ 
Fleet to confirm structures of compounds generated with other LCQ Fleet systems.

Data-Dependent Experiments

Use Data-Dependent experiments for the qualitative analysis of unknown compounds for 
structure elucidation or confirmation. The LCQ Fleet uses the information in a 
Data-Dependent experiment to make decisions about the next step of the experiment 
automatically without input from a user. Instrument Setup contains the Instrument Method 
templates that you need to get started with Data-Dependent experiments. 

A Data-Dependent experiment produces a great deal of data from a single sample analysis. 
You can run a Data-Dependent experiment even if you know very little about your sample, 
and even if you are unfamiliar with the variables of mass spectroscopy. In a Data-Dependent 
experiment, you can specify parent ions for fragmentation or you can let the LCQ Fleet 
automatically select the ions for fragmentation. The LCQ Fleet can collect the structural 
information for every parent ion in the sample automatically, even if the sample is a mixture 
of compounds.

A Data-Dependent experiment requires minimal input about how the experiment should best 
proceed, as long as you specify that one or more scan events of an experiment segment are to 
be run as Data-Dependent. The LCQ Fleet then collects MS/MS or MSn data and makes 
decisions about what the next step in the experiment should be to collect even more data. For 
example, in a Data-Dependent Triple Play experiment for a mixture of compounds, the LCQ 
Fleet can decide which parent ion to isolate, the charge state of the parent ion, and the 
molecular mass of the compound. 

Ion Mapping experiments can be Data-Dependent. The Total Ion Map, Neutral Loss Ion 
Map, and Parent Ion Map experiments are not Data-Dependent. The Data-Dependent Zoom 
Map experiment collects ZoomScan data on every scan interval in a specified mass range.

Ion Tree experiments are a type of Data-Dependent experiment that provide methods for 
automatically interpreting MSn data and arranging the data in easy-to-manipulate formats.
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You can approach the setup of Data-Dependent experiments in either of two ways:

• If you have some idea of the parent ion, or if you expect a certain kind of parent, you set 
up a list of possible parent ions. Then, when one of the parent ions you specified is 
detected, you can acquire product spectra and analyze the information. Conversely, you 
can also set up a list of ions that you do not want to be selected for fragmentation.

• If you have little information about your compound, you can set up the parameters of a 
Data-Dependent experiment so that if the intensity of the ion signal is above a specified 
threshold, the LCQ Fleet generates product spectra. Later, you decide if the information 
is useful. Parameters might include threshold values for the intensity of the MS or MSn 
ion signal. Whatever threshold values you choose should isolate your parent ions of 
interest.

You can find useful structural information about your compound automatically with the 
simplest Data-Dependent experiment, Data-Dependent MS/MS. You specify the MS scan 
range, and you do not need to specify a parent ion. The LCQ Fleet then collects full scan MS 
data, picks the most intense parent ion in the spectrum, and fragments the ion to generate 
product ions. 

A Data-Dependent Triple-Play experiment is the same as Data-Dependent MS/MS but 
includes the identification of the charge state of the parent with the LCQ Fleet ZoomScan 
feature. A Data-Dependent Triple-Play experiment collects full-scan MS data, and then uses 
ZoomScan to determine the charge state of the parent ion and calculate the molecular weight. 
The parent ion is then fragmented into product ions (MS/MS). For example, if the LCQ 
Fleet determines a charge state equal to two, and if the mass-to-charge ratio of the parent ion 
is m/z 500, then the mass-to-charge ratios of the product ions can be up to and including 
m/z 1000 (or 2 × 500).

Use a Data-Dependent experiment (from templates in Instrument Setup) to do the following:

• Identify low-level impurities in high-purity compounds (Data-Dependent MS/MS). 

For example in the quality assurance process for aspirin, the LCQ Fleet can identify 
impurities of 0.1%.

• Identify metabolites in a complex mixture (Chromatographic Separation with 
Data-Dependent MS/MS). 

For example characteristic masses along the metabolic pathways of a drug can produce 
MS/MS spectra that are specific to the structure of the drug. These spectra are essential to 
metabolite identification.

• Build a custom library of composite MSn spectra (Ion Tree). 

A Data-Dependent experiment can produce a composite spectrum of, for example, MS2, 
MS3, and MS4 data. The LCQ Fleet can store the MSn fingerprint data in a custom MSn 
library spectrum. The data is valuable for use in process control, quality assurance, or 
research.
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Ion Mapping Experiments

Use an Ion Mapping experiment to get full structural characterization of unknown molecules 
in complex mixtures. In an Ion Mapping experiment, you can get product ion scans on every 
parent ion over a specified mass range. An Ion Mapping experiment can help to identify 
automatically which parent ions were fragmented to yield a specified product ion. The 
experiment “maps” one or more parent ions by using the information from product ion scans. 

The LCQ Fleet includes Ion Mapping templates in Instrument Setup.Use one of the 
following templates to start with an Ion Mapping experiment: 

• Total (or full scan) Ion Map

• Neutral Loss Ion Map

• Parent Ion Map

• Data-Dependent Zoom Ion Map

These experiments, in general, require that sample solution enter the MS Detector at a 
composition that is constant throughout. Therefore, use infusion to introduce your sample 
for these experiments. 

In a Total (or full scan) Ion Mapping experiment, product ion scans are produced for each 
parent ion, so you can determine which parent ions lost a particular fragment to yield a 
particular product ion. Furthermore, determine which parent ions are related to specific 
product ions. For example, you can map the spectral peaks in a mass range from m/z 400 to 
m/z 2000 and specify to scan for MS/MS product ions in incremental steps of every 
mass-to-charge ratio, every fifth mass-to-charge ratio, or every tenth mass-to-charge ratio. 

A Neutral Loss Ion Mapping experiment collects scans for masses that have lost neutral 
fragments. As with full scan Ion Mapping, you can get product ion scans on every parent ion. 
However, a Neutral Loss Ion Map identifies which parent ions lost a neutral fragment of a 
particular mass. For example, you can specify a neutral loss of 80 u (as in the case of a 
phosphorylated peptide in a tryptic digest). A Neutral Loss Ion Mapping experiment can step 
through each product mass in the mixture. The experiment searches for evidence of the loss of 
a neutral moiety of mass 80 u.

A Parent Ion Mapping experiment identifies all the ions that produce a particular molecular 
ion that you specify. For example, if you specify a product ion mass of m/z 50, a Parent Ion 
Map includes all the parent ions that yielded the specified product ion, m/z 50.

A Data-Dependent Zoom Map is an Ion Mapping experiment that collects ZoomScan data 
on every scan interval in a mass range that you specify, as well as Data-Dependent MS/MS 
product spectra on every mass above an intensity threshold.

You can view the results of any of the Ion Mapping experiments in the Xcalibur Qual Browser 
window.
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Ion Tree Experiments

In an Ion Tree experiment, the LCQ Fleet can collect MSn data automatically. You can 
specify a particular parent ion for fragmentation or let the LCQ Fleet find the parent ions 
automatically and fragment them to any level between MS2 and MS10. The LCQ Fleet 
automates the collection of data by deciding what actions need to occur next for the 
experiment to progress. 

In an Ion Tree experiment, you can specify either of two options to prioritize how the LCQ 
Fleet gathers information, Depth Focus or Breadth Focus. 

• Depth Focus characterizes an ion by performing a series of MSn-level fragmentations (for 
example, MS/MS, MS3, MS4, and so on) before characterizing the next most intense ion 
in the MSn series. 

• Breadth Focus characterizes all ions to the same MSn level before advancing to the next 
MSn level. 

For example, if you specify a Maximum Depth of three and a Maximum Breadth of two in an 
Ion Tree experiment, the following occurs:

1. With either Depth or Breadth Focus, the LCQ Fleet scans for parent ions (MS) over the 
specified mass range. The most intense ion of the MS spectrum is selected for 
fragmentation (MS/MS). 

2. If you chose the Depth Focus, after the most intense ion of the MS spectrum is 
fragmented—producing an MS/MS spectrum—the LCQ Fleet selects and fragments the 
most intense ion of the MS/MS spectrum. This results in an MS3 spectrum, the level 
specified as the maximum depth for this example. The LCQ Fleet then backs up one level 
and fragments the second most intense ion of the MS/MS spectrum, creating more 
product ions on the level of MS3 from this parent ion. This process is then repeated for 
the second most intense ion in the MS spectrum.

3. If you chose the Breadth Focus, after the most intense ion of the MS spectrum is 
fragmented—producing an MS/MS spectrum—the LCQ Fleet selects and fragments the 
second most intense ion of the same MS spectrum. The fragmentation of parent ions 
continues to the Max Breadth level that you specified (in this example, two). After the 
two most intense peaks on the MS level are fragmented, the LCQ Fleet scans the first 
MS/MS spectrum to select and fragment the two most intense ions. This results in 
product ions on the level of MS3, the level specified as the maximum depth for this 
example. This process is then repeated for the second most intense ion in the MS 
spectrum.

You can view the results of a Data-Dependent Ion Tree experiment in the Xcalibur Qual 
Browser window. The results are displayed as a structure tree that originates from a particular 
parent ion.
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Functional Description

This chapter describes the principal components of the LCQ Fleet LC/MS system and their 
respective functions. 

This chapter contains the following sections:

• Liquid Chromatography System

• Syringe Pump

• Divert/Inject Valve 

• Mass Spectrometer (MS) Detector

• Data System

Figure 7 shows a functional block diagram of the LCQ Fleet system. A sample transfer line 
connects the liquid chromatograph (LC) to the MS detector. The autosampler and LC are 
usually installed on the left of the MS detector. The syringe pump and divert/inject valve are 
integrated into the MS detector cabinet.

In analysis by LC/MS, a sample is injected onto an LC column. The sample is then separated 
into its various components. The components elute from the LC column and pass into the 
MS detector where they are analyzed. 

Upon entering the atmospheric ionization (API) source, sample molecules are ionized by 
electrospray ionization (ESI), atmospheric pressure chemical ionization (APCI), atmospheric 
pressure photoionization (APPI), or nanospray ionization (NSI). The ion optics focus and 
accelerate the resulting sample ions into the mass analyzer, where they are analyzed according 
to their mass-to-charge ratios. The sample ions are then detected by an ion detection system 
that produces a current proportional to the number of ions detected. The current from the 
ion detection system is received and amplified by the LCQ Fleet electronics. This current is 
then passed on to the data system for further processing, storage, and display. The data system 
provides the primary LCQ Fleet user interface.
Thermo Scientific LCQ Fleet Hardware Manual 21
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 2 Functional Description
Liquid Chromatography System
Liquid Chromatography System
In general, a liquid chromatography system, used as an inlet for a mass spectrometer, consists 
of an autosampler, an analytical pump, and an LC column. Some autosamplers include a 
built-in column oven, and some LC systems contain an additional column heater device.

This section contains the following topics:

• Autosampler

• Liquid Chromatography Pump and Column

Autosampler

The autosampler is used to inject samples automatically into the mobile phase stream 
produced by the liquid chromatography pump. You can control the Thermo Scientific 
autosampler (Surveyor Autosampler or Accela Autosampler) Waters 2795 Separations 
module, and Agilent (1100) autosamplers directly from the Xcalibur data system. With an 
autosampler, you can automate your LC/MS analyses.

To control an autosampler from the Xcalibur data system, you must first add it to your 
instrument configuration. Refer to the online Help provided with the Xcalibur Instrument 
Configuration application for more information on configuring your autosampler.

After you add the autosampler to the instrument configuration, you can specify its injection 
parameters in the Xcalibur Instrument Setup application. Refer to the Xcalibur online Help 
for a description of the Instrument Setup application.

Front-panel (or keypad) operation of the autosampler and maintenance procedures for the 
autosampler are described in the documentation provided with your autosampler.

Liquid Chromatography Pump and Column

The high performance liquid chromatograph (LC), which consists of an LC pump and an LC 
column, separates a sample mixture into its chemical components by liquid chromatography. 
In liquid chromatography, the sample mixture partitions between a solid stationary phase of 
large surface area and a liquid mobile phase that percolates over the stationary phase. The 
molecular structure of each component of the mixture determines when each component 
elutes from the LC and enters the MS detector.

Note  For other autosamplers, the LCQ Fleet provides contact closure Start/Stop signals. 
Refer to the LCQ Fleet Getting Connected manual for information on connecting an 
autosampler to the LCQ Fleet by contact closure Start/Stop signals.
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You can control the Thermo Scientific (Surveyor MS Pump, Surveyor LC Pump Plus, or 
Accela Pump), and Agilent (1100) LCs (and the corresponding UV detectors) directly from 
the Xcalibur data system. Refer to the LCQ Fleet Getting Connected manual for information on 
connecting an LC to the LCQ Fleet MS detector. 

To control the devices of your liquid chromatograph, you must first add them to your 
instrument configuration. Refer to the online Help provided with the Xcalibur Instrument 
Configuration application for more information on configuring these devices.

After you add an LC pump to your instrument configuration, you specify the 
chromatographic parameters in the Xcalibur Instrument Setup application. Refer to the 
Xcalibur online Help for a description of the Instrument Setup application.

Front-panel (or keypad) operation of the LC devices and maintenance procedures for the LC 
devices are described in the documentation provided with these devices.

Syringe Pump
The LCQ Fleet includes an electronically controlled, integrated, syringe pump. The syringe 
pump delivers sample solution from the syringe into the API source. See Figure 8. When the 
syringe pump is operating, a motor drives a pusher block that depresses the plunger of the 
syringe at a rate (volume per minute) that is user adjustable. Liquid flows out of the syringe 
needle and into the sample transfer line as the plunger is depressed. A syringe holder keeps the 
syringe in place. Refer to the LCQ Fleet Getting Started Guide for instructions on setting up 
the syringe pump.

You can start and stop the syringe pump from the Syringe Pump dialog box, which can be 
reached from the Tune Plus window (or by choosing Start > All Programs > Xcalibur > LCQ 
Fleet Tune). Refer to the Xcalibur online Help for instructions on operating the syringe 
pump from the data system.

The syringe pump light emitting diode (LED) is green whenever the syringe pump is 
pumping. The LED is off if the syringe pump is at the end of its travel.
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Figure 8. Syringe pump 

Divert/Inject Valve
The divert/inject valve is located on the front of the LCQ Fleet to the left of the API source. 
See Figure 9. 

Figure 9. Divert/inject valve set up for flow injection analyses

You can configure (plumb) the divert/inject valve as a loop injector (for flow injection 
analysis) or as a divert valve. Procedures for plumbing the valve as a loop injector or a divert 
valve are provided in both the LCQ Fleet Getting Connected Guide and the LCQ Fleet Getting 
Started Guide.

LC Union Needle Syringe Syringe Holder Pusher Block

3

5
1

Sample Loop

Needle Port
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You can control the divert/inject valve from the data system. You specify the parameters of the 
divert/inject valve in the Divert/Inject Valve dialog box, located in the Tune Plus window, or 
the Divert Valve page, located in the Instrument Setup window. Refer to the online Help for 
instructions on operating the divert/inject valve from the data system.

You can also use the divert/inject valve button to divert the LC flow between the MS detector 
and waste when the valve is in the divert valve configuration, or switch between load and 
inject modes when the valve is in the loop injector configuration.

Mass Spectrometer (MS) Detector
The MS detector provides sample ionization and mass analysis of samples injected directly 
into the inject/divert valve or samples eluted from a liquid chromatograph. The LCQ Fleet 
MS detector uses a three-dimensional ion trap mass analyzer with an ion source external to 
the mass analyzer. 

The primary components of the mass spectrometer are as follows:

• Manual Controls and LED Indicators

• API Source

• Ion Optics

• Mass Analyzer

• Ion Detection Systems

• Vacuum System and API Source Gas Hardware

• Cooling Fans

• Electronic Assemblies

Manual Controls and LED Indicators

The LCQ Fleet has the following LED indicators and manual controls:

• Front Panel LEDs

• Main Power Circuit Breaker Switch

• Electronics Service Switch

• Reset Button

• Divert/Valve LEDs and Push-Button

• Syringe Pump LED and On/Off Push Button
LCQ Fleet Hardware Manual Thermo Scientific
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Front Panel LEDs

Five indicator LEDs (light-emitting diodes)—labeled Power, Vacuum, Communication, 
System, and Scanning— are located on the upper-right side of the MS detector as shown in 
Figure 10.

Figure 10. Front panel LEDs of the MS detector

Table 1. LED indicators

State Yellow Green Not Illuminated Flashing Blue

Power LED N/A Power is being 
supplied to the 
vacuum system and 
electronic assemblies 
of the MS detector.

Power is not being 
supplied to the LCQ 
Fleet.

N/A

Vacuum LED A vacuum sensor 
detects a fault and 
power is being 
applied to the LCQ 
Fleet components.

The vacuum 
protection circuitry 
indicates that the 
vacuum is within the 
allowable operating 
range. 

High voltage is not 
being applied to the 
LCQ Fleet 
components.

N/A

Communication LED The MS detector and 
the data system are 
trying to establish a 
communication link.

The data system is 
communicating with 
the MS detector. 

Power is not being 
supplied to the LCQ 
Fleet.

N/A

System LED The API interlock is 
open (that is, high 
voltage is not 
supplied to the API 
source, mass analyzer, 
and ion detection 
system) and the MS 
detector power is on.

The MS detector is 
on and high voltage is 
being supplied to the 
API source, mass 
analyzer, and ion 
detection system. 

Power is not being 
supplied to the LCQ 
Fleet.

N/A

Scanning LED N/A N/A The MS detector is 
not scanning ions.

 The MS detector is 
on and scanning ions.

Power Vacuum Communication System Scanning
Thermo Scientific LCQ Fleet Hardware Manual 27



2 Functional Description
Mass Spectrometer (MS) Detector

28
Main Power Circuit Breaker Switch

The main power circuit breaker switch (labeled Main Power) is located on the power panel, 
which is located on the lower portion of the right side panel of the MS detector. See 
Figure 11. In the Off (O) position, the circuit breaker removes all power to the MS detector, 
including the external forepump. In the On (|) position, power is supplied to the MS 
detector. In the standard operational mode, the circuit breaker is kept in the On (|) position.

Electronics Service Switch

The electronics service switch is located on the power panel as shown in Figure 11. In the 
Service position, the switch removes power to all components of the MS detector other than 
the vacuum system, which includes both the forepump and turbomolecular pump. In the 
Electronics Normal position, power is supplied to all components of the MS detector. 

Reset Button

The reset button is also located on the power panel. When you briefly press the reset button, 
the LCQ Fleet software is reloaded from the data system. See “Resetting the MS Detector” on 
page 117 in Chapter 5 of this manual for information on resetting the MS detector.

Figure 11. Power panel 

CAUTION  In an emergency, to shut off all power to the MS detector, place the main 
power circuit breaker switch (labeled Main Power) in the Off (O) position. Do not use the 
electronics service switch. 
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Divert/Valve LEDs and Push-Button

The push-button switch located on the front panel above the divert/inject valve toggles the 
position of the two-position valve. LEDs to the left of the button indicate the position of the 
valve as shown in Figure 12. 

Figure 12. Divert/inject valve button and LEDs 

When the divert/inject valve is set up for loop injections (flow injection analysis, FIA), 
pressing the divert/inject valve button toggles the valve between the load and inject modes. 
The Load and Inject LEDs indicate the position of the valve. 

When the divert/inject valve is set up for divert valve operation, pressing the divert/inject 
valve button toggles the LC flow between the MS detector and the waste container. The 
Detector and Waste LEDs indicate the position of the valve.

Syringe Pump LED and On/Off Push Button

The blue push-button switch located on the front panel above the syringe pump toggles the 
syringe pump on and off. An LED above the button indicates whether the pump is on or off.

API Source

The atmospheric pressure ionization (API) source forms gas phase sample ions from sample 
molecules that are contained in solution. The API source also serves as the interface between 
the LC and the MS detector. You can operate the API source using the electrospray ionization 
(ESI), atmospheric pressure chemical ionization (APCI), atmospheric pressure 
photoionization (APPI), or nanospray ionization (NSI) techniques.

The API source consists of the following:

• Ion Max-S Ion Source

• Ion Source Interface

Ion Max-S Ion Source

The Ion Max-S™ ion source, shown in Figure 13, is the part of the API source that is at 
atmospheric pressure. The Ion Max-S™ ion source can be configured to operate in any of 
several API modes, including electrospray ionization (ESI), atmospheric pressure chemical 
ionization (APCI) and atmospheric pressure photoionization (APPI). The ion optics transmit 
the ions produced in the API source into the mass analyzer, where they are separated 
according to their mass-to-charge ratios.

Load

Inject Waste

Detector
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Figure 13. Ion Max-S ion source 

The Ion Max-S ion source housing enables you to quickly switch between ionization modes 
without the need for specialized tools. Ventilation in the ion source housing keeps the 
housing cool and easy to handle. The ion source is kept at atmospheric pressure. The probe 
mounting angle is fixed at the optimum angle for signal intensity and ion source robustness. 
The probe position in the Z dimension is adjustable to allow for further optimization of signal 
intensity. A view port, which enables visual control of probe positioning and monitoring 
during operation, and facilitates the addition of accessories, is located at the side of the ion 
source housing. 

The ion source lifetime is excellent due to several special features. The drain size and angle 
prevent ion source corrosion by allowing eluants to flow directly from the probe into the 
drain when auxiliary gases are off. For liquids that do not enter the drain directly, the floor of 
the ion source interior is sloped to enable maximum drainage of collected eluants. 
Additionally, the zero dead volume LC grounding union that connects the LC flow to the ESI 
sample inlet is offset from the ion source to prevent LC leaks from dripping directly on the 
ion source housing.

The Ion Max-S ion source has a universal mounting platform and interface for use with ESI, 
APCI, NSI, and APPI ionization sources. For more information on the analysis of ions 
produced by the Ion Max-S ion source, refer to the Ion Max and Ion Max-S API Source 
Manual.
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Ion Source Interface

The ion source interface consists of the components of the API source that are held under a 
vacuum (except for the atmospheric pressure side of the ion sweep cone). The ion source 
interface includes an ion sweep cone, vent prevent ball, ion transfer capillary, two cartridge 
heaters, heater block, platinum probe sensor, tube lens, and skimmer. See Figure 14 and 
Figure 15. 

The ion sweep cone is a metallic cone over the ion transfer capillary and acts as a physical 
barrier that protects the entrance of the capillary. 

The ion transfer capillary assists in desolvating ions that are produced by ESI, APCI, NSI, or 
APPI. This capillary is a metal, 4-in. long cylindrical tube. The vent prevent ball falls into the 
space occupied by the ion transfer capillary when the capillary is removed, thus preventing air 
from entering the vacuum manifold. The vent prevent ball allows you to remove the ion 
transfer capillary for cleaning without venting the system. Two heater cartridges are 
embedded in the heater block. The heater block surrounds the ion transfer capillary and heats 
it to temperatures up to 400 °C. A platinum probe sensor measures the temperature of the 
heater block. Typical temperatures of the ion transfer capillary are 270 °C for ESI and 250 °C 
for APCI. Ions are drawn into the ion transfer capillary in the atmospheric pressure region 
and transported to the capillary-skimmer region of the vacuum manifold by a decreasing 
pressure gradient. A potential of typically 0 to ±10 V (positive for positive ions and negative 
for negative ions) assists in repelling ions from the ion transfer capillary to the skimmer. 

The system electronics includes an over-temperature/under-temperature circuit and a voltage 
monitor circuit to protect the heaters. The voltage monitoring circuit detects shorting failures. 
The over-temperature circuit operates as a thermal limit switch to prevent the heater from 
going above a preset maximum temperature. The under-temperature feature protects against 
false low temperature readings. These could occur due to faults in the platinum probe 
temperature sensor that prevent it from sensing the preset maximum temperature. Such false 
low temperature readings could cause the heater to run at its maximum setting and cause 
damage to the capillary.

Ions from the ion transfer capillary enter the tube lens. The tube lens has a mass dependent 
potential applied to it that focuses the ions towards the opening of the skimmer. When you 
tune the LCQ Fleet, you adjust the tube lens offset voltage to maximize sensitivity by 
balancing desolvation with fragmentation.

Ions from the tube lens pass through the skimmer and move toward the Q00 RF lens. The 
skimmer acts as a vacuum baffle between the higher pressure ion source interface region and 
the lower pressure Q00 region of the vacuum manifold. 

The ion source interface is enclosed in a vacuum chamber that is evacuated by the forepump 
(also known as s a rotary-vane pump or mechanical pump). 
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Figure 14. Cross sectional view of the ion source interface and Q00/L0RF lens

Figure 15. Internal (under vacuum) components of the MS detector
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Ion Optics

The ion optics focus the ions produced in the API source and transmit them to the mass 
analyzer. The ion optics consist of the following:

• Q00/L0 RF Lens

• Q0 Ion Guide

• Q1 Ion Guide

Q00/L0 RF Lens 

The Q00/L0 RF lens is located closest to the API source. The Q00/L0 RF lens includes the 
Q00 RF lens and L0 lens. See Figure 14 and Figure 15.

The Q00 RF lens is a square array of square-profile segments that act as an ion focusing 
device. Any RF voltage that is applied to the optics produces an electric field that focuses the 
ions along the axis of the Q00 RF lens. A dc voltage offset from ground that is applied to the 
Q00 RF lens—called the Q00 offset voltage—increases the translational kinetic energy of 
ions emerging from the skimmer. During ion transmission, the offset voltage is negative for 
positive ions and positive for negative ions. Increasing the offset voltage increases the 
translational kinetic energy of the ions. Typical values of the Q00 offset voltage are –4 V 
to +4 V. 

The lens L0 is a metal disk with a circular hole in the center through which the ion beam can 
pass. An electrical potential of between 0 and ±5 V (negative for positive ions and positive for 
negative ions) is applied to lens L0 to aid in ion transmission. Lens L0 also acts as a vacuum 
baffle between the Q00 RF lens and the Q0 ion guide. The Q00 RF lens chamber of the 
vacuum manifold is evacuated by the third inlet in the molecular drag section of the 
turbomolecular pump.

Q0 Ion Guide

The Q0 ion guide transmits ions from the Q00 RF lens to the Q1 ion guide. The Q0 ion 
guide includes the Q0 quadrupole and lens L1. See Figure 15.

The Q0 quadrupole is a square array of square-profile rods that act as an ion transmission 
device similar to the Q00 RF lens. An RF voltage that is applied to the rods produces an 
electric field that guides the ions along the axis of the quadrupole. The Q0 offset voltage 
increases the translational kinetic energy of ions emerging from the Q00 RF lens. Q0 must be 
at a lower potential than the Q00 RF lens.

The lens L1 is a metal disk with a circular hole in the center through which the ion beam can 
pass. An electrical potential can be applied to the lens to accelerate (or decelerate) ions as they 
approach the lens and to focus the ion beam as it passes through the lens. The value ranges 
between 0 and ±125 V. Lens L1 also acts as a vacuum baffle between the Q0 ion guide 
chamber and the mass analyzer chamber. The interstage inlet of the turbomolecular pump 
evacuates the Q0 ion guide chamber.
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Q1 Ion Guide

The Q1 ion guide transmits ions from the Q0 ion guide to the mass analyzer. The Q1 ion 
guide includes the Q1 octapole and the gate lens. See Figure 15.

The Q1 octapole is an octagonal array of round-profile rods that act as an ion transmission 
device similar to the Q00 RF lens and Q0. An RF voltage that is applied to the rods produces 
an electric field that guides the ions along the axis of the octapole. The Q1 offset voltage 
increases the translational kinetic energy of ions emerging from Q0. 

The gate lens starts and stops the injection of ions into the mass analyzer.

The front lens focuses the ions before entering the trap.

Mass Analyzer

The mass analyzer is the site of mass analysis (that is, ion storage, ion isolation, collision 
induced dissociation, and ion scanout). This topic describes the following:

• Components of the Mass Analyzer 

• Main RF Voltage Applied to the Mass Analyzer Ring Electrode

• Voltages Applied to the Mass Analyzer End Caps

• Helium Gas in the Mass Analyzer Cavity

• Operation of the Mass Analyzer During Mass Analysis

Components of the Mass Analyzer

The mass analyzer consists of an entrance endcap electrode, ring electrode, and the exit 
endcap electrode (see Figure 15). The entrance endcap electrode and exit endcap electrodes 
are metal disks with circular holes in their centers through which the ion beam can pass. The 
inner surfaces of these electrodes have a complex shape. The electrodes form a cavity in which 
mass analysis occurs. 

The entrance endcap electrode is the electrode that is closest to the ion optics, and the exit 
endcap electrode is the electrode that is closest to the ion detection system. Both endcap 
electrodes have a small hole in their centers to permit the passage of ions into and out of the 
mass analyzer cavity. The ring electrode is located between the endcap electrodes. Ions 
produced in the API source enter the mass analyzer cavity through the entrance endcap 
electrode. Ions are ejected through either endcap electrode during mass analysis. The 
conversion dynode accelerates ions ejected from the exit endcap towards the ion detection 
system. The potential of the conversion dynode relative to the exit endcap, which is at ground 
potential, creates the accelerating potential. Helium damping gas enters the mass analyzer 
cavity through a nipple on the entrance endcap electrode.
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Two quartz space rings separate the entrance endcap electrode, exit endcap electrode, and ring 
electrode. The spacer rings position the electrodes at the proper distance apart and also serve 
as electrical insulators. Two nonconducting analyzer posts pass through both endcap 
electrodes and screw into the analyzer mount (also nonconducting). A spring washer and 
analyzer nut on the end of each post apply a force to the exit endcap electrode that holds the 
electrodes and spacers in place. 

Figure 16. The 3D ion trap assembly 

Main RF Voltage Applied to the Mass Analyzer Ring Electrode

The RF voltage is applied only to the ring electrode (see Figure 16) and is of constant 
frequency (825 kHz) and of variable amplitude (0 to 10000 V zero-to-peak). Because the 
frequency of this RF voltage is in the radio frequency (RF) range, it is referred to as the main 
RF voltage. The application of the main RF voltage to the ring electrode produces a 
three-dimensional quadrupole field within the mass analyzer cavity. This time-varying field 
drives ionic motion in the axial radial direction. Ionic motion must be stable in both 
directions for an ion to remain trapped. (A stable trajectory is an oscillatory trajectory that is 
confined within the mass analyzer). During ion scan–out, the system produces a 
mass-dependent instability to eject ions from the mass analyzer in the axial direction. The ions 
are ejected from holes in the end caps and go to the dynode (Figure 16). The ions strike the 
dynode and release particles. An electron multiplier captures and amplifies these secondary 
particles producing the signal that the instrument associates with the ions that are responding 
to the mass-dependent instability.
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When the amplitude of the main RF voltage is low, all ions above a minimum mass-to-charge 
ratio are trapped. This RF voltage is referred to as the storage voltage, and the minimum 
mass-to-charge ratio is usually chosen to be greater than the mass-to-charge ratios associated 
with air, water, and solvent ions. During ion scan–out, the main RF voltage is ramped at a 
constant rate corresponding to approximately 12500 u/s (for unit resolution). As the main RF 
voltage increases, ions of increasing mass-to-charge ratio become successively unstable in the 
axial direction and are ejected from the mass analyzer. The voltage at which an ion is ejected 
from the mass analyzer is defined as its resonance voltage. The ejection of ions of each 
mass-to-charge ratio occurs over a very short time with the ion detection system detecting 
many of these ejected ions.

Voltages Applied to the Mass Analyzer End Caps

The ion isolation waveform, resonance excitation, and resonance ejection signals are 
AC voltages that are applied to the end caps (see Figure 16) to stimulate motion of the ions in 
the direction of the ion detection system. The voltages applied to the end caps are equal in 
amplitude but are 180o out of phase with each other. When the AC frequency applied to the 
end caps equals the resonance frequency of a trapped ion, which depends on its mass, the ion 
gains kinetic energy. If the magnitude of the applied voltage is large enough or the ion is given 
sufficient time, the ion is ejected from the mass analyzer in the direction of the ion detection 
system (through the hole in one of the end caps as shown in Figure 16). The ion detection 
system consists of the conversion dynode and electron multiplier (Figure 15 and Figure 16).

The waveform signal needed for ion isolation consists of a distribution of frequencies between 
5 and 425 kHz, containing all resonance frequencies except for those corresponding to the 
ions to be trapped. The ion isolation waveform acts during the ion isolation step of SIM, 
SRM, CRM, or MSn (n > 1) full–scan applications. The waveform for ion isolation, in 
combination with the main RF voltage, ejects all ions except those of a selected 
mass-to-charge ratio or narrow ranges of mass-to-charge ratios. The LCQ Fleet calculates and 
automatically applies the correct waveform voltage at the correct time.

During the collision–induced dissociation step of SRM, CRM, or MSn (n > 1) full–scan 
applications, the resonance excitation signal is applied to the end caps to fragment parent ions 
into product ions. The signal is not strong enough to eject an ion from the mass analyzer. 
However, ion motion in the radial direction is enhanced and the ion gains kinetic energy. 
After many collisions with the helium damping gas that is present in the mass analyzer, the 
ion gains enough internal energy to cause it to dissociate into product ions. The product ions 
are then mass analyzed.

During ion scan–out, the AC voltage for resonance ejection facilitates the ejection of ions 
from the mass analyzer and thus improves mass resolution. The AC voltage is applied at a 
fixed frequency and increasing amplitude during the ramp of the main RF voltage. Only 
when an ion is about to be ejected from the mass analyzer cavity by the main RF voltage is it 
in resonance with the resonance ejection signal. When an ion approaches resonance, it moves 
farther away from the center of the mass analyzer, where the field generated by the main RF 
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voltage is zero (and space-charge effects are strong), into a region where the field produced by 
the main RF voltage is strong (and space-charge effects are small). As a result, the ejection of 
the ion is facilitated, and mass resolution is significantly improved.

Helium Gas in the Mass Analyzer Cavity

The mass analyzer cavity contains helium that is used as a damping gas and as a collision 
activation partner. The helium damping gas enters the mass analyzer cavity through a passage 
in the end cap. An open split regulates the flow of gas (approximately 1 mL/min) into the 
mass analyzer cavity, while the openings in the mass analyzer restrict the flow of gas out of the 
mass analyzer cavity (and into the turbomolecular pump). The flows into and out of the 
cavity are matched so that the partial pressure of helium in the mass analyzer cavity is 
maintained at the proper pressure.

As the ions enter the mass analyzer, they collide with the helium atoms and lose kinetic 
energy, which allows the RF field in the mass analyzer to trap them. As the ions continue to 
collide with the helium atoms, the amplitude of their oscillations decreases and they become 
focused towards the center of the trap, which significantly enhances sensitivity and mass 
spectral resolution. 

Helium in the mass analyzer cavity also serves as a collision activation partner. During the 
collision induced dissociation step of an SRM, CRM, or MSn (n > 1) full–scan analysis, the 
AC voltage (used to induce resonance excitation) applied to the end caps drives parent ions 
into the helium atoms. After gaining sufficient internal energy from the resulting collisions, 
the parent ion dissociates into one or more product ions.

Operation of the Mass Analyzer During Mass Analysis

The processes that occur in the mass analyzer can be broken down into four steps:

For SRM and MS/MS full–scan applications the ion isolation and collision induced 
dissociation steps are performed once. For CRM and MSn (n > 1) full–scan applications, the 
ion isolation and collision induced dissociation steps are performed n-1 times. 

• Ion Storage

Before ion storage, helium is present in the mass analyzer cavity, and the main RF voltage 
is set to the storage voltage. The ion isolation waveform voltage, resonance excitation AC 
voltage, and resonance ejection AC voltage on the end caps are off.

With these conditions achieved, sample ions formed in the API source are trapped in the 
mass analyzer if the ions have mass-to-charge ratios greater than the minimum storage 
mass-to-charge ratio.

• Ion Isolation (SIM, SRM, CRM, or MSn [n > 1] full scan only) 

Next, the ion isolation waveform voltage is applied to the end caps, in combination with 
a ramp of the main RF voltage to a new storage voltage, to eject all ions except those of 
the selected mass-to-charge ratio.
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• Collision induced dissociation (SRM, CRM, or MSn [n > 1] full scan only)

Then, for SRM, CRM, or MSn (n > 1) full–scan analyses, the resonance excitation AC 
voltage is applied to the end caps to cause collision induced dissociation. Product ions 
with mass-to-charge ratio greater than the minimum storage mass-to-charge ratio are 
stored. (The minimum storage mass during collision induced dissociation is typically set 
to one quarter of the parent ion mass-to-charge ratio.)

For SRM and MS/MS full scan applications, the ion isolation and collision induced 
dissociation steps are performed once. For CRM and MSn (n > 1) full–scan applications, 
the ion isolation and collision induced dissociation steps are performed n-1 times.

• Ion scan out (the ion detection step)

Finally, the sample ions or product ions are scanned out: The main RF voltage is ramped 
from low voltage to high voltage, and simultaneously the resonance ejection AC voltage is 
applied to the end caps to facilitate ejection. As the main RF voltage increases, ions of 
greater and greater mass-to-charge ratios become unstable and are ejected through the 
slots in the exit rods. Many of these ions are focused toward the ion detection system 
where they are detected.

Ion Detection Systems

The LCQ Fleet is equipped with one high sensitivity, on-axis ion detection system that 
produces a high signal-to-noise ratio and allows for voltage polarity switching between 
positive ion and negative ion modes of operation. The ion detection system includes a 15-kV 
conversion dynode and a channel electron multiplier. The ion detection system is located 
behind the mass analyzer (see Figure 15 and Figure 16). 

Figure 17 shows the details of the ion detection system. The conversion dynode is a concave 
metal surface that is located at a right angle to the ion beam. A potential of +15 kV for 
negative ion detection, or -15 kV for positive ion detection, is applied to the conversion 
dynode. When an ion strikes the surface of the conversion dynode, one or more secondary 
particles are produced. These secondary particles can include positive ions, negative ions, 
electrons, and neutrals. When positive ions strike a negatively charged conversion dynode, the 
secondary particles of interest are negative ions and electrons. When negative ions strike a 
positively charged conversion dynode, the secondary particles of interest are positive ions. The 
curved surface of the conversion dynode focuses these secondary particles, and a voltage 
gradient accelerates them into the electron multiplier. The conversion dynode shield and disk 
shield the vacuum manifold from the electric field that the conversion dynode produces.

The electron multiplier is mounted on the top cover plate of the vacuum manifold behind the 
mass analyzer. See Figure 17 and Figure 21. The electron multiplier includes a cathode and an 
anode. The cathode of the electron multiplier is a lead-oxide, funnel-like resistor. A potential 
of up to -2.5 kV is applied to the cathode by the high voltage ring. The exit end of the 
cathode (at the anode) is near ground potential. The cathode is held in place by the high 
voltage ring, two support plates, the electron multiplier support, and the electron multiplier 
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shield. A spring washer applies a force to the cathode to hold it in contact with the electron 
multiplier shield. Two screws attach the electron multiplier support to the top cover plate of 
the vacuum manifold. 

The anode of the electron multiplier is a small cup located at the exit end of the cathode. The 
anode collects the electrons produced by the cathode. The anode screws into the anode 
feedthrough in the top cover plate.

Secondary particles from the conversion dynode strike the inner walls of the electron 
multiplier cathode with sufficient energy to eject electrons. The ejected electrons are 
accelerated farther into the cathode, drawn by the increasingly positive potential gradient. 
Due to the funnel shape of the cathode, the ejected electrons do not travel far before they 
again strike the inner surface of the cathode, thereby causing the emission of more electrons. 
The resulting cascade of electrons creates a measurable current at the end of the cathode 
where the anode collects the electrons. The current collected by the anode is proportional to 
the number of secondary particles striking the cathode. 

Typically, the electron multiplier is set to a gain of about 4 × 105 (for example, for each ion or 
electron that enters, 4 × 105 electrons exit). The current that leaves the electron multiplier via 
the anode is converted to a voltage by the electrometer circuit and recorded by the data 
system. Refer to “Ion Detection System Electronic Assemblies” on page 53.
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Figure 17. Cross–sectional view of the ion detection system 
 

The ion detection system of the LCQ Fleet increases signal and decreases noise. The high 
voltage applied to the conversion dynode results in a high conversion efficiency and increased 
signal. That is, each ion striking the conversion dynode produces many secondary particles. 
The increase in conversion efficiency is more pronounced for more massive ions than for less 
massive ions.
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Vacuum System and API Source Gas Hardware

The vacuum system evacuates the region around the API stack, ion optics, mass analyzer, and 
ion detection system. The vacuum system and API source gas hardware includes the following 
components:

• Vacuum Manifold

• Turbomolecular Pump

• Forepump

• Convectron® Gauge

• Ion Gauge

• Vent Valve

• Damping Gas Inlet Assembly

• API Source Gas Hardware

Figure 18 shows a functional block diagram of the vacuum system and API source gas 
hardware.

Figure 18. Vacuum system and inlet gas hardware (functional block diagram)
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Vacuum Manifold

The vacuum manifold encloses the ion source interface, ion guides, mass analyzer, and ion 
detection system assemblies. The vacuum manifold is a thick-walled, aluminum chamber with 
a removable top cover plate, machined flanges on the front, sides, and bottom, and various 
electrical feedthroughs and gas inlets. 

The vacuum manifold is divided into four chambers by three baffles. Figure 19 shows three of 
these chambers. The forepump evacuates the capillary/skimmer region inside the first 
chamber. The third inlet in the molecular drag section of the triple-inlet turbomolecular 
vacuum pump evacuates the Q00 RF lens region. The interstage port of the turbomolecular 
vacuum pump evacuates the Q0 ion guide region. The high vacuum port of the 
turbomolecular pump evacuates the analyzer region. In turn, the turbomolecular pump 
discharges into the forepump through the foreline.

Three high-voltage electrical feedthroughs pass through the vacuum manifold, one 
feed-through for each of the following: 

• The conversion dynode high voltage

• The RF voltage of the mass analyzer 

• The AC voltages of the mass analyzer

Figure 19. Vacuum manifold 
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The removable top cover plate of the vacuum manifold holds the Q0 and Q1 ion guides, the 
electron multiplier (part of the ion detection system), and ion trap. Removing of the top cover 
plate gives you access to these assemblies. The top cover plate has two handles on the top and 
four guide posts on the underside to facilitate its removal and installation. An O-ring provides 
a vacuum-tight seal between the top cover plate and the vacuum manifold. Figure 20 and 
Figure 21 show the top cover plate and its attached assemblies.

Figure 20. Top cover plate of the vacuum manifold (topside) 

Six electrical feedthroughs pass through the top cover plate:

• Two 4-pin and two 8-pin feedthroughs for the RF and DC voltages to the ion optics

• One feedthrough for the high voltage to the cathodes of the electron multiplier
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Figure 21. Top cover plate of the vacuum manifold (underside), and attached assemblies 

Turbomolecular Pump

A Leybold TW220/150/15S triple-inlet turbomolecular pump provides the vacuum for the 
Q00 RF lens region, Q0 ion guide region, and analyzer region of the vacuum manifold. The 
turbomolecular pump mounts onto the bottom of the vacuum manifold. 

The turbomolecular pump has three pumping inlets (see Figure 22): 

• A 220 L/s high-vacuum inlet at the top of the rotor stack, which evacuates the analyzer 
chamber

• A 150 L/s interstage inlet about half way down the rotor stack, which evacuates the Q0 
ion guide chamber 

• A 15 L/s third inlet in the molecular drag section of the pump, which evacuates the Q00 
RF lens chamber
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Figure 22. Turbomolecular pump

The turbomolecular pump is controlled by a Leybold TDS controller and powered by a 
+24 V dc power supply. The main power circuit breaker switch turns off the power for the 
turbomolecular pump, not the electronics service switch. A fan that draws air in from the 
front of the instrument cools the pump.

The Leybold TDS Turbomolecular Pump Controller provides power to and control of the 
turbomolecular pump. The turbomolecular pump status (such as the temperature or 
rotational speed) is sent from the Turbomolecular Pump Controller to the embedded 
computer over a serial line. Power to the turbomolecular pump is shut off if the pump 
temperature is too high.

Forepump

An Edwards E2M30 forepump (also referred to as a rotary-vane pump or a mechanical pump) 
establishes the vacuum necessary for the proper operation of the turbomolecular pump. The 
forepump also evacuates the ion transfer capillary-skimmer region of the vacuum manifold. 
The pump has a maximum displacement of 650 L/min and maintains a minimum pressure of 
approximately 1 Torr. 

A section of 1.27 cm (0.5 in.) ID reinforced PVC tubing connects the forepump to the 
turbomolecular pump. The power cord of the forepump is plugged into the outlet labeled 
Mech. Pumps on the power panel (see Figure 11 on page 28). This outlet supplies power to 
the pump and is controlled by the main power circuit breaker switch and not by the 
electronics service switch. 
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Convectron® Gauge

The Convectron gauge measures the pressure in the ion transfer capillary-skimmer region of 
the vacuum manifold and the foreline, which connects the turbomolecular pump and the 
forepump.

Ion Gauge

A Granville-Phillips® 342™ mini ion gauge measures the pressure in the analyzer region of the 
vacuum manifold. The ion gauge produces energetic electrons that cause the ionization of 
molecules in the ion gauge. Positive ions formed in the ion gauge are attracted to a collector. 
The collector current is related to the pressure in the vacuum manifold. The ion gauge is also 
used in vacuum protection.

Vent Valve

The vent valve allows the vacuum manifold to be vented to air that has been filtered through 
a sintered nylon filter. The vent valve is a solenoid-operated valve. The vent valve is closed 
when the solenoid is energized.

The vacuum manifold is vented when external power is removed from the MS detector. A 
power failure or placing the main power circuit breaker in the Off (O) position removes 
power from the MS detector. After the external power is removed, power is provided to the 
vent valve for a short time. If external power is not restored to the MS detector in 10 seconds, 
however, power to the vent valve solenoid shuts off. When power to the vent valve solenoid 
shuts, the vent valve opens and the manifold is vented to filtered air. The vent valve closes 
after power to the MS detector is restored. 

Damping Gas Inlet Assembly

The damping gas inlet assembly controls the flow of helium into the mass analyzer cavity. 
Helium (40 ± 10 psig [275 ± 70 kPa], 99.999% [ultra-high] purity) enters the MS detector 
through a 1/8-in. port on the back of the MS detector. The LCQ Fleet regulates the flow of 
helium by use of an open split helium line. The helium enters the mass analyzer through a 
nipple on the ion trap mount.

Helium in the mass analyzer cavity dampens ionic motion and improves the performance of 
the MS detector. See “Helium Gas in the Mass Analyzer Cavity” on page 37.

CAUTION  Always plug the forepump power cord into the outlet labeled Mech. Pumps on 
the right side of the MS detector. Never plug it into a wall outlet. 
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API Source Gas Hardware

The source gas hardware controls the flow of sheath gas, auxiliary gas, and sweep gas into the 
MS detector. 

The sheath gas, auxiliary gas, and sweep gas valves control the flow of nitrogen into the API 
source. Sheath gas is nitrogen gas that flows through the inner coaxial of the API probe. The 
sheath gas converts the sample solution into a fine mist as the solution exits the sample tube. 
Auxiliary gas is the outer coaxial nitrogen gas that assists the sheath gas in the evaporation of 
the sample solution. Sweep gas flows out from behind the sweep cone in the ion source 
interface. The sweep gas aids in solvent declustering and adduct reduction. 

Dry nitrogen (100 ±20 psig [690 ±140 kPa], 99% purity) enters the MS detector through a 
1/4-in. port in the back of the MS detector. Valves that are controlled by the data system 
regulate the nitrogen pressure. You can set the flow rates from the Tune Plus window. Sheath 
gas is not used with an NSI source. The sheath gas, auxiliary gas, and sweep gas enter the API 
source through 1/4-in. ID tubing.

Cooling Fans

Five fans provide cooling for the MS detector: a 100 ft.3/min fan cools the RF voltage coil; a 
21 ft.3/min fan cools the turbomolecular pump; three 100 ft.3/min fans cool the electronics in 
the tower. Air is drawn in from the back of the MS detector. The exhaust air is expelled from 
the vent slots on the sides of the MS detector.

Electronic Assemblies

The electronic assemblies that control the operation of the MS detector are distributed among 
various printed circuit boards (PCBs) and other modules. These other modules are located in 
the electronics rack and on or around the vacuum manifold of the MS detector.

The electronic assemblies of the MS detector include the following:

• Power Entry Module and Power Distribution

• System Control and Monitoring Circuitry

• RF / Waveform Voltage Generation Electronic Assemblies

• Ion Detection System Electronic Assemblies

CAUTION  To ensure proper cooling, always operate the MS detector with its covers in 
place.
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Power Entry Module and Power Distribution

The Power Entry Module provides system power control, a contact closure interface, an 
Ethernet 100 Base T connection from the power/signal distribution PCB to the data system 
PC, and a system reset button. See Figure 11 on page 28.

The Power Entry Module accepts, filters, and provides line power to various components of 
the MS detector. Figure 23 shows a functional block diagram of the Power Entry Module and 
MS detector power distribution.

The Power Entry Module includes the following components:

• Main power circuit breaker switch. Line power (230 V ac ± 10%, 15 A, 50/60 Hz, 
single phase) enters the power panel on the right side panel of the MS detector, and passes 
through the main power circuit breaker and a line filter (see Figure 11 on page 28). The 
main power circuit breaker switch, located on the right side panel of the MS detector (see 
Figure 11 on page 28), shuts off all power to the MS detector, including the vacuum 
system. After the main power circuit breaker switch, power goes to the line filter.

• Line filter. The line filter removes noise from the line power.

• Electronics service switch. After the line filter, power goes to the power/signal 
distribution PCB and to the electronics service switch. The electronics service switch is a 
circuit breaker that allows service of the non-vacuum system components of the MS 
detector while the vacuum system is still in operation (see Figure 11 on page 28). In the 
Service position, the switch removes power to all components of the MS detector other 
than the fans and vacuum system. In the Electronics Normal position, all components of 
the MS detector receive power.

• Interlock PCB. The interlock PCB, which resides in the Power Entry Module, receives 
220 V ac from the electronics service switch (called service 220 V ac) and +24 V dc from 
PS2 power supply by way of the power/signal distribution PCB. If the safety interlock 
switch on the API source is closed, then the interlock PCB distributes 220 V ac to the 
APCI vaporizer heater and +24 V dc (called interlock +24 V dc) to the power/signal 
distribution PCB, which distributes it to the 8 KV power supply and the power supply of 
the conversion dynode and electron multiplier.

The power/signal distribution PCB receives 220 V ac and service 220 V ac from the Power 
Entry Module. The power/signal distribution PCB distributes the 220 V ac to power supply 
PS2 and the service 220 V ac to power supply PS1. It then distributes the power produced by 
PS1 and PS2 to other power supplies, PCBs, the turbomolecular pump, the vent valve, and 
fans. The power/signal distribution PCB also receives the interlock +24 V dc from the 
interlock PCB and distributes it to the 8 KV power supply and the conversion 
dynode/electron multiplier power supply. 

CAUTION  For emergency shutoff of all power to the MS detector, place the main power 
circuit breaker switch in the Off (O) position. Do not use the electronics service switch to 
remove power to the system in an emergency. 
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Power supply PS1 provides +5 V dc, ± 15 V dc for analog and digital circuits and +60 V dc 
for the heater that heats the ion transfer capillary. 

Power supply PS2 provides +24 V dc for the turbomolecular pump, fans, vent valve, 
divert/inject valve, syringe pump, 8 KV power supply, conversion dynode/electron multiplier 
power supply, main RF PCB, and analog PCB. It also provides +36 V dc and -28 V dc that 
are used for RF generation for the ion guides and mass analyzer.

The source PCB distributes power to the ion gauge, divert/inject valve, syringe pump, and 
nitrogen gas valves.

The 8 kV power supply delivers voltage to either the ESI needle in the ESI mode, or the 
corona discharge needle in the APCI mode. Typical operating voltages range between ±3 to 
±6 kV. In the ESI mode, the voltage is regulated, whereas in the APCI mode, the current is 
regulated.

The conversion dynode / electron multiplier power supply provides ±15 kV to the conversion 
dynode and 0 to –2.5 KV to the electron multiplier in the ion detection system.
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Figure 23. Functional block diagram of the Power entry module and power distribution of the MS detector
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System Control and Monitoring Circuitry

Table 2 lists the LCQ Fleet electronic circuitry that controls and monitors the operation of 
the MS detector.

Table 2. System control and monitoring circuitry,  (Sheet 1 of 2)

Circuit Function

DC voltage control 
circuitry

Controls and monitors the dc voltages that are applied to the ion transfer capillary heater, 
tube lens, ion optics, lenses, and mass analyzer electrodes.

Divert/inject valve 
control circuit

 Controls and monitors the divert/inject valve.

API source control 
circuit

Controls and monitors the high voltage that is applied to the ESI needle, the APCI corona 
discharge needle, and the NSI capillary.

Electron multiplier 
control circuit

Sends a signal to the electron multiplier power supply that is proportional to the voltage to 
be applied to the electron multiplier cathode. It also reads back a signal that is proportional 
to the actual voltage applied to the electron multiplier cathode. The electron multiplier 
control circuit lowers the electron multiplier voltage when mass analysis is not occurring.

Conversion dynode 
control circuit

Controls and monitors the polarity of the 15 kV potential that is applied to the conversion 
dynode.

Ion transfer capillary 
heater/sensor control 
circuit

 Monitors the temperature of the ion transfer capillary via a platinum probe temperature 
sensor. It also provides the voltage needed by the ion transfer capillary heater.

APCI vaporizer 
heater/sensor control 
circuit/safety interlock 
relay

Controls the temperature of the APCI vaporizer via a thermocouple sensor. It also provides 
230 V ac line voltage to the heater in the APCI vaporizer.

Ion gauge control 
circuit

Controls the ion gauge and reads back the pressure signal. The ion gauge measures the 
pressure in the analyzer region of the vacuum manifold.

Convectron® gauge 
control circuit

Controls the Convectron gauge and reads back the pressure signal. The Convectron gauge 
measures the pressure in the foreline and the ion transfer capillary-skimmer region of the 
vacuum manifold.

RF voltage control 
circuitry

 Controls and monitors the PCBs that are responsible for RF voltage generation.

Temperature 
monitoring circuitry

 Monitors the temperatures at several PCBs in the MS detector.

Diagnostic circuitry Monitors the outputs of various components and circuits on the LCQ Fleet. Information on 
voltages, currents, temperatures, flow rates, logic, and so on is sent to the data system, where 
it can be accessed in the diagnostics views of Tune Plus.
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RF / Waveform Voltage Generation Electronic Assemblies

The RF/waveform voltage generation electronic assemblies produce the RF voltages for the 
mass analyzer, Q00 RF lens and Q0 quadrupole, and Q1 octapole. They also produce the ion 
isolation waveform voltage, resonance excitation RF voltage, and resonance ejection RF 
voltage that are applied to the end caps of the mass analyzer. 

The main RF voltage generation involves the following components:

• RF oscillator located on the digital PCB. This oscillator provides a 825 kHz sine wave 
reference signal that it uses to produce the RF voltage.

• RF voltage amplifier PCB. Produces the RF primary voltage for the RF voltage coil. To 
produce the RF primary voltage, the RF voltage amplifier PCB takes the sine wave 
reference signal and amplifies it by an amount based on a 0 to 10 V dc RF modulation 
signal from the integrating amplifier. 

• Low pass filter PCB. Removes second and third harmonics from the RF primary voltage.

• RF voltage coil. Amplifies the RF primary voltage to produce a secondary voltage of 0 to 
10 000 V ac (zero to peak) that is supplied to the rods of the mass analyzer. 

• RF voltage detector. Senses the 0 to 10 000 V RF voltage signal that is applied to the 
rods of the mass analyzer and converts this sensed signal into a 0 to -10 V dc output 
signal.

Vacuum protection 
circuitry

Monitors the pressure in the ion transfer capillary-skimmer region of the vacuum manifold, 
as measured by the Convectron gauge, and in the analyzer region of the vacuum manifold, 
as measured by the ion gauge. The vacuum protection circuitry turns off power to any of 
these components: the ion optics and mass analyzer RF and waveform generation circuitry, 
8 kV power supply (for the API source), electron multiplier and conversion dynode power 
supply, APCI vaporizer heater, or shuts down dc voltages to the ion transfer capillary heater, 
tube lens, ion optics, and mass analyzer, if one or more of the following conditions occurs:

• The pressure in the ion transfer capillary-skimmer region is above 3 Torr.

• The pressure in the analyzer region is above 5 × 10-4 Torr.

• The high-voltage safety interlock switch on the API source is open (that is, the API 
probe has been removed).

The Vacuum LED on the LCQ Fleet front panel is illuminated green when the vacuum 
protection circuitry detects adequate vacuum.

Table 2. System control and monitoring circuitry,  (Sheet 2 of 2)

Circuit Function
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• Mass DAC and Integrating amplifier. This integrating amplifier, also called an error 
amplifier, produces the 0 to 10 V dc RF modulation signal that is used by the RF voltage 
amplifier PCB. The magnitude of the RF modulation signal is proportional to the 
difference between the detected RF signal and the mass set signal requested by the Mass 
DAC (digital-to-analog converter). The integrating amplifier adjusts the RF modulation 
signal until the detected RF signal equals the requested RF signal.

• Waveform AWG (arbitrary waveform generator). Part of the digital PCB, the 
waveform AWG provides the reference waveforms that are used to create the ion isolation 
waveform voltage, resonance excitation RF voltage, and resonance ejection RF voltage. A 
waveform amplifier on the analog PCB amplifies the reference waveforms. The 
embedded computer, also part of the digital PCB, is where the computations that are 
required to produce the waveforms take place. 

Ion Detection System Electronic Assemblies

The ion detection system electronic assemblies provide high voltage to the electron multiplier 
and conversion dynode of the ion detection system. The ion detection system electronic 
assemblies also receive the electron multiplier output current signal, convert it to a voltage (by 
the electrometer circuit), and pass it to the data system. Figure 24 shows a functional block 
diagram of the ion detection system electronic assemblies.

The ion detection system electronic assemblies include the following:

• Electron multiplier/conversion dynode power supply

The electron multiplier/conversion dynode power supply supplies the -0.8 kV to -2.5 kV 
dc high voltage to the cathode of the electron multiplier. The high voltage set control 
signal for the electron multiplier power supply comes from the analog PCB. This signal 
controls a feedback control circuit and is proportional to the final high voltage to be 
applied to the electron multiplier cathode. To prolong the life of the electron multiplier, 
the analog PCB lowers the electron multiplier voltage during sample ionization.

The electron multiplier/conversion dynode power supply also supplies +15 kV and -15 
kV dc high voltage to the conversion dynode. A control signal from the analog PCB 
determines the polarity of the voltage applied to the conversion dynode.

• Electrometer circuit

The electrometer circuit, located in a shielded enclosure on the electrometer PCB, 
receives the amplified ion current from the anode of the electron multiplier, converts the 
current into a voltage, and then integrates the voltage over time. The integrated voltage is 
then passed to the power/signal distribution PCB where it is processed and sent to the 
data system.
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Figure 24. Ion detection system electronic assemblies (functional block diagram)

Data System
The data system controls and monitors the LCQ Fleet. The data system also processes data 
that the LCQ Fleet acquires. 

This section contains the following topics:

• Software and Computer Hardware Requirements

• Data System/ MS Detector and Local Area Network Interface

• Printer
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Software and Computer Hardware Requirements

For information about the computer, refer to the manuals that come with the computer.

Table 3 lists the minimum software and computer hardware requirements to install the 
LCQ Fleet 2.4 instrument control software and the Xcalibur 2.0.5 data system.

Data System/ MS Detector and Local Area Network Interface

The data system computer contains two Ethernet adapters; one adapter is labeled User’s 
Network and the other adapter is labeled Surveyor MS.

Use the Ethernet adapter that is labeled User’s Network to connect to your local area network.

Use the Ethernet adapter that is labeled Surveyor MS to connect to a a 10/100 base T 
Ethernet switch. Connect the LCQ Fleet MS detector, Surveyor Autosampler, Surveyor LC 
Pump Plus, and Surveyor PDA Plus Detector to the Ethernet switch. 

Printer

A high-resolution laser printer is available with the LCQ Fleet as an option. The printer 
communicates with the PC via the local area network. Refer to the printer manual for details.

To set up the printer 

Choose File > Print Setup from any window in the Xcalibur data system or the Tune Plus 
program.

The Print Setup dialog box appears.

Table 3. Software and computer hardware requirements for running Xcalibur 2.0.5 and higher

Computer hardware Software

Intel Pentium IV 1 GHz processor Microsoft Windows XP SP2

256 MB RAM for processing Microsoft Office XP 2003

256 MB RAM for acquisition

20 GB hard drive (NTFS) or more recommended

CD-ROM drive

Video card and monitor capable of 1280 × 1025 resolution 
and 65536 colors

Note  The Surveyor MS Pump Plus communicates with the data system computer 
through a USB connection.
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Daily Operation

To ensure the proper operation of your system, Thermo Scientific recommends that you 
perform daily preventative maintenance. This chapter provides details about the items you 
should check before you operate the system and the cleaning procedures you should perform 
after you complete your analyses and contains the following sections:

• Before Operating the LCQ Fleet

• After Operating the LCQ Fleet 

Before Operating the LCQ Fleet
Perform the following procedures every day before you begin your first analysis:

• Checking the Helium and Nitrogen Supplies

• Checking the ESI Fused-Silica Sample Tube for Elongation

• Checking the System Vacuum Levels

• Checking the Disk Space 

Note  You do not need to tune (optimize the tune parameters for the ESI calibration 
solution) and calibrate the LCQ Fleet as part of your daily routine. 

Calibration parameters are instrument parameters that affect the mass accuracy and 
resolution. Tune parameters are instrument parameters that affect the intensity of the ion 
signal. You must tune and calibrate the LCQ Fleet (that is, optimize the tune for the ESI 
calibration solution and calibrate the mass accuracy using the ESI calibration solution) 
about once a quarter. 

You must optimize the tune parameters (create a new tune method) whenever you change 
the type of experiment.  

For information on tuning and calibration, refer to the LCQ Fleet Getting Started Guide.
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Checking the Helium and Nitrogen Supplies

Check the helium supply on the regulator of the gas tank. Make sure that you have sufficient 
gas for your analysis. If necessary, install a new tank of helium. Verify that the pressure of 
helium reaching the MS detector is between 200 and 350 kPa (30 to 50 psig). If necessary, 
adjust the pressure with the tank pressure regulator.

Check the nitrogen supply on the regulator of the nitrogen gas tank or liquid nitrogen boil-off 
tank. Make sure that you have sufficient gas for your analysis. Typical nitrogen consumption 
is 100 cubic feet per day (nitrogen On 24 hours per day). If necessary, replace the tank. 
Verify that the pressure of nitrogen reaching the MS detector is between 550 and 830 kPa 
(80 to 120 psig). If necessary, adjust the pressure with the tank pressure regulator. 

Checking the ESI Fused-Silica Sample Tube for Elongation

Using acetonitrile in the mobile phase can elongate the polyimide coating on the fused-silica 
sample tube. Elongation of the polyimide coating can degrade both signal intensity and 
stability over time. 

If you are running in the ESI mode with a fused-silica sample tube, verify the sample tube is 
not elongated past the tip of the ESI spray needle. 

To cut and reposition the end of the sample tube 

1. Remove the ESI probe from the Ion Max-S ion source.

For instructions on removing the ESI probe, refer to the Ion Max and Ion Max-S API 
Source Hardware Manual.

2. Loosen the sample inlet fitting.

3. Gently pull back on the sample tube to free it from the fitting.

4. Push the sample tube forward so that it extends beyond the end of the electrospray 
needle.

5. With a fused-silica cutting tool, cut off a small length of sample tube. Ensure that you cut 
the end of the sample tube squarely.

6. Pull the sample tube backwards until the exit end of the sample tube is recessed just inside 
the ESI needle by approximately 1 mm.

7. Tighten the sample inlet fitting securely to hold the sample tube in place.

CAUTION  Before you begin normal operation each day, make sure that you have 
sufficient nitrogen for your API source. The presence of oxygen in the ion source when 
the MS detector is on could be unsafe. The LCQ Fleet displays a popup message when the 
nitrogen pressure is too low.
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8. Reinstall the ESI probe. 

For instructions on installing the ESI probe, refer to the Ion Max and Ion Max-S API 
Source Hardware Manual.

Checking the System Vacuum Levels

For proper performance, you must operate the LCQ Fleet system at the proper vacuum levels. 
Operation of the system with poor vacuum levels can cause reduced sensitivity, tuning 
problems, and reduced lifetime of the electron multiplier. Before you begin daily operation, 
check for major air leaks in the system, and check the vacuum levels of the system. 

To check the system for major air leaks

Listen for a rush of air or a hissing sound inside the MS detector.

A major leak might be caused, for example, by a loose or disconnected fitting, by an O-ring 
that is not properly seated, or by an open valve. 

To check the system vacuum levels 

1. From the Windows XP taskbar, choose Start > All Programs > Xcalibur > LCQ Fleet 
Tune.

The Tune Plus window appears.

2. Choose Setup > Vacuum.

The Vacuum dialog box appears. 

3. Check the Convectron Gauge Pressure readback. This readback displays the current 
pressure in the capillary-skimmer and foreline region.

4. Check the Ion Gauge Pressure readback. This readback displays the current pressure in 
the analyzer region.

5. Compare the current values of the pressures in the vacuum manifold with the values listed 
in Table 4. 

If the observed pressures are higher than those in the table, your system might have an air 
leak. If the pressure is high (above 5 x 10-5 Torr in the analyzer region), and you have 
restarted the system within the last 30 to 60 minutes, wait an additional 30 minutes and 

Note  The sample tube might move forward when you tighten the sample inlet fitting. 
Ensure that the sample tube is recessed just inside the ESI needle by approximately 1 mm. 
If necessary, loosen the fitting and reposition the sample tube.
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recheck the pressure. If the pressure decreases with time, check the pressure periodically 
until it falls within the typical pressure range of the MS detector. If the pressure remains 
high, your system might have an air leak. 

To remedy an air leak

1. Shut down the system as described in Shutting Down the System Completely on 
page 113. 

2. Make a visual inspection of the vacuum system and vacuum lines for leaks. 

3. Check each fitting and flange on the system for tightness, and tighten the fittings or 
flanges that are loose. Do not tighten fittings indiscriminately. Pay particular attention to 
fittings that have been changed recently or to fittings that have been subjected to heating 
and cooling. 

4. Make sure that the cover plates of the vacuum manifold are properly seated.

Checking the Disk Space

Periodically verify that your hard disk drive has enough free space for data acquisition. 

To determine the amount of available disk space

1. From the Windows XP Start menu, choose All Programs > Xcalibur > Xcalibur. 

The Xcalibur Home Page window appears.

2. Choose Actions > Check Disk Space. 

The Disk Space dialog box appears and lists the following:

• Current drive and directory (for example, C:\Xcalibur\system\programs)

• Number of Mb that are available (free) on the current drive

• Percentage of the current drive that is available

• Total capacity of the current drive

3. To select another disk drive so that you can determine its disk space, click Directory.

Table 4.Typical Pressure Readings 

Conditions
Convectron gauge reading 
(foreline, capillary skimmer 
region)

Ion gauge reading 
(analyzer region)

Ion transfer capillary 
orifice open, ion transfer 
capillary at 250  °C 

1.0 to 1.5 Torr 0.75 × 10-5 to 
1.5 × 10-5 Torr
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4. When you have completed this procedure, click OK to close the dialog box.

After Operating the LCQ Fleet
After operating the LCQ Fleet, perform the following procedures in sequence:

1. Flushing the Sample Transfer Line, Sample Tube, and API Probe

2. Placing the System in Standby Mode

3. Flushing the Ion Sweep Cone and Ion Transfer Capillary

4. Purging the Oil in the Forepump

5. Emptying the Solvent Waste Bottle

Flushing the Sample Transfer Line, Sample Tube, and API Probe

Flush the sample transfer line, sample tube, and API probe at the end of each working day 
(or more often if you suspect they are contaminated) with a mobile phase of 
50:50 methanol \ distilled water. Flushing the system with 50:50 methanol \ distilled water at 
at a flow rate of 200 to 400 μL/min for a period of approximately 15 minutes should be 
sufficient to remove contamination.

To flush the sample transfer line, sample tube, and API probe

1. Wait until data acquisition, if any, is complete.

2. Make sure that the lid to the API chamber is closed and secured.

3. From the Windows XP taskbar, choose Start > All Programs > Xcalibur > LCQ Fleet 
Tune. 

The LCQ Fleet Tune Plus window appears.

4. From the Tune Plus window, choose Control > On (or click the On/Standby button to 
toggle it to On) to turn on the voltages and gas flows to the API source. 

• If you are operating in APCI or APPI mode, go to step 5.

• If you are operating in ESI mode, go to step 6.

5. To set up the APCI source to be flushed

a. In the LCQ Fleet Tune Plus window, choose Setup > APCI Source (or click the 
APCI Source button). 

Tip  If necessary, you can free space on the hard disk by deleting obsolete files and by 
moving files from the hard disk drive to a backup medium. First, copy files to the backup 
medium. After you have copied the files, you can delete them from the hard disk.

   Standby
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The APCI Source dialog box appears.

b. To set the APCI vaporizer temperature to 500 °C, type 500 in the Vaporizer 
Temperature box.

c. To set the sheath gas flow rate to 30, type 30 in the Sheath Gas Flow Rate box. 

d. To set the auxiliary gas flow rate to 5, type 5 in the Aux Gas Flow Rate box. 

e. To set the sweep gas flow rate to 0, type 0 in the Sweep Gas Flow Rate box. 

f. To set the APCI spray current to 0, type 0 in the Spray Current box. 

g. Click OK.

h. Go to step 7.

6. To set up the ESI source to be flushed

a. In the LCQ Fleet Tune Plus window, choose Setup > ESI Source (or click the ESI 
source button). 

The ESI Source dialog box appears.

b. To set the sheath gas flow rate to 30, type 30 in the Sheath Gas Flow Rate box. 

c. To set the auxiliary gas flow rate to 5, type 5 in the Aux Gas Flow Rate box. 

d. To set the sweep gas flow rate to 0, type 0 in the Sweep Gas Flow Rate box. 

e. To set the ESI spray voltage to 0, type 0 in the Spray Voltage box. 

f. Click OK.

7. To set up and start a flow of 50:50 methanol \ water solution from the LC to the API 
source: 

a. In the LCQ Fleet Tune Plus window, choose Setup > Inlet Direct Control (or click 
AS/LC direct control). 

The Inlet Direct Control view appears.

b. Select the LC tab.

c. Set the Flow Rate to a value that is typical for your experiments.

d. Set the solvent proportions to 50% methanol and 50% water.

e. Click  (or Pump On or Start Pump) to start the LC pump.

8. Let the solution flow through the sample transfer line, sample tube, and API probe for 
15 minutes. 

9. After 15 minutes, turn off the flow of liquid from the LC to the API source as follows:

a. Leave the API source (including the APCI vaporizer, sheath gas, and auxiliary gas) on 
for an additional 5 minutes. 
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b. Click  (or Pump Off or Stop Pump) to stop the LC pump.

10. After 5 minutes, turn off the API source by placing the MS detector in Standby. From the 
LCQ Fleet Tune Plus window, choose Control > Standby (or click On/Standby) to put 
the MS detector in Standby.

Placing the System in Standby Mode

To place the LCQ Fleet system in Standby mode

1. From the LCQ Fleet Tune Plus window, choose Control > Standby (or click 
On/Standby) to put the MS detector in Standby. 

The System LED on the front panel of the MS detector turns yellow when the system is 
in Standby.

2. Leave the MS detector power On.

3. Leave the LC pump power On.

4. Leave the autosampler power On.

5. Leave the data system power On.

Flushing the Ion Sweep Cone and Ion Transfer Capillary

You must clean the ion sweep cone (or spray cone) and the ion transfer capillary on a regular 
basis to prevent corrosion and to maintain optimum performance of your API source. A good 
practice is to flush the ion sweep cone and ion transfer capillary at the end of each operating 
day after you pump a solution of 50:50 methanol \ water solution through the sample transfer 
line, sample tube, and API probe (see Flushing the Sample Transfer Line, Sample Tube, and 
API Probe on page 61.) If you use a mobile phase that contains a nonvolatile buffer or inject 
high concentrations of sample, you might need to clean the ion sweep cone and ion transfer 
capillary more often. It is not necessary to vent the system to flush the ion sweep cone and ion 
transfer capillary. 

To clean the ion sweep cone and the ion transfer capillary

1. To turn off the solvent flow from the LC pump (or other sample introduction device) to 
the API source

a. From the Windows XP taskbar, choose Start > All Programs > Xcalibur > LCQ 
Fleet Tune. 

The LCQ Fleet Tune Plus window appears.

b. Choose Setup > Inlet Direct Control (or click AS/LC direct control). 

The Inlet Direct Control view appears.

   Standby
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c. Click the LC tab and click  (or Pump Off or Stop Pump) to stop the LC pump.

2. From the LCQ Fleet Tune Plus window, choose Control > Standby (or click the 
On/Standby button) to put the MS detector in Standby.

3. Remove the Ion Max ion source from the front of the MS detector, as described in 
“Removing the Ion Max Ion Source Housing” on page 77.

4. Fill a spray bottle with a 50:50 solution of HPLC-grade methanol \ distilled water. Spray 
approximately 5 mL of the solution at the opening of the ion transfer capillary. Do not 
touch the ion transfer capillary with the tip of the spray bottle.

5. Use the spray bottle filled with the 50:50 solution of methanol \ water to flush 
contaminants from the accessible surfaces of the ion source chamber and the spray cone 
or ion sweep cone (if installed).

6. Ensure that you have removed any salt or other contaminants that may have been 
deposited on the ion sweep cone or spray cone.

7. To remove the ion sweep cone (if it is installed)

a. Put on a pair of talc-free gloves.

b. Grasp the outer ridges of the ion sweep cone and pull the cone straight off of the API 
cone seal. You might need to loosen the set screws on the ion sweep cone in order to 
remove it. 

8. To clean the ion transfer capillary and the ion sweep cone (if it is installed)

a. Place the ion sweep cone and the ion transfer capillary in a beaker of 50:50 
methanol/water. 

b. Place the beaker in an ultrasonic bath, and sonicate these components for 
15 minutes.

c. Dry the ion sweep cone.

9. Clean the spray cone with a Kimwipe™ tissue soaked in methanol.

CAUTION  AVOID BURNS. At operating temperatures, the APCI vaporizer and ion 
transfer capillary can severely burn you! The APCI vaporizer typically operates at 
400 to 600 °C and the ion transfer capillary typically operates at 100 to 300 °C. 
Allow approximately 20 minutes for the vaporizer and ion transfer capillary to cool to 
room temperature before you touch or remove either component.  

Tip  This is a good point to remove and clean the ion transfer capillary. You remove 
the ion transfer capillary by turning it counter clockwise with the custom removal 
tool. See Cleaning the Ion Transfer Capillary and Ion Sweep Cone on page 73.
LCQ Fleet Hardware Manual Thermo Scientific



 3 Daily Operation
After Operating the LCQ Fleet

T

10. To reinstall the ion sweep cone

a. Carefully align the gas inlet (see Figure 26) on the ion sweep cone with the sweep gas 
supply port (see Figure 25) in the API cone seal. Firmly press the ion sweep cone into 
position.

b. If necessary, adjust the set screws around the perimeter of the ion sweep cone.

Figure 25. View of the sweep gas supply port in the API cone seal

Figure 26. View of the gas inlet on the ion sweep cone

11. Reinstall the Ion Max ion source as described in “Reinstalling the Ion Max Ion Source 
Housing” on page 85.

Spray Cone

Sweep Gas 
Supply Port

Gas Inlet
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Purging the Oil in the Forepump

Plan to purge (decontaminate) the oil in the forepump (also known as a rotary-vane pump, 
backing pump, roughing pump, or mechanical pump) on a daily basis to remove water and 
other dissolved chemicals from the pump oil. Water and other chemicals in the forepump can 
cause corrosion and decrease the lifetime of the forepump. The best time to purge the oil is at 
the end of the working day after you flush the API probe, ion sweep cone, and ion transfer 
capillary.

To purge the oil in the forepump

1. To turn off the solvent flow from the LC pump to the API source:

a. From the Windows XP taskbar, choose Start > All Programs > Xcalibur > LCQ 
Fleet Tune. 

The LCQ Fleet Tune Plus window appears.

b. Choose Setup > Inlet Direct Control (or click on the AS/LC direct control button).

The Inlet Direct Control view appears.

c. Click the LC tab and click  (or Pump Off or Stop Pump) to stop the LC pump.

2. From the LCQ Fleet Tune Plus window, choose Control > Standby (or click the 
On/Standby button) to put the MS detector in Standby. 

3. Ensure that a septum seals the entrance to the ion transfer capillary.

4. Open the gas ballast valve on the forepump by turning it to position |. 

Refer to the manual that came with the forepump for the location of the gas ballast valve.

5. Allow the pump to run for 30 minutes with the gas ballast valve open.

6. After 30 minutes, close the gas ballast valve by turning it to position O.

Emptying the Solvent Waste Bottle

Check the solvent level in the solvent waste bottle on a daily basis. If necessary, empty the 
solvent waste bottle. Dispose of the solvent waste in accordance with local and national 
regulations.

   Standby
LCQ Fleet Hardware Manual Thermo Scientific



4

MS Detector Maintenance

The performance of the LCQ Fleet MS detector depends on the maintenance of all parts of 
the instrument. 

This chapter describes routine MS detector maintenance procedures that you or your Thermo 
Scientific service engineer must perform to ensure optimum performance of the instrument. 
Most of the procedures involve cleaning. Maintenance procedures include cleaning the API 
source, ion guides, mass analyzer, and ion detection system. Procedures are also provided for 
replacing the API sample tube, ion transfer capillary, and API source, ion optics, and mass 
analyzer assemblies.

This chapter contains the following sections:

• Overview of Maintenance Procedures

• Tools and Supplies

• Frequency of Cleaning

• API Source Maintenance

• Cleaning the Q00-L0 RF Lens

• Cleaning the Q0 and Q1 Ion Guides

• Maintaining the Mass Analyzer

• Replacing the Electron Multiplier

• Replacing the Turbomolecular Pump Cartridge

• Cleaning the Fan Filter

Note  Table 5 and Table 6 list the maintenance procedures that you must perform on a 
regular basis to maintain your LCQ Fleet system. Table 7 lists the maintenance 
procedures that should be performed by a Thermo Scientific service engineer.
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Overview of Maintenance Procedures
To maintain the performance of the MS detector, you must perform the maintenance 
procedures listed in Table 5. When you perform these procedures, do the following:

• Proceed methodically.

• Always wear clean, lint-free gloves when handling the components of the API source, ion 
guides, mass analyzer, and ion detection system.

• Always place the components on a clean, lint-free surface.

• Never overtighten a screw or use excessive force.

Table 5. User–performed MS detector maintenance procedures 

MS Detector 
Component Task Frequency Procedure 

API source Flush (clean) the sample 
transfer line, sample tube, and 
API probe

Daily Flushing the Sample Transfer Line, 
Sample Tube, and API Probe on 
page 72

Ion source 
interface

Flush (clean) the ion sweep 
cone and ion transfer capillary

Daily (or more often1) Flushing the Ion Sweep Cone and 
Ion Transfer Capillary on page 72

Clean the tube lens and 
skimmer

As needed1 Cleaning the Tube Lens and 
Skimmer on page 79

Remove and clean the ion 
transfer capillary

Weekly, or if the ion 
transfer capillary bore is 
contaminated or blocked

Cleaning the Ion Transfer Capillary 
and Ion Sweep Cone on page 73

Replace the ion transfer 
capillary

If its bore is corroded Ion Max and Ion Max-S 
API Source Hardware Manual

PhotoMate 
light source

Clean or polish the VUV lamp 
window

If the VUV lamp window 
is dirty

Ion Max API Source Hardware 
Manual

Replace the VUV lamp If the lamp fails Ion Max and Ion Max-S 
API Source Hardware Manual

Cooling fans Clean the fan filters Every 4 months Cleaning the Fan Filter on page 110

ESI probe Trim the sample tube If polyimide coating on 
the end of the sample 
tube has elongated

Checking the ESI Fused-Silica 
Sample Tube for Elongation on 
page 58

APCI or 
ESI probe

Replace the sample tube If sample tube is broken 
or obstructed

Ion Max and Ion Max-S 
API Source Hardware Manual

Ion detection 
system

Clean the ion detection system 
(electron multiplier and 
conversion dynode)

Whenever you remove 
the top cover plate of the 
vacuum manifold 

Cleaning the Ion Detection System 
on page 99

1Frequency depends on analytical conditions
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To keep the forepump (also known as a rotary-vane pump or mechanical pump) in optimal 
working condition, you must perform the maintenance procedures listed in Table 6. 

Because the procedures listed in Table 7 require a system shutdown and the removal of one or 
more of the outer covers of the MS detector, they must be performed by aThermo Scientific 
service engineer.

Table 6. User performed forepump maintenance procedures

Task Frequency Procedure

Purge (decontaminate) oil Daily Purging the Oil in the Forepump on 
page 66

Add oil When the oil level is low Manufacturer’s documentation

Change oil Every 3 months, or if oil is cloudy or 
discolored

Manufacturer’s documentation

Table 7. MS detector maintenance procedures that should be performed by a Thermo Scientific Service Engineer

MS Detector 
Component Procedure Frequency Procedure 

Ion detection system Replace the electron 
multiplier assembly

If noise in spectrum is excessive 
or proper electron multiplier 
gain can not be achieved

Replacing the Electron 
Multiplier on page 105

Q0 ion guide Clean Q0 quadrupole and 
intermultiple lens L1

As needed1 Cleaning the Q0 and Q1 
Ion Guides on page 91

Mass analyzer Clean the mass analyzer Rarely (if ever)1 Maintaining the Mass 
Analyzer on page 101

Q1 ion guide Clean the Q1 octapole and 
gate lens

As needed1 Cleaning the Q0 and Q1 
Ion Guides on page 91

Q00 RF lens Clean Q00 RF lens and 
lens L0

As needed1 Maintaining the Internal 
Components of the Ion 
Source Interface on page 76

Turbomolecular pump Replace the turbomolecular 
pump insert

Every 20000 to 30000 hours or 
if bearings fail

Replacing the 
Turbomolecular Pump 
Cartridge on page 109

PCBs Replace PCB If PCB fails

Electronic modules Replace the module If the electronic module fails
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Tools and Supplies
The LCQ Fleet requires very few tools to perform routine maintenance. You can remove and 
disassemble many of the components by hand. The tools, equipment, and chemicals listed in 
Table 8 are needed for the maintenance of the API source, ion guides, mass analyzer, and ion 
detection system. 

Table 8. Tools, equipment, and chemicals required for maintenance

Description Part Number

Screwdrivers, set, ball point, Allen 
(also referred to as ball drivers)

00025-03025 

Hex ball Driver, 3/16-in. 00025-01700

Hex ball Driver, 7/64-in. 00025-01800

Hex ball driver, 5/16-in., 9.5 in. long 00025-10015

Hex ball driver, 5/32, 7.4 in. long 00025-10020

Ion transfer capillary removal tool 70111-20258

Screwdriver, slot head, large

Screwdriver, slot head, small

Screwdriver, Phillips, small

Fused-silica cutting tool

Spray bottle

Beaker, 450 mL

Gloves, nylon 00301-09700

Kimwipes or other lint-free industrial tissue

Applicators (swabs), cotton-tipped 00301-02000

Detergent

Clean, dry, compressed nitrogen gas

Distilled water

Methanol, HPLC grade or better

Nitric acid, dilute

CAUTION  Make sure that solvents and reagents are stored and handled according to 
standard safety procedures and disposed of according to applicable local and national 
regulations.
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Frequency of Cleaning
The frequency of cleaning the components of the MS detector depends on the types and 
amounts of samples and solvents that are introduced into the instrument. In general, for a 
given sample and ionization technique, the closer an MS detector component is to the source 
of the ions, the more rapidly it becomes dirty. Table 9 lists the frequency of cleaning for the 
component of the MS detector.

When the performance of your system decreases significantly because of contamination, clean 
the following components of the MS detector in order:

1. The API probe, ion sweep cone (if installed), spray cone, and ion transfer capillary

2. The tube lens and skimmer

3. The quadrupole and lens of the Q00 RF lens

4. The quadrupole and lens of the Q0 ion guide and the octapole and lens of the Q1 ion 
guide

5. The mass analyzer

Table 9. Frequency of cleaning for the components of the MS detector

Component Frequency of cleaning Procedure

Sample tube, API probe, ion 
transfer capillary bore, ion 
sweep cone of the API 
source

Clean at the end of each operating day to 
remove any residual salts from buffered 
mobile phases or other contamination 
that might have accumulated during 
normal operation.

Flushing the Sample Transfer Line, 
Sample Tube, and API Probe on page 72 

Flushing the Ion Sweep Cone and Ion 
Transfer Capillary on page 72

Tube lens and skimmer of 
the Q00 RF lens and 
lens L0

Clean occasionally. Cleaning the Q00-L0 RF Lens on page 87

Q0 quadrupole, 
Q1 octapole, and lenses of 
the Q0 and Q1 ion guides 

Clean occasionally. Cleaning the Q0 and Q1 Ion Guides on 
page 91

Electrodes of the mass 
analyzer

Clean rarely. Maintaining the Mass Analyzer on 
page 101

Electron multiplier and 
conversion dynode 

Whenever you remove the top cover plate 
of the vacuum manifold, clean these 
components by blowing them with a 
clean, dry gas.

Cleaning the Ion Detection System on 
page 99
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API Source Maintenance
The API source requires minimal maintenance. Periodically, you must clean the components 
of the API source to remove salts or other contaminants. The frequency of cleaning the API 
source depends on the types and amounts of samples and solvents that are introduced into the 
instrument.

For information on maintaining the API probes or the Photomate light source, refer to the 
Ion Max and Ion Max-S API Source Hardware Manual.

This section contains maintenance procedures for the following:

• Flushing the Sample Transfer Line, Sample Tube, and API Probe

• Flushing the Ion Sweep Cone and Ion Transfer Capillary

• Checking the Vacuum Pressure in the Ion Trap

• Cleaning the Ion Transfer Capillary and Ion Sweep Cone

• Maintaining the Internal Components of the Ion Source Interface 

Flushing the Sample Transfer Line, Sample Tube, and API Probe

Flush the sample transfer line, sample tube, and API probe at the end of each working day (or 
more often if you suspect they are contaminated) by setting up the LC pump to pump a 
50:50 methanol / distilled water solution through the API source.

To flush the sample transfer line, sample tube, and API probe, follow the procedure described 
in “Flushing the Sample Transfer Line, Sample Tube, and API Probe” on page 61.

Flushing the Ion Sweep Cone and Ion Transfer Capillary

To prevent corrosion and to maintain optimum performance of your API source, you must 
clean the ion sweep cone (or the spray cone, if the ion sweep cone is not installed) and the ion 
transfer capillary on a regular basis. A good practice is to flush the ion sweep cone and ion 
transfer capillary at the end of each operating day after you flush the sample transfer line, 
sample tube, and API probe with a 50:50 methanol / water solution. To clean the ion sweep 
cone and the ion transfer capillary follow the procedure described in “Flushing the Ion Sweep 
Cone and Ion Transfer Capillary” on page 63.

CAUTION  AVOID EXPOSURE TO POTENTIALLY HARMFUL MATERIALS. 
Always wear protective gloves and safety glasses when you use solvents or corrosives. Also, 
contain waste streams and use proper ventilation. For procedures that describe how to 
handle a particular solvent, refer to your supplier's Material Safety Data Sheets (MSDS).
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Checking the Vacuum Pressure in the Ion Trap

A blocked ion transfer capillary can cause a loss of vacuum in the ion transfer 
capillary-skimmer region.

To check the Convectron gauge pressure reading

1. From the Windows XP taskbar, choose Start > All Programs > Xcalibur > LCQ Fleet 
Tune. 

The LCQ Fleet Tune window appears.

2. Choose Setup > Vacuum 

The Vacuum dialog box appears. See Figure 27.

Figure 27. Vacuum dialog box

Cleaning the Ion Transfer Capillary and Ion Sweep Cone

Salt buildup from buffered mobile phases or complex sample matrices or contamination from 
concentrated samples can block the bore of the ion transfer capillary. If the pressure in the ion 
transfer capillary-skimmer region (as measured by the convectron gauge) drops considerably 
below 1 Torr, a blocked ion transfer capillary is the likely cause. 

The ion transfer capillary is located behind the ion sweep cone and can be easily removed for 
cleaning. You do not have to vent the system to remove the ion transfer capillary. 

To clean the ion transfer capillary, perform the following steps:

1. Removing the Ion Transfer Capillary and the Ion Sweep Cone

2. Cleaning the Ion Transfer Capillary, Sweep Cone, and Spray Cone O-ring

3. Reinstalling the Spray Cone O-ring, Ion Transfer Capillary, and Ion Sweep Cone
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Removing the Ion Transfer Capillary and the Ion Sweep Cone

To remove the ion transfer capillary and the ion sweep cone

1. To turn off the solvent flow from the LC pump to the API source

a. Choose Start > Programs > Xcalibur > LCQ Fleet Tune. 

The Tune Plus window appears.

b. In the LCQ Fleet Tune Plus window, choose Setup > Inlet Direct Control (or click 
AS/LC direct control). 

The Inlet Direct Control view appears.

c. CLick the LC tab and click  (or Stop Pump or Pump Off ) to stop the LC pump.

2. To turn off the non-vacuum system voltages, place the electronics service switch (located 
on the right side of the MS detector) in the Service position. 

3. Remove the Ion Max ion source housing from the front of the MS detector as described 
in “Removing the Ion Max Ion Source Housing” on page 77.

4. To remove the ion sweep cone, grasp its outer ridges and pull it straight off of the API 
cone seal. If you cannot separate the ion sweep cone from the API cone seal, loosen the set 
screws on the ion sweep cone in order to remove it. See Figure 28.

CAUTION  Make sure that the LCQ Fleet electronics service switch is in the Service 
position before you proceed.

CAUTION  The ion transfer capillary typically operates at 250 to 400 °C. Allow the 
ion transfer capillary and ion sweep cone to cool before you remove them. 
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Figure 28. Removing the ion sweep cone, ion transfer capillary, and 0.3-in. ID O-ring

5. Remove the ion transfer capillary (P/N 97055-20198) by turning it counterclockwise 
with the custom removal tool (P/N 70111-20258) until you can pull the ion transfer 
capillary free from the ion source interface.

6. Remove the 0.3-in. ID Kalrez® O-ring (P/N 00107-12750) that is seated in the spray 
cone under the entrance end of the ion transfer capillary.

Cleaning the Ion Transfer Capillary, Sweep Cone, and Spray Cone O-ring

To clean the ion transfer capillary, sweep cone, and spray cone O-ring

1. To remove contaminants, soak the ion transfer capillary in a dilute solution of nitric acid.

2. Sonicate the ion transfer capillary in distilled water.

3. Clean the ion sweep cone by wiping the inside and outside with methanol and a 
Kimwipe.

4. Clean the 0.3-in. ID Kalrez® O-ring with methanol.

Spray Cone

0.3-in. ID O-ring

Ion Sweep Cone

Ion Transfer 
Capillary

Set Screw
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Reinstalling the Spray Cone O-ring, Ion Transfer Capillary, and Ion Sweep Cone

To reinstall the spray cone O-ring, ion transfer capillary, and ion sweep cone

1. Reseat the O-ring in the spray cone. 

2. Insert the ion transfer capillary into the heater block. Rotate the capillary as you insert it. 
Once inserted, turn the capillary clockwise until it is finger tight.

3. Reinstall the ion sweep cone on the ion source interface. 

4. Reinstall the Ion Max ion source housing on the MS detector as described in 
“Reinstalling the Ion Max Ion Source Housing” on page 85.

5. To turn on the non-vacuum system voltages, place the electronics service switch in the 
Electronics Normal position.

Maintaining the Internal Components of the Ion Source Interface

The ion source interface includes the ion sweep cone, ion transfer capillary, capillary heater, 
tube lens, and skimmer. The ion sweep cone and ion transfer capillary are not under vacuum, 
and you can remove them for cleaning or replacement without venting the system. For 
information on maintaining these parts, see Cleaning the Ion Transfer Capillary and Ion 
Sweep Cone on page 73 and Flushing the Ion Sweep Cone and Ion Transfer Capillary on 
page 72.

To clean or replace the components of the ion source interface that are under vacuum, 
perform the following steps:

1. Removing the Ion Max Ion Source Housing

2. Removing the Ion Source Interface from the Vacuum Manifold

3. Cleaning the Tube Lens and Skimmer

4. Replacing the Ion Source Interface Components

5. Reinstalling the Ion Source Interface

6. Reinstalling the Ion Max Ion Source Housing

CAUTION  To prevent damage, be careful not to bend the ion transfer capillary. Rotate 
the capillary as you insert it.

Note  If you unblocked the ion transfer capillary, expect the Convectron gauge 
pressure to increase to a normal value (approximately 1 Torr). If you cannot clear the 
ion transfer capillary by this method, replace the ion transfer capillary.
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Removing the Ion Max Ion Source Housing

To remove the Ion Max Ion Source Housing from the front of the MS detector

1. If you have not already done so, disconnect any liquid lines connected to the ion source 
housing.

2. Remove the drain tube from the ion source housing drain. See Figure 29.

Figure 29. Ion Max-S ion source

3. Rotate the ion source housing locking levers 90º to release the ion source housing from 
the ion source mount assembly.

4. Remove the ion source housing by pulling straight off of the ion source mount assembly, 
and place the housing in a safe location for temporary storage.

Locking Levers

Drain Tube
Thermo Scientific LCQ Fleet Hardware Manual 77



4 MS Detector Maintenance
API Source Maintenance

78
Removing the Ion Source Interface from the Vacuum Manifold

To remove the ion source interface from the vacuum manifold

1. Shut down and vent the system as described in “Shutting Down the System Completely” 
on page 113. Wait several minutes for the LCQ Fleet to vent.

2. Ensure that you have removed the LCQ Fleet from line power by unplugging its 
power cord. 

3. Grasp the ridges on either side of the ion source interface and carefully pull it free from 
the vacuum manifold. 

4. Place the ion source interface on a clean surface. 

Figure 30. Removing the ion source interface from the vacuum manifold

CAUTION  Make sure to unplug the LCQ Fleet power cord before you proceed. 

Ion Source 
Interface

Vacuum 
Manifold
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Cleaning the Tube Lens and Skimmer

Chemicals that accumulate on the surfaces of the tube lens and skimmer form an insulating 
layer that can modify the electrical fields that control ion transmission. The tube lens and 
skimmer require cleaning less often than the ion sweep cone and the ion transfer capillary.

To clean the tube lens and skimmer 

1. To remove the skimmer, carefully pull it free from the rear of the ion source interface. 
Note the orientation of the skimmer.

2. To remove the tube lens, carefully pull it free from the rear of the ion source interface. 
Note the orientation of the tube lens.

Figure 31. Removing the skimmer and the tube lens from the back of the ion source interface

3. Clean the tube lens inside and out with a cotton-tipped applicator (swab) soaked in 
HPLC-grade methanol. 

CAUTION  Wait for the ion source interface to cool to ambient temperature before 
disassembling it. 

IMPORTANT  Wear clean gloves when you handle the tube lens and the skimmer.

CAUTION  Take care not to scratch or nick the skimmer cone.

Skimmer

Tube Lens
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4. Clean the skimmer inside and out with HPLC-grade methanol and a cotton-tipped 
applicator (swab).

5. To reinstall the tube lens in the ion source interface

a. Orient the tube lens so that the lead pin aligns with the socket. See Figure 32.

Figure 32. View of the tube lens, showing the orientation of the lead pin

b. Push the tube lens until it snaps into place. 

6. To reinstall the skimmer in the ion source interface

a. Orient the skimmer so that the lead pin aligns with the socket. 

b. Push the skimmer until it snaps into place. 

Note  For most cleaning applications, HPLC grade methanol is the solvent of choice. 
However, use of buffers or salt solutions may require that you use an acidic, aqueous 
solution. If you need to use a solvent other than methanol, after cleaning the 
component, flush the component with distilled water and then flush it with methanol 
as a final wash. In all cases, ensure that all solvent has evaporated from the 
component(s) before reassembly.

Lead Pin

CAUTION  Take care not to scratch or nick the skimmer cone.

Note  There are no leads to connect to the tube lens and skimmer. 
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Replacing the Ion Source Interface Components

You must replace the capillary heater assembly (P/N 97055-60176) as a unit.

To remove the capillary heater assembly

1. To remove the ion transfer capillary, turn it counterclockwise until you can pull it free 
from the ion source interface.

2. Disconnect the capillary heater cable.

3. Disconnect the grounding wire.

4. Loosen the two screws that hold the capillary heater mount to the ion source interface 
housing.

5. Remove the capillary heater assembly.

To install a capillary heater assembly

1. Connect the capillary heater mount to the ion source interface housing.

2. Connect the grounding wire.

3. Connect the capillary heater cable.

4. Insert the ion transfer capillary into the ion source interface.

To replace other ion source interface components, refer to the exploded diagrams shown in 
Figure 33, Figure 34, and Figure 35.

CAUTION  Wait for the ion source interface to cool to ambient temperature before you 
disassemble it.

Note  Wear clean gloves when you handle the ion source interface components.
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Figure 33. Exploded view of the ion source interface (front)

Capillary Heater 
Mounting Cage

O-ring

Spray Cone

Ion Transfer 
Capillary 

O-ring

Kalrez 
O-ring

O-ring

Ion Sweep 
Cone

Graphite Seal 

Spray Cone Seal
LCQ Fleet Hardware Manual Thermo Scientific



 4 MS Detector Maintenance
API Source Maintenance
Figure 34. Exploded view of the ion source interface (rear)
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Figure 35. Capillary heater assembly and wiring diagram for the ion source interface
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Reinstalling the Ion Source Interface

To reinstall the ion source interface

1. Orient the ion source interface as shown in Figure 30.

2. Carefully insert the ion source interface into the vacuum manifold until it is seated in the 
Q00 RF lens. 

Reinstalling the Ion Max Ion Source Housing

To reinstall the Ion Max ion source housing

1. Carefully align the two guide pin holes on the rear of the source housing (see Figure 36) 
with the ion source housing guide pins on the mass spectrometer (see Figure 37), and 
carefully press the ion source housing onto the ion source mount.

2. Rotate the ion source housing locking levers 90 degrees to lock the ion source housing 
onto the ion source mount assembly.

Figure 36. Rear view of the Ion Max-S source housing

Guide Pin 
Holes

Locking Levers
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Figure 37. Ion source mount

3. To reinstall the source drain tube and restart the system 

a. Connect the 1-in. ID Tygon tubing (P/N 00301-22922) to the ion source housing 
drain fitting.

b. Attach the free end of the hose to a waste container, and vent the waste container to a 
fume exhaust system.

c. Start the system as described in “Starting the System after a Complete Shutdown” on 
page 115.

Guide Pins

CAUTION  Prevent solvent waste from backing up into the ion source and mass 
spectrometer. Always ensure that liquid in the drain tube is able to drain to a waste 
container and that the outlet of the drain tube is above the level of liquid in the waste 
container.

CAUTION  Your laboratory must be equipped with at least two independent fume 
exhaust systems. Route the (blue) forepump exhaust tubing to the first dedicated 
fume exhaust system. Route the drain tube from the Ion Max ion source to a waste 
container. Vent this waste container to the second dedicated fume exhaust system.

CAUTION   Do not vent the Ion Max ion source drain tube (or any vent tube 
connected to the waste container) to the same fume exhaust system to which you have 
connected the forepump. The analyzer optics can become irreversibly contaminated 
with pump oil residue if the Ion Max ion source drain tube and the blue forepump 
exhaust tubing are connected to the same fume exhaust system.
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Cleaning the Q00-L0 RF Lens
Chemicals that accumulate on the surfaces of the Q00 segments and lens L0 form an 
insulating layer that can modify the electrical fields that control ion transmission. Therefore, 
clean ion guide components are essential to the performance of the instrument. The Q00 
segments and lens L0 require cleaning less often than the tube lens and skimmer. The 
frequency of cleaning depends on the type and quantity of the compounds that you analyze.

To clean or replace the Q00 RF lens components, perform the following steps:

1. Removing the Q00-L0 RF Lens from the Vacuum Manifold

2. Disassembling the Q00-L0 RF Lens

3. Cleaning the Q00-L0 RF Lens Components

4. Reassembling the Q00-L0 RF Lens

5. Reinstalling the Q00-L0 RF Lens

Removing the Q00-L0 RF Lens from the Vacuum Manifold

Before you remove the Q00-L0 RF Lens from the vacuum manifold, you must shut down the 
MS detector, and then remove the ion source and the ion source interface.

To remove the Q00-L0 RF lens

1. Shut down and vent the system as described in “Shutting Down the System Completely” 
on page 113. 

2. Remove the Ion Max ion source from the front of the MS detector as described in 
Removing the Ion Max Ion Source Housing on page 77.

3. Remove the ion source interface as described in “Removing the Ion Source Interface from 
the Vacuum Manifold” on page 78.

4. Reach into the opening in the vacuum manifold (where the ion source interface was) and 
disconnect the electrical connector to the Q00-L0 RF lens.

CAUTION  Make sure to unplug the LCQ Fleet power cord before you proceed. 
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5. Loosen the three mounting bolts that hold the Q00-L0 RF lens housing to the vacuum 
manifold. See Figure 38.

6. Carefully remove the Q00-L0 RF lens assembly and place it on a clean surface.

Figure 38. Q00-L0 RF lens assembly removal
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Disassembling the Q00-L0 RF Lens

To disassemble the Q00-L0 RF lens 

1. Prepare a clean work area by covering the area with lint-free paper. 

2. Put on clean gloves before you handle the Q00-L0 RF lens components.

3. Remove the Q00-L0 device from the rear of the Q00 RF lens cage. The Q00-L0 device is 
secured to the Q00 RF lens cage by plunger balls. Figure 39 shows the location of the 
Q00-L0 RF lens components.

Figure 39. Exploded view of the Q00-L0 RF lens

Cleaning the Q00-L0 RF Lens Components

To clean the Q00-L0 RF lens

1. With a soft toothbrush or lint-free swab, scrub the contaminated part with a solution of 
detergent and water.

2. Rinse the part with tap water to remove the detergent.

3. Rinse the part with distilled water.

Threaded Guide Post (2)
Plunger Ball (3)

Plunger Ball (3)
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O-ring

O-ring

Q00 RF Lens Cage
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4. Place the part in a beaker and immerse it completely in HPLC-grade methanol. Move the 
part up and down in the methanol for 15 s. 

5. Remove the part from the methanol bath, and then rinse it thoroughly with fresh 
methanol.

6. Dry the part with a rapid stream of nitrogen gas.

7. Inspect each part for contamination and dust. If necessary, repeat the cleaning procedure.

Reassembling the Q00-L0 RF Lens

To reassemble the Q00-L0 RF lens 

Insert the Q00-L0 device through the rear of the Q00 RF lens cage until it is seated in the 
cage.

Reinstalling the Q00-L0 RF Lens

To reinstall the Q00-L0 RF lens in the vacuum manifold

1. Ensure that the two 2.148-in. O-rings (P/N 00107-15542) are properly installed on the 
back of the Q00 RF lens cage.

2. Orient the Q00-L0 RF lens assembly as shown in Figure 38 on page 88.

3. Carefully insert the Q00-L0 RF lens assembly into the vacuum manifold.

4. Reconnect the electrical connections.

5. Reinstall the ion source interface as described in “Reinstalling the Ion Source Interface” 
on page 85.

6. Reinstall the Ion Max ion source housing as described in Reinstalling the Ion Max Ion 
Source Housing on page 85.

7. Start up the system as described in “Starting the System after a Complete Shutdown” on 
page 115.

Note  Wear clean gloves to handle the parts after you clean them in methanol.
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Cleaning the Q0 and Q1 Ion Guides 
Chemicals that accumulate on the surfaces of the Q0 and Q1 ion guides form an insulating 
layer that can modify the electrical fields that control ion transmission. Therefore, clean ion 
guide components are essential to the performance of the instrument. The Q0 and Q1 ion 
guides require cleaning less frequently than the Q00 RF lens. The frequency of cleaning 
depends on the type and quantity of the compounds that you analyze.

To clean or replace Q0 and Q1 ion guide components, perform the following steps:

1. Removing the Top Cover of the MS Detector

2. Removing the Top Cover Plate of the Vacuum Manifold

3. Removing the Q0 and Q1 Ion Guides 

4. Cleaning the Q0 and Q1 Ion Guides

5. Reinstalling the Q0 and Q1 Ion Guides

6. Cleaning the Ion Detection System 

7. Reinstalling the Top Cover Plate of the Vacuum Manifold

8. Reinstalling the Top Cover of the MS Detector

Removing the Top Cover of the MS Detector

To remove the top cover of the MS detector 

1. Shut down and vent the system as described in “Shutting Down the System Completely” 
on page 113. 

2. Open the front door of the MS detector by loosening the Allen screw on the right side of 
the door with an Allen wrench. 

3. Loosen the two fasteners that hold the top cover to the MS detector chassis. The fasteners 
are located in the upper right and left corners of the chassis.

4. Slide the top cover back by about 1.2 cm (0.5 in.).

5. With one hand under the center of the top cover, lift the top cover up and away from the 
MS detector.

CAUTION  Make sure to unplug the LCQ Fleet power cord before you proceed. 
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Removing the Top Cover Plate of the Vacuum Manifold

You must remove the top cover plate of the vacuum manifold to access the Q0 and Q1 ion 
guides, mass analyzer, and ion detection system. The top cover plate is held in place by gravity 
and by the air pressure differential between the vacuum manifold and atmospheric pressure. 
Five cables are connected to the top cover plate and a helium gas line Swage-lok® fitting. See 
Figure 40.

To remove the top cover plate

1. Disconnect the electron multiplier high voltage coaxial cable that originates from the 
electron multiplier power supply.

2. Disconnect the electrometer cable from the electrometer PCB. (If necessary, use a small 
screw driver to loosen the screws that secure the cable.)

3. Disconnect the three cables that connect to the top cover PCB.

4. Disconnect the helium tube from the top cover.

5. Carefully lift the top cover plate straight up by its two handles. Take care not to damage 
the components on the underside of the cover plate. Place the cover plate upside down 
(supported on its handles) on a flat surface.

6. Cover the opening in the top of the vacuum manifold with a large, lint-free tissue.
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Figure 40. Electrical and helium connections to the top cover of the vacuum manifold 
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Removing the Q0 and Q1 Ion Guides

To remove the Q0 and Q1 ion guides from the top cover plate

1. Prepare a clean work area by covering the area with lint-free paper. Place each part on the 
paper as you remove it. 

2. To handle the ion guides, wear clean, lint-free, nylon or cotton gloves.

3. Disconnect the electrical leads to the Q0 quadrupole, lens L1, gate lens, Q1 octapole, and 
ion trap. 

4. Disconnect the Teflon tube from the nipple located entrance end cap electrode of the ion 
trap.

5. Holding the Q0 quadrupole and lens L1 with one hand, loosen and remove the two 
thumb screws that hold the Q0 ion guide mounting bracket to the top cover plate of the 
vacuum manifold. Slide the 3D trap back. See Figure 41.

6. Remove the Q0 quadrupole and lens L1.

7. Hold the Q1 octapole and gate lens with one hand; loosen and remove the two thumb 
screws that hold the ion trap mounting bracket to the top cover plate of the vacuum 
manifold. See Figure 41.

8. Remove the Q1 octapole and gate lens.

CAUTION  Be careful not to bend or break the lead pins on the Q0 quadrupole and 
Q1 octapole.
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Figure 41. Exploded view of the Q0 and Q1 ion guides 
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Cleaning the Q0 and Q1 Ion Guides

Remove contamination from the Q0 quadrupole, Q1 octapole, lens L1, and the gate lens. 
Clean each part in turn. After cleaning, place each part on a clean, lint–free surface. 

To remove contamination from the Q0 quadrupole, Q1 octapole, lens L1, and the gate 
lens

1. With a soft tooth brush or lint-free swab, scrub the ion guide part with a solution of 
detergent and water.

2. Rinse the part with tap water to remove the detergent.

3. Rinse the part with distilled water.

4. Place the part in a tall beaker and immerse it completely in HPLC-grade methanol. Move 
the part up and down in the methanol for 15 seconds.

5. Remove the part from the methanol bath, and then rinse it thoroughly with fresh 
methanol.

6. Dry the part with a rapid stream of nitrogen gas.

7. Inspect each part for contamination and dust. If necessary, repeat the cleaning procedure.

Reinstalling the Q0 and Q1 Ion Guides

Two adjustable mounting brackets hold the Q0 and Q1 ion guides in position on the top 
cover plate of the vacuum manifold. See Figure 41.

To re-install the Q0 and Q1 ion guides on the top cover plate

1. To install the Q0 ion guide

a. Insert lens L1 into the opening in the baffle (Figure 41). 

CAUTION  Take care not to bump or jar the Q0 quadrupole and Q1 octapole.

Note  When you clean the ion guide parts, pay particular attention to the inside 
surfaces.

Note  Wear clean, lint-free, nylon or cotton gloves to handle the parts after you clean 
them in methanol.

Note  To handle the ion guides, wear clean, lint-free, nylon or cotton gloves.
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b. With one hand, hold the Q0 quadrupole against the lens L1; with the other hand, 
install the Q0 ion guide mounting bracket so that the quadrupole is held between the 
mounting bracket and the lens L1. 

c. Tighten the two thumb screws that hold the Q0 ion guide mounting bracket to the 
top cover plate. 

2. To install the Q1 ion guide 

a. Insert the gate lens into the opening in the baffle (Figure 41). 

b. With one hand, hold the Q1 octapole against the gate lens; with the other hand, 
install the ion trap mounting bracket so that the octapole is held between the 
mounting bracket and the gate lens. 

c. Tighten the two thumb screws that hold the Q1 ion guide mounting bracket to the 
top cover plate. 

3. Reconnect the electrical leads to the Q0 quadrupole, lens L1, gate lens, Q1 octapole, and 
ion trap, according to the diagram shown in Figure 42. 

4. Check all leads to ensure that they are secure and that they are attached to the proper 
electrodes.

CAUTION  Be careful not to bend or break the lead pins on the Q0 quadrupole 
and Q1 octapole.
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Figure 42. Wiring diagram for the Q0 and Q1 ion guides

5. Slide the tubing for the helium damping gas onto the nipple located on the entrance 
end cap electrode of the ion trap. 

Figure 43 shows the connection of the tubing for the helium damping gas to the nipple 
on the ion trap and the wires to the connected to the Q0 and Q1 ion guides. The 
numbered wires in the photograph correspond to the numbered wires shown in the 
schematic (Figure 42).

Wire 13 (entrance end cap, yellow)

Wire 14 (exit end cap, green) Wire 7 (Q1, blue)

Wire 8 (Q1, violet)

Wire 4 (split lens, yellow)

Wire 1 (exit lens, brown)

Wire 2 (entrance lens, red)

Wire 3 (split lens gate, orange)

Wire 5 (lens 1, green)

Wire 9 (Q0, grey)

Wire 10 (Q0, white)

Wire 11 (Q00, blue)

Wire 6 (Lens 0, black)

Wire 12 (Q00, violet)
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Figure 43. View of the tubing that connects the helium damping gas to the ion trap

Cleaning the Ion Detection System

To keep the conversion dynode and electron multiplier of the ion detection system dust free, 
clean these components whenever you remove the top cover plate of the vacuum manifold. 
To clean the conversion dynode and electron multiplier, blow off the dust with a clean, dry 
gas such as nitrogen. Do not use freon gas. 

Teflon Tubing
Nipple

13

14

11

6

10

9
12

3
5

8

4

1

7

2

Note  Do not use liquids to clean the ion detection system components. Always cover the 
opening in the top of the vacuum manifold with a large, lint-free tissue whenever you 
remove the top cover plate of the vacuum manifold.
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Reinstalling the Top Cover Plate of the Vacuum Manifold

To reinstall the top cover plate of the vacuum manifold  

1. Remove the tissue from the opening in the top of the vacuum manifold.

2. Check the O-ring that surrounds the opening for signs of wear, and replace it if necessary 
(P/N 97055-40005). Make sure that the O-ring is seated properly. 

3. Carefully lift the top cover plate by its two handles and turn it over. Orient the top cover 
plate so that the electron multiplier is over the conversion dynode. Carefully insert the 
guide posts on the underside of the top cover plate into the guide holes in the vacuum 
manifold, and then slowly lower the cover plate onto the opening in the vacuum 
manifold. Take care not to damage the components on the underside of the cover plate.

4. Ensure that the cover plate is seated properly on the vacuum manifold. 

5. Reconnect the three cables to the top cover PCB. See Figure 40.

6. Reconnect the electron multiplier high voltage coaxial cable that comes from the electron 
multiplier power supply. 

7. Reconnect the electrometer cable to the electrometer PCB. 

8. Reconnect the helium gas line.

Reinstalling the Top Cover of the MS Detector 

To reinstall the top cover of the MS detector   

1. Open the front door of the MS detector by loosening the Allen screw on the right side of 
the door with an Allen wrench or hex-head ball driver.

2. With one hand under the center of the top cover, place the top cover over the MS 
detector so that the front of the cover is about 1.2 cm (0.5 in.) behind the front of the MS 
detector.

3. Slide the cover forward until it is flush with the front doors (when they are closed).

4. Tighten the two fasteners to secure the top cover to the chassis. 

5. Close the front door of MS detector. Tighten the screw on the right side of the door. 

6. Start up the system as described in “Starting the System after a Complete Shutdown” on 
page 115.

Note  Periodically, remove any contamination that might be on the inner walls of the 
manifold by wiping the inner walls with a lint-free tissue soaked in HPLC-grade 
methanol. Use a cotton-tipped applicator soaked in methanol to clean around inlets 
and feedthroughs.
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Maintaining the Mass Analyzer 
Although the mass analyzer very rarely requires cleaning, you can clean it by performing the 
following steps:

1. Removing the Mass Analyzer

2. Disassembling the Mass Analyzer

3. Cleaning the Mass Analyzer Parts

4. Reassembling the Mass Analyzer

5. Reinstalling the Mass Analyzer

Removing the Mass Analyzer

The ion optics and mass analyzer are mounted on a plastic mount on the underside of the top 
cover plate of the vacuum manifold. See Figure 44 for the location of the ion optics and mass 
analyzer components.

Figure 44. Mass analyzer exploded view 
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To remove the mass analyzer from the MS detector

1. Disconnect the electrical leads to the entrance lens, entrance endcap electrode, exit 
endcap electrode, and the exit lens of the mass analyzer. See Figure 42 on page 98.

2. Disconnect the tubing for the helium damping gas from the nipple on the exit endcap 
electrode by pulling the line free from the nipple. See Figure 43 on page 99.

3. Holding the mass analyzer with one hand, loosen the two thumb screws that hold the 
analyzer mount to the top cover.

4. With one hand holding the mass analyzer and the other hand holding the octapole, 
slide the mass analyzer away from the baffle on the top cover plate. Take care not to touch 
the electron multiplier with the mass analyzer, as doing so could damage the 
electropolished surface of the electron multiplier. Take care not to drop the octapole, as 
doing do could damage it.

Disassembling the Mass Analyzer

Figure 44 on page 101 shows the location of the ion optics and mass analyzer components.

To disassemble the mass analyzer

1. Remove the entrance lens by pulling the entrance lens out of the entrance lens sleeve.

2. Remove the entrance lens sleeve by squeezing the sleeve and pulling it out of the recess in 
the entrance endcap electrode.

3. Remove the exit lens by pulling it out of the exit lens sleeve. Use the connector pin to aid 
in pulling off the lens.

4. Remove the exit lens sleeve by squeezing the sleeve and pulling it out of the recess in the 
exit endcap electrode.

5. Unscrew and remove the two nuts from the posts.

6. Remove the two spring washers from the posts.

7. Remove the exit endcap electrode from the posts.

8. Remove the two spacer rings and the ring electrode.

9. Remove the entrance endcap electrode from the posts.

IMPORTANT   Wear clean, lint-free, nylon or cotton gloves when you handle the mass 
analyzer and its components.
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Cleaning the Mass Analyzer Parts

Use the following procedure to remove contamination from the ion optics and mass analyzer 
parts. Clean each part in turn. After cleaning, place each part on a clean, lint–free surface.

To remove contamination from the mass analyzer parts

1. With a soft tooth brush or lint-free swab, scrub the ion optics or mass analyzer part with a 
solution of detergent and water.

2. Rinse the part with tap water to remove the detergent.

3. Rinse the part with distilled water.

4. Place the part in a tall beaker and immerse it completely in HPLC-grade methanol. Move 
the part up and down in the methanol for 15 seconds. 

5. Wearing clean, lint-free, nylon or cotton gloves, do the following:

a. Remove the part from the methanol bath

b. Rinse the part thoroughly with fresh methanol.

c. Dry the part with a rapid stream of nitrogen gas.

d. Inspect each part for contamination and dust. If necessary, repeat the cleaning 
procedure.

CAUTION  Do not chip, scratch, or break the spacer rings of the mass analyzer. Take care 
not to bump or jar the octapole. Do not place the octapole in an ultrasonic cleaner.

Note   When you clean the ion optics and mass analyzer parts, pay particular attention to 
the inside surfaces.

CAUTION  Do not use aluminum oxide to clean the ion optics or the mass analyzer. 
Doing so removes the XXX.

Tip  You can use an ultrasonic bath to clean the ring electrode, end caps, and lens.
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Reassembling the Mass Analyzer

Figure 44 on page 101 shows the location of the ion optics and mass analyzer components.

To reassemble the mass analyzer 

1. Wearing clean, lint-free, nylon or cotton gloves, reinstall the entrance endcap electrode

a. Slide the entrance endcap electrode onto the analyzer posts.

b. Check the following:

• The convex surface of the electrode faces away from the analyzer mount.

• The opening in the electrode for the pin on the end of the electrical lead faces 
away for the top cover plate (when the analyzer mount is installed on the top 
cover plate), slide the entrance endcap electrode onto the analyzer posts.

2. Place a quartz spacer ring into the groove in the entrance endcap electrode.

3. Reinstall the ring electrode onto the quartz spacer ring so that the spacer ring is held 
securely between the electrodes. The orientation of the ring electrode is unimportant. 

4. Reinstall the second quartz spacer ring into the groove in the ring electrode.

5. To reinstall the exit endcap electrode

a. Slide the exit endcap electrode onto the analyzer posts so that the quartz spacer ring is 
held in place between the ring electrode and the exit endcap electrode. 

b. Check the following:

• The electrode is oriented with the convex surface facing the spacer ring.

• The damping gas nipple points away from the top cover plate when the analyzer 
mount is installed on the top cover plate.

6. Inspect the mass analyzer assembly. Ensure that all the parts are aligned properly and that 
they all fit together snugly.

7. Reinstall the spring washers on the analyzer posts.

8. Reinstall the analyzer nuts onto the analyzer posts and tighten the nuts by hand until they 
are finger tight. Do not overtighten the nuts.

IMPORTANT   Wear clean, lint-free, nylon or cotton gloves when you handle the mass 
analyzer and its components.

CAUTION  Handle the quartz spacer rings carefully. Do not scrape the spacer rings 
against any metal surfaces. Metal deposits on the surfaces of the spacer rings might 
cause potentially damaging RF voltage, arcing across the spacer rings to the endcaps. 
Do not overtighten the mass analyzer nuts.
LCQ Fleet Hardware Manual Thermo Scientific



 4 MS Detector Maintenance
Replacing the Electron Multiplier
9. Squeeze the exit lens sleeve and insert it into the recess in the exit endcap electrode. See 
Figure 44 on page 101 for the proper orientation of the exit lens sleeve.

10. Insert the exit lens into the exit lens sleeve so that the lead pin on the exit lens points in 
the same direction as the 8-pin feedthrough when the analyzer mount is installed on the 
top cover plate. Make sure that the exit lens lead pin does not contact the nut on the end 
of the mass analyzer post.

11. Insert the entrance lens sleeve so that the lead pin on the entrance lens points in the same 
direction as the 8-pin feedthrough when the analyzer mount is installed on the top cover 
plate. 

Reinstalling the Mass Analyzer

To reinstall the mass analyzer 

1. Wearing clean, lint-free, nylon or cotton glove, insert the octapole into the gate lens and 
support it with your hand. See Figure 41 on page 95.

2. With your other hand, slide the mass analyzer assembly so that the octapole mates with 
the front lens. 

3. Secure the analyzer mount to the baffle with the two thumb screws.

4. Inspect the ion optics. Ensure that all the parts are aligned properly and that they all fit 
together snugly.

5. Reconnect all the electrical leads. See Figure 42 on page 98.

6. Reconnect the damping gas line to the nipple on the entrance endcap electrode. 

Replacing the Electron Multiplier
The electron multiplier of the ion detection system includes an anode and a cathode. The 
anode and cathode have finite lifetimes. The anode loses sensitivity over time due to 
contamination of its surface. Heat, electron flow (which produces internal heat), air (which 
causes oxidation and arcing) and water (which causes arcing) decrease the lifetime of the 
cathode. 

The following symptoms suggest that the electron multiplier might need replacing:

• Excessive noise in the mass spectrum

IMPORTANT  Wear clean, lint-free, nylon or cotton gloves when you handle the mass 
analyzer and its components.

Note  Check all leads and ensure that they are secure and that they go to the proper 
electrodes.
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• Inability of the multiplier gain calibration procedure to achieve a gain of 4 × 105 electrons 
per ion with an electron multiplier voltage less than or equal to 2.5 kV

To check the current value of the electron multiplier voltage, choose Setup > Ion Detection 
System in Tune Plus window to open the Ion Detection System dialog box.

If you are having problems with the ion detection system, you must replace the electron 
multiplier assembly.

To replace the electron multiplier assembly

1. Shut down and vent the system as described in “Shutting Down the System Completely” 
on page 113.

2. Remove the top cover of the MS detector as described in “Removing the Top Cover of 
the MS Detector” on page 91.

3. Remove the top cover plate of the vacuum manifold as described in “Removing the Top 
Cover Plate of the Vacuum Manifold” on page 92. 

4. With an Allen wrench and wearing clean, lint-free, nylon or cotton gloves, remove the 
two socket-head screws that hold the electron multiplier support to the top cover plate of 
the vacuum manifold. See Figure 45.

5. With one hand holding the high voltage tube and with the other hand holding the 
electron multiplier support, detach the high voltage tube from the high voltage 
feedthrough in the top cover plate and remove the electron multiplier as a unit. (The 
anode remains in the anode feedthrough in the top cover plate.)

6. With one hand holding the high voltage tube and the other hand holding the electron 
multiplier support, install the new electron multiplier (P/N 96000-60036) on the top 
cover plate. Ensure that the high voltage tube is properly inserted in the high voltage 
feedthrough and that the screw holes in the electron multiplier support are aligned with 
the screw holes in the top cover plate as shown in Figure 45.

CAUTION  Make sure to unplug the LCQ Fleet power cord before you proceed.

IMPORTANT  Wear clean, lint-free, nylon or cotton gloves when you handle the 
electron multiplier components.

CAUTION  Be careful not to damage the surface of the electron multiplier shield. The 
electron multiplier shield has been electropolished to prevent field emission.
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Figure 45. Installing the electron multiplier

7. Reinstall the two socket-head screws that secure the electron multiplier support to the top 
cover plate. Tighten the screws with an Allen wrench.

8. Reinstall the top cover plate of the vacuum manifold over the opening in the vacuum 
manifold as described in “Reinstalling the Top Cover Plate of the Vacuum Manifold” on 
page 100.

9. Reinstall the top cover of the MS detector as described in “Reinstalling the Top Cover of 
the MS Detector” on page 100.

10. After you replace the electron multiplier, calibrate it as described in the next section.

Electron Multiplier

Top Cover Plate

Electron Multiplier

Top Cover Plate
High Voltage 
Feedthrough

High Voltage Tube
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Calibrating the Electron Multiplier
Calibrate the electron multiplier after you replace it.

To calibrate the electron multiplier

1. Start up the LCQ Fleet system as described in “Starting the System after a Complete 
Shutdown” on page 115.

2. Set the electron multiplier voltage to -800 V as follows:

a. Make sure that the system is in the MS/MS mode.

b. From the Windows XP taskbar, choose Start > All Programs > Xcalibur > LCQ 
Fleet Tune to open the Tune Plus window.

c. From the Tune Plus window, choose Diagnostics > Diagnostics.

The Diagnostics dialog box appears. See Figure 46.

Figure 46. Diagnostics dialog box

d. Under Tools, select Set device.

e. Under Device, select Multiplier norm gain.

f. In the Value box, type -800.

g. Click Set to set the electron multiplier voltage to -800 V.

h. Click OK to return to Tune Plus.

3. To calibrate the electron multiplier voltage

a. Pump down the system for at least one hour before you turn on the high voltages.

b. Set up to infuse tuning solution into the MS detector as described in the LCQ Fleet 
Getting Started Guide.
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c. From the Tune Plus window, choose Control > Calibrate. 

The Calibrate dialog box appears.

d. Choose View > Display Graph View.

e. Click the Semi-Automatic tab to display the Semi-Automatic page.

f. Under What to Calibrate, select Electron Multiplier Gain. 

g. To start the multiplier gain procedure, click Start.

4. After the Electron Multiplier Gain program is finished, set up for operation as described 
in the LCQ Fleet Getting Started Guide.

Replacing the Turbomolecular Pump Cartridge
Plan to replace the rotating, interior portion of the turbomolecular pump, referred to as the 
turbomolecular pump cartridge, after 20000 to 30000 hours of operation, or if the bearings 
fail. 

To replace the turbomolecular pump cartridge 

1. Shut down the system.

2. Remove the left front panel. 

3. Disconnect the power cable from the turbomolecular pump. 

4. Disconnect the foreline from the turbomolecular pump. 

5. Loosen and remove the six 4-mm socket-head screws that hold the insert to the pump. 

6. Remove the old cartridge and install a new cartridge. 

7. Install and tighten the six screws that hold the cartridge to the pump.

8. Connect the foreline to the turbomolecular pump.

9. Connect the power cable to the turbomolecular pump.

10. Reinstall the left front panel.

11. Start the system.

CAUTION  The turbomolecular pump insert is very delicate. We recommend that a 
Thermo Scientific field service engineer replace the turbomolecular pump insert.
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Cleaning the Fan Filter
You must clean the fan filter (P/N 97055-20254) every four months. The fan filter is located 
on the back of the MS detector on the right side (when viewed from the front). 

To clean the fan filter 

1. Remove the fan filter from the rear of the MS detector by pulling it up and out of its fan 
filter bracket.

2. Wash the fan filter in a solution of soap and water.

3. Rinse the fan filter with tap water.

4. Squeeze the water from the fan filter and allow it to air dry.

5. Reinstall the fan filter in its fan filter bracket.
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System Shutdown, Startup, and Reset

If you will not be using the system for 12 hours or more, you can place the LCQ Fleet system 
in Standby mode to conserve nitrogen. To perform maintenance procedures on system 
components that are held under vacuum, you must shut down the MS detector completely.

This chapter contains the following sections:

• Shutting Down the System in an Emergency

• Placing the System in Standby Mode

• Shutting Down the System Completely

• Starting the System after a Complete Shutdown

• Resetting the MS Detector

• Resetting the Tune and Calibration Parameters to their Default Values

• Resetting the Data System

• Turning Off Selected MS Detector Components

Shutting Down the System in an Emergency
In emergency situations, you can turn off the MS detector and the vacuum pumps.

To perform an emergency shutdown of the LC/MS system

1. If you need to turn off the MS detector in an emergency, place the main power circuit 
breaker switch, located on the power panel on the right side panel of the MS detector (see 
Figure 47), in the Off (O) position. This turns off all power to the MS detector, 
including the vacuum pumps. 

Although removing power abruptly will not harm any component within the system, 
Thermo Scientific does not recommend doing so. Instead, follow the procedure 
“Shutting Down the System Completely” on page 113. 

2. To turn off the LC pump, autosampler, and computer in an emergency, use the on/off 
switches for these devices.
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 On
Figure 47. View of the power panel showing the Reset button and the main power circuit breaker 

Placing the System in Standby Mode
You do not need to shut down the LCQ Fleet completely if you are not going to use it for a 
short period of time, such as overnight or over weekends. When you are not going to operate 
the system for 12 hours or more, you can leave the system in Standby mode.

To place the LCQ Fleet MS detector in Standby mode

1. Wait until data acquisition, if any, is complete.

2. To turn off the solvent flow from the LC pump 

a. In the Tune Plus window, click the LC button. 

The Inlet Direct Control dialog box appears.

b. Click on  (or Pump Off or Stop Pump) to stop the LC pump. 

3. From the Tune Plus window, choose Control > Standby (or click the On/Standby 
button to toggle it to Standby). The MS detector in now in Standby mode.

Main Power 
Circuit Breaker

CAUTION  If you are using APPI do not leave the LC or other liquid delivery 
device ON while the mass spectrometer is in Standby mode. The absence of 
sheath and auxiliary gas can cause the hot VUV lamp to break upon contact 
with liquids. 

   Standby
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When you put the MS detector in Standby, the LCQ Fleet turns off the electron 
multiplier, conversion dynode, 8 kV power to the API source, main RF voltage, and ion 
guide RF voltages. The LCQ Fleet also turns off the auxiliary and sheath gas flows. See 
Table 10 on page 120 for the On/Off status of MS detector components when the MS 
detector is in Standby mode. The System LED on the front panel of the MS detector is 
yellow when the system is in Standby.

4. Flush the spray cone and the entrance end of the ion transfer capillary of the API source 
as described in “Flushing the Ion Sweep Cone and Ion Transfer Capillary” on page 72.

5. Purge the forepump oil as described in “Purging the Oil in the Forepump” on page 66. 

6. Leave the power on for the following components of your LC/MS system:

• The MS detector

• The LC pump 

• The autosampler 

• The data system computer 

Shutting Down the System Completely
If you are not going to use LCQ Fleet MS detector for a short period of time, such as 
overnight or over weekends, you do not need to shut it down completely (see “Placing the 
System in Standby Mode” on page 112). Shut down the system completely only if you do not 
plan to use it for an extended period or if it must be shut down for a maintenance or service 
procedure.

To shut down the LCQ Fleet completely

1. Turn off the solvent flow from the LC pump (or other sample introduction device). 

2. From the Tune Plus window, choose Control > Standby (or click On/Standby) to put 
the MS detector in Standby. 

When you place the MS detector in Standby, the LCQ Fleet turns off the electron 
multiplier, conversion dynode, 8 kV power to the API source, main RF voltage, and 
octapole RF voltage. In addition the LCQ Fleet turns off the flow of the sheath and 
auxiliary gasses.

3. Place the electronics service switch, located on the power panel (see Figure 47 on 
page 112), in the Service position. 

Note  For instructions on how to turn off the solvent flow from the LC pump, refer to 
the Help provided with the software.
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Placing the electronics service switch in the Service position turns off the power to the 
non-vacuum system electronics. 

4. Place the main power circuit breaker switch in the Off (O) position. 

The switch is located on the power panel (Figure 47). When this switch is turned off, the 
following occurs:

• All power to the MS detector, including the turbomolecular pump and forepump, is 
turned off. (All LEDs on the front panel of the MS detector are off.)

• Power to the vent valve solenoid is shut off. When power to the vent valve solenoid is 
shut off, the vent valve opens and the vacuum manifold is vented to filtered air. You 
can hear a hissing sound as the air passes through the air filter.

• After about 5 minutes, the vacuum manifold is at atmospheric pressure.

5. Unplug the power cord for the MS detector. 

6. Turn off the LC pump (if it is a part of your system). Follow the procedure described in 
the manual that came with the LC.

7. Turn off the helium damping gas supply at the tank. 

8. Turn off the nitrogen supply at the tank.

9. Turn off the data system as follows:

a. In the Windows XP® Start menu, click the Shutdown button. 

The Shut Down Windows dialog box appears.

b. Select Shut Down, and then click OK to start the Windows XP shutdown 
procedure.

c. When the Windows XP shutdown procedure tells you that it is safe to turn off the 
computer, turn off the monitor and computer by using the on/off switches.

CAUTION  Allow heated components to cool before servicing them.

Note  If you are planning to perform routine or preventive system maintenance on the 
MS detector only, you do not need to turn off the LC pump, data system, and 
autosampler. In this case, the shutdown procedure is completed. However, if you do 
not plan to operate your system for an extended period of time, Thermo Scientific 
recommends that you turn off the LC pump, data system computer, and autosampler 
as described in steps 6 through 11.
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10. Turn off the printer (if it is a part of your system) by using the printer on/off switch.

11. Turn off the autosampler (if it is a part of your system) by using the autosampler main 
power on/off switch.

Starting the System after a Complete Shutdown
To start up the LCQ Fleet after it has been shut down completely, you must perform the 
following steps:

1. Starting the LC Pump (if this is a part of the system)

2. Starting the Data System

3. Starting the MS Detector

4. Starting the Autosampler (if this is a part of the system)

5. Setting Up Conditions for Operation

Starting the LC Pump

To start the LC pump, follow the startup procedure described in the manual that came with 
the LC pump. If necessary, configure the LC pump as described in the manual provided with 
the LC Devices software. Do not turn on the solvent flow to the MS detector.

Starting the Data System

To start the data system 

1. Turn on the monitor, computer, and printer.

2. Follow the Windows XP startup procedure. 

3. Press CTRL + ALT + DEL when you are prompted to do so, and then click OK or enter 
your password (if you have one) in the Logon Information dialog box to complete the 
startup procedure.

Starting the MS Detector

To start the MS detector 
 

1. Turn on the flows of helium and nitrogen at the tanks if they are off.

Note  The data system must be running before you start the MS detector. The MS 
detector will not operate until software is received from the data system.
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2. Make sure that the main power circuit breaker switch is in the Off (O) position and the 
electronics service switch is in the Service position.

3. Plug in the power cord for the MS detector.

4. Place the main power circuit breaker switch in the On (|) position. When you place the 
main power circuit breaker switch in the On (|) position, the forepump and the 
turbomolecular pump start. All LEDs on the MS detector front panel are off.

5. Allow the LCQ Fleet to pump down for 5 minutes.

6. Place the electronics service switch in the Electronics Normal position. 

When you place the electronics service switch in the Electronics Normal position, the 
following occurs:

• The Power LED on the MS detector front panel turns green to indicate that power is 
provided to the MS detector electronics. (The electron multiplier, conversion 
dynode, 8 kV power to the API source, main RF voltage, and octapole RF voltage 
remain off.)

• The embedded computer reboots. After several seconds the Communication LED on 
the front panel turns yellow to indicate that the data system and the MS detector 
have started to establish a communication link.

• After several more seconds, the Communication LED turns green to indicate that the 
data system and the MS detector have established a communication link. Ensure that 
the instrument console window is active. Software for the operation of the MS 
detector is then transferred from the data system to the MS detector.

• After three minutes, the System LED turns yellow to indicate that the software 
transfer from the data system to the MS detector is complete and that the instrument 
is in Standby. 

 

If you have an autosampler, see “Starting the Autosampler” on page 116. If you do not have 
an autosampler, go to the topic “Setting Up Conditions for Operation” on page 117.

Starting the Autosampler

To start the autosampler, place the main power switch on the autosampler in the on position. 
If necessary, configure the autosampler. For procedures for placing sample vials, preparing 
solvent and waste bottles, installing syringes, and so on, refer to the manual supplied with the 
autosampler. You can find information on connecting your autosampler to the LCQ Fleet 
MS detector in the LCQ Fleet Getting Connected Guide.

Note  The Vacuum LED on the front panel of the MS detector turns green only 
if the pressure in the vacuum manifold is below the maximum allowable pressure 
(5 × 10-4 Torr in the analyzer region, and 2 Torr in the capillary-skimmer 
region).
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Setting Up Conditions for Operation

To set up your LCQ Fleet for operation

1. Before you begin data acquisition with your LCQ Fleet, allow the system to pump down 
for at least one hour. Operation of the system with excessive air and water in the vacuum 
manifold can cause reduced sensitivity, tuning problems, and reduced lifetime of the 
electron multiplier.

2. Ensure that the helium pressure and nitrogen pressure are within the operational limits 
(helium: 40 ± 10 psig [275 ±70 kPa], nitrogen: 100 ± 20 psig [690 ± 140 kPa]). 

3. Look at the status panel in the Tune Plus window. Check to see if the pressure measured 
by the ion gauge is below about 5 ×10-5 Torr, and the pressure measured by the 
Convectron gauge is around 1 Torr. Compare the values of the other parameters in the 
status panel with values that you recorded previously.

4. Set up for ESI, APCI, APPI, or NSI operation as described in the LCQ Fleet Getting 
Started Guide. 

Resetting the MS Detector
If communication between the MS detector and data system computer is lost, it may be 
necessary to reset the MS detector using the Reset button on the power panel. Pressing the 
Reset button creates an interruption in the embedded computer that causes it to restart in a 
known (default) state. See Figure 47 on page 112 for the location of the Reset button. 

Note  Air in the helium line must be purged or given sufficient time to be purged for 
proper LCQ Fleet performance.

Note  You do not need to calibrate or tune the LCQ Fleet each time you restart it.

Calibration parameters are instrument parameters whose values do not vary with the 
type of experiment, such as the ionization mode or the solvent flow rate. Calibrate the 
LCQ Fleet once a month. Check the calibration once a week by viewing the mass 
spectrum of an analyte for which you have recorded data. If the measured 
mass-to-charge ratios for the known analytes changes, re-calibrate the MS detector. 
Refer to the LCQ Fleet Getting Started Guide for the LCQ Fleet calibration procedure.

Tune parameters are instrument parameters whose values vary with the type of 
experiment. Tune the LCQ Fleet (or change the tune method) whenever you change 
the type of experiment. Refer to LCQ Fleet Getting Started Guide for tuning 
procedures in the ESI or APCI mode. The LCQ Fleet comes with several standard 
tune methods that are specific for various experimental conditions. 
Thermo Scientific LCQ Fleet Hardware Manual 117



5 System Shutdown, Startup, and Reset
Resetting the Tune and Calibration Parameters to their Default Values

118
This procedure assumes that the MS detector and data system computer are both powered on 
and operational. If the MS detector, data system computer, or both are off, see “Starting the 
System after a Complete Shutdown” on page 115.

To reset the MS detector 

Press the Reset button located on the power panel, and then verify that the Communication 
LED is extinguished. 

When you press the Reset button, the following occurs:

• An interruption of the embedded computer causes the CPU to reboot. All LEDs on the 
front panel of the MS detector are off except the Power LED.

• After several seconds, the Communication LED turns yellow to indicate that the data 
system and the MS detector are starting to establish a communication link.

• After several more seconds, the Communication LED turns green to indicate that the 
data system and the MS detector have established a communication link. Software for the 
operation of the MS detector is then transferred from the data system to the MS detector.

• After three minutes the software transfer is complete. The System LED turns either green 
or yellow. Green indicates that the instrument is functional and the high voltages are on. 
Yellow indicates that the instrument is functional and is in Standby mode.

Resetting the Tune and Calibration Parameters to their Default Values
You can reset the LCQ Fleet tune and calibration parameters to their default values at any 
time. This feature might be useful if you have manually set some parameters that have resulted 
in less than optimal performance. 

To reset the LCQ Fleet tune and calibration parameters to their default values 

1. In the Tune Plus window, choose File > Restore Factory Calibration to restore the 
default calibration parameters, or choose File > Restore Factory Tune Method to restore 
the default tune parameters.

2. To optimize the LCQ Fleet system parameters (that is, to calibrate or tune the system), 
perform the calibration procedure described in the LCQ Fleet Getting Started Guide. 

Note  The Reset button is a momentary switch. After you release it, it returns to its 
normal position.

Note  Make sure that the problems that you are experiencing are not due to improper API 
source settings (for example, spray voltage, sheath and auxiliary gas flow, ion transfer 
capillary temperature, and so on) before resetting the system parameters to their default 
values.
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Resetting the Data System
There are two ways to reset the data system:

• Using Windows XP to Reset the Data System

• Using the Reset Button on the PC to Reset the Data System

Using Windows XP to Reset the Data System

If possible, use the Windows XP shutdown and restart procedure to shut down and restart the 
data system so that Windows XP can properly close applications and save changes to files.

To reset the data system by using Windows XP 

1. From the Windows XP task bar, choose Start > Turn Off Computer. 

The Turn Off Computer dialog box appears.

2. Click the Restart button to start the Windows XP shutdown and restart procedure.

3. Press CTRL + ALT + DEL when prompted, and then click OK or enter your password 
(if you have one) in the Logon Information dialog box to complete the shutdown and 
restart procedure. 

Using the Reset Button on the PC to Reset the Data System

To reset the data system by pressing the reset button on the computer

1. Press the reset button on the personal computer.

2. Observe the Windows XP shutdown and restart procedure on the monitor, and press 
CTRL + ALT + DEL when prompted. To complete the shutdown and restart procedure, 
click OK or enter your password (if you have one) in the Logon Information dialog box.

3. When the shutdown and restart procedure is complete, choose 
Start > All Programs > Xcalibur > LCQ Fleet Tune.

The Tune Plus window appears.

Note  Resetting the data system automatically re-establishes the communications link 
between the data system and the MS detector. When this link occurs, the 
Communication LED on the front panel of the MS detector turns yellow and then 
green. If the system is unable to re-establish the communications link, press the Reset 
button on the power panel of the MS detector. Press the Reset button quickly and 
firmly.
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Turning Off Selected MS Detector Components
You can turn off some or all of the MS detector components five ways:

• Turn off individual MS detector components from the Tune Plus window. Turning off 
individual MS detector components might be necessary when you are troubleshooting or 
when you are running certain diagnostic procedures.

• Place the MS detector in Standby. Standby is the normal condition in which to leave the 
MS detector when it is not in use. Choose Control > Standby (or click the On/Standby 
button) from the Tune Plus window.

• Turn the MS detector off. Off is similar to Standby, except all high voltage components 
of the MS detector are turned off. Choose Control > Off from the Tune Plus window to 
place the MS detector in the Off mode.

• Turn the electronics service switch to Service. The electronics service switch allows you to 
perform maintenance procedures involving system components of the MS detector that 
are not under vacuum.

• Place the main power circuit breaker switch in the Off (O) position. Placing the main 
power circuit breaker switch in the Off (O) position removes all power to the MS 
detector, including the vacuum system.

The on/off status of MS detector components, voltages, and gas flows is summarized in 
Table 10.

Note  The communications link between the data system and the MS detector should 
be automatically reestablished after you reset the data system. When this occurs, the 
Communication LED on the front panel of the MS detector turns yellow and then 
green. If the system is unable to reestablish the communications link, press the Reset 
button on the power panel of the MS detector. Only a momentary push of the Reset 
button is needed as it is a momentary switch. 

Table 10. On/off status of MS detector components, voltages, and gas flows (Sheet 1 of 2) 

MS detector component
Standby mode Off mode Electronics service 

switch in 
Service position

Main power circuit breaker 
switch in 
Off (O) position

Electron multiplier Off Off Off Off

Conversion dynode Off Off Off Off

Mass analyzer RF/waveform voltages Off Off Off Off

Mass analyzer dc offset voltage On Off Off Off
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Ion optics multipoles RF voltages Off Off Off Off

Ion optics multipoles dc offset 
voltages

On Off Off Off

Ion optics lens On Off Off Off

Tube lens On Off Off Off

Ion transfer capillary heater On On Off Off

Ion transfer capillary dc offset On Off Off Off

Corona discharge needle Off Off Off Off

APCI vaporizer On Off Off Off

ESI needle Off Off Off Off

Sheath gas Off Off Off Off

Auxiliary gas Off Off Off Off

Sweep gas Off Off Off Off

Helium damping gas On On On On

Vent valve Closed Closed Closed Open

Turbomolecular pump On On On Off

Rotary-vane pump On On On Off

Turbomolecular Pump Controller On On On Off

Power supply, electron 
multiplier/conversion dynode

Off Off Off Off

Power supply, 8 kV Off Off Off Off

Power supply PS1 On On Off Off

Power supply PS2 On On On Off

Fan, turbomolecular pump On On On Off

Fan, RF coil On On Off Off

Fans, electronics tower On On On Off

Convectron gauge On On Off Off

Ion gauge On On Off Off

Table 10. On/off status of MS detector components, voltages, and gas flows (Sheet 2 of 2) 

MS detector component
Standby mode Off mode Electronics service 

switch in 
Service position

Main power circuit breaker 
switch in 
Off (O) position
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Diagnostics and PCB and Assembly Replacement

Many of the MS detector components can be tested by the LCQ Fleet diagnostics. 
Thermo Scientific’s service philosophy for the LCQ Fleet system calls for troubleshooting to 
the lowest part, assembly, PCB, or module listed in Chapter 7, “Replaceable Parts.”  Plan to 
replace LCQ Fleet components when indicated by the LCQ Fleet diagnostics, by 
Thermo Scientific Technical Support, or by a Thermo Scientific Customer Support Engineer.

This chapter contains the following sections:

• Running the LCQ Fleet Diagnostics

• Replacing a Fuse

• Replacing Power Supplies

• Replacing PCBs in the MS Detector

Running the LCQ Fleet Diagnostics 
The LCQ Fleet diagnostics test the major electronic circuits within the instrument and 
indicate whether the circuits pass or fail the tests. If there is a problem with the instrument 
electronics, the LCQ Fleet diagnostics can often locate the problem. You can often correct the 
problem yourself by replacing a faulty PCB or assembly.

The LCQ Fleet diagnostics only diagnose problems that are electrical in nature. For example, 
they do not diagnose poor sensitivity due to misaligned or dirty components or to improper 
tuning. For such reasons, it is important to have someone who is familiar with system 
operation and basic hardware theory run the diagnostics and use them to assist in isolating 
any problems.

Before running the diagnostics, consider the following:

• Did the system fail when you were running samples?

• Did problems occur after you performed maintenance on the instrument, data system, or 
peripherals?

• Did you change the system’s configuration, cables, or peripherals just before the problem 
occurred?
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If the answer is yes to the first item above, there is the possibility of a hardware failure, and 
running the diagnostics is appropriate.

If the answer is yes to one of the last two items above, the problem is probably mechanical, 
not electrical. Check that alignment, configurations, and cable connections are correct before 
you run the LCQ Fleet diagnostics.

To run the LCQ Fleet diagnostics, perform the following steps:

1. Calibrating the Multipole RF and the Main RF

2. Running the Diagnostics

Calibrating the Multipole RF and the Main RF

Proper calibration of the multipole RF frequency is necessary to allow for the maximum 
transmission of ions through the multipoles. You need to calibrate the frequency of the 
multipole RF voltage each time you modify the hardware in some way, for example, by a 
maintenance operation. 

To calibrate the multipole RF and the main RF

1. Click Calibrate in the Tune Plus window task bar (Figure 48). You can also access 
Calibrate from the Control menu at the top of the Tune Plus window by choosing 
Control > Calibrate.

The Calibrate dialog box appears. See Figure 49.
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Figure 48. LCQ Fleet Tune Plus window

2. Click the Semi-Automatic tab. 

Figure 49 shows the Semi-Automatic page of the Calibrate dialog box.

3. In the What to Calibrate area, select the Multipole RF Frequency and Main RF 
Frequency check boxes. 

4. Click Start.

Calibrate button
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Figure 49. Calibrate dialog box. Multipole RF Frequency and Main RF Frequency are indicated.

After you click the Start button (see Step 2 above), the instrument carries out an 
automated sequence of steps that the data system displays as graphs in the Graph view of 
the Tune Plus window. The titles of the graphs are as follows:

• Coarse Tune - multipole resonance frequency (Figure 50)

• Scanning Multipole RF DAC graph (Figure 51)

• Tuning RF Resonance Frequency (Figure 52)

The graphs shown in Figure 51 through Figure 52 appear automatically as the instrument 
goes through the tuning procedure. 

Multipole RF 
Frequency

Main RF 
Frequency
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Figure 50. Coarse Tune - multipole resonance frequency
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Figure 51. Scanning Multipole RF DAC graph 
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Figure 52. Tuning RF resonance frequency

Running the Diagnostics

To run the diagnostics

1. In the LCQ Fleet Tune window, choose Diagnostics > Diagnostics. 

The Diagnostics dialog box appears (Figure 53). 

2. Click the Test tab (Figure 53). 

3. Depending on what you want to test, do one of the following:

• To perform testing on all the subsystems (except for the I/O test that requires a 
special test fixture), go to step 4.

• To perform testing on specific subsystems, go to step 5.

4. To select all the subsystems, do the following:

a. Under General, select All.

b. Under What to Test, select the All tests check box. 
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The check boxes of the subsystems under ALL TESTS are automatically selected, 
which ensures that all of the electronic subsystems (that is, power supplies, lenses, ion 
detection system, electronics and RF system) will undergo testing. See Figure 53.

c. Go to step step 6.

5. To test an individual subsystem, select the check box corresponding to that subsystem in 
the What to Test area.

6. Click Start to start the diagnostics.

The LCQ Fleet starts testing and displays a chronological log of all diagnostic tests in the 
Testing box. Once testing for a specific subsystem is complete, the LCQ Fleet displays either a 
Pass (green check mark) or a Fail (red X) in the Result group box. If the LCQ Fleet diagnostics 
indicate a problem, follow the maintenance procedure as instructed by one of the following: 
a) the LCQ Fleet diagnostics, b) Thermo Scientific Technical Support, c) a Thermo Scientific 
Customer Support Engineer. For more information on the LCQ Fleet diagnostics, refer to the 
LCQ Fleet online Help.

Figure 53. Diagnostics dialog box showing All Tests checked.

Replacing a Fuse 
Fuses protect the various circuits by opening the circuits whenever overcurrent occurs. On the 
MS detector the fuses are located on the Interlock PCB and Source PCB. The function and 
current rating of the various fuses are listed in Table 11.

Tests Button
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Check fuses when power is lost to a fused subsystem. 

Replacing Power Supplies 
The LCQ Fleet uses the following power supplies. They are easily accessed from the front of 
the LCQ Fleet if service or replacement is needed. See Figure 54. 

• PS1 power supply (P/N 97055-60014S)

• PS2 power supply (P/N 97055-60015S)

• 8 kV power supply (P/N 97355-60003)

CAUTION  Before you replace fuses, always shut down the system and disconnect the 
power cord 

Use only the fuses specified in Table 11. Never replace a fuse with a fuse of a different 
type, voltage, or current rating.

Table 11. MS detector fuses 

Location Fuse Circuit Description Part Number

Interlock PCB F1,F3 APCI vaporizer heater 3.15 A, Type F, 
5 × 20 mm, 250 V

00006-10510

Interlock PCB F2, F4 220 Vac 6.3 A, 250 V 00006-11450

Source PCB F3 4.0 A, 250 V 00006-11420
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Figure 54. Power supplies

To replace the power supplies

1. Shut down and vent the system as described in “Shutting Down the System Completely” 
on page 113.

2. Open the right front door of the MS detector by loosening the Allen screw on the right 
door. 

3. If necessary, remove the left front cover as follows:

a. If necessary, remove the Ion Max ion source housing as described in “Removing the 
Ion Max Ion Source Housing” on page 77.

b. Unscrew the two fasteners that secure the left front cover to the vertical beam.

c. Move the left front cover up by 0.2 in., and then pull it out enough to access the 
cables that connect to the back.

d. Disconnect the cables and remove the cover.

4. If necessary, remove the vertical beam.

5. To remove a power supply, loosen the fastener that holds it to the chassis and then 
carefully tug on the power supply to remove it as a module.

PS1 
Power Supply 

PS2 
Power Supply 

8 kV 
Power Supply 

CAUTION  Make sure to unplug the LCQ Fleet power cord before you proceed.
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The power supplies in the Power Supply Housing have bulkhead connectors on the back.

6. Unpack the new power supply. Retain the packing materials so that you can pack and 
ship the defective switching power supply assembly to theThermo Scientific Repair 
Center in San Jose. Be sure to note the apparent problem or symptoms on the enclosed 
forms.

7. Slide the new power supply into the space that the old power supply once occupied. Push 
carefully on the power supply to seat the connectors in the back.

8. Tighten the fastener that holds the power supply to the tower.

9. If necessary, reinstall the vertical beam if you removed it in step 4.

10. If necessary, reinstall the left front cover if you removed it in step 3 as follows:

a. While holding the left front cover next to the left side of the MS detector, reconnect 
the cables to the back of the cover.

b. Reinstall the left front cover on the MS detector and tighten the two fasteners that 
secure the left front cover to the vertical beam.

c. If necessary, reinstall the Ion Max ion source as described in “Reinstalling the Ion 
Max Ion Source Housing” on page 85.

11. Close the right front door of the MS detector. Tighten the Allen screw on the right front 
door.

12. Restart the system as described in “Starting the System after a Complete Shutdown” on 
page 115.

13. Run the LCQ Fleet diagnostics to verify that the system is operational.

Replacing PCBs in the MS Detector
The LCQ Fleet electronic assemblies are close-packed to minimize the size of the system. 
Because of the complexity of removing and reinstalling many of the LCQ Fleet PCBs, we 
recommend that a Thermo Scientific Field Service Engineer replace and reinstall the 
electronic assemblies.

Figure 55 shows the PCBs in the MS detector. 

CAUTION  Shut down the system and unplug the power cord before you access PCBs and 
electronic assemblies. 
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Figure 55. MS detector PCBs

CAUTION  To prevent damage to the electronics from electrostatic discharge, attach an 
electrostatic discharge (ESD) strap to your wrist before handling PCBs.

Distribution PCB

Detect PCB (in box)

Analog PCB

Digital PCB

Source PCB

Top PCB &
Electrometer PCB
(under their 
respective plates)
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Replaceable Parts

This chapter contains part numbers for replaceable and consumable parts for the mass 
spectrometer, data system, and kits. To ensure proper results in servicing the LCQ Fleet 
system, order only the parts listed or their equivalent. 

This chapter contains the following sections:

• MS Detector

• Manuals

• MS Accessory Kit

• Special LXQ/LCQ Fleet Trap Accessory Kit

• Metal Needle Kits

• Fittings, Ferrules, Sample Loops, Unions, and Tubing

• Chemicals Kit

Note  Not all parts are available for purchase separately. Some parts may be only available 
for purchase as part of a kit or assembly.

Some parts are also available as exchange parts. An exchange part is a refurbished part that 
can be purchased at a discounted price. Exchange parts are specified by the EX in front of 
the part number. for example, EX00108-01-00004.
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MS Detector
Replaceable parts are available for the following:

• ESI Source

• APCI Source

• Ion Source Interface

• Q00 RF Lens

• Q0 and Q1 Ion Guides

• Mass Analyzer

• Electron Multiplier

• Coil Module

• Divert/Inject Valve

• Syringe Pump

• Turbomolecular Pump

• Forepump

• Pressure Gauges

• Vacuum Accessories

• Vacuum Manifold O-Rings

• Vent Valve

• Power Supplies

• Printed Circuit Boards (PCBs)

• Cables

• Fans 
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Please note that not all parts are available for purchase separately, some parts may only be 
available for purchase as part of a kit or assembly. Figure 56 shows an exploded view of the 
ESI probe.
ESI Probe . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . OPTON-20011

Body-probe manifold,. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-20300
Nozzle-ESI probe 3-port, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-20146
Fitting, union, ZDV, 1/4-28, PEEK, black,  . . . . . . . . . . . . . . . . . . . . . . .  00109-00304
Contact, Battery, BECU, 0.598 mml, 0.02 ohm@4A,  . . . . . . . . . . . . . . .  00004-21402
Seal STD needle 5000 series,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00950-00952
Needle, D PNT 26 gauge, 2-in.L, 0.24-in. OD washer, . . . . . . . . . . . . . .  00950-00990
Connector receptacle, high voltage, shielded,  . . . . . . . . . . . . . . . . . . . . . .  00004-89626
Ferrule, 0.012-in. ID (inner bore), KEL-F, HPLC, . . . . . . . . . . . . . . . . . .  00101-18116
Fitting, Fingertight 2 Upchurch,. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00101-18195
Fitting, plug, 1/4-28, TEFZEL, HPLC, . . . . . . . . . . . . . . . . . . . . . . . . . .  00101-18075
O-ring, 0.676-in. ID × 1/16 THK, Viton, . . . . . . . . . . . . . . . . . . . . . . . .  00107-05710
O-ring, 0.125-in. ID × 1/16 THK, Viton, . . . . . . . . . . . . . . . . . . . . . . . .  00107-02550
Assembly-resistor contact-ESI probe,  . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-60058
Resistor FXD CC 1/4W 22M 5%, ROHS . . . . . . . . . . . . . . . . . . . . .  00015-02-00032
Fitting, HPLC adapter, 10-32 × 1/4-28, KEL-F,. . . . . . . . . . . . . . . . . . . .  00101-18080
Tubing, fused-silica, 0.100 mm ID × 0.19 mm OD,  . . . . . . . . . . . . . . . .  00106-10499
Ferrule, 0.008-in. inner bore, KEL-F HPLC, . . . . . . . . . . . . . . . . . . . . . .  00101-18114

Safety Sleeve Kit. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70005-62015
Ferrule, 0.027-in. inner bore, PEEK HPLC,. . . . . . . . . . . . . . . . . . . . . . .  00101-18119
Tube, 0.009-in. ID × 0.024-in OD, 10 inches, natural PEEK, . . . . . . . . .  00301-22806
Fitting, Fingertight 2 Upchurch,. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00101-18195
Fitting, fingertight, HPLC, 10-32, PEEK,  . . . . . . . . . . . . . . . . . . . . . . . .  00101-18081
Fitting, internal union for 1/16-in. OD tubing, stainless steel. . . . . . . . . . 00101-18182
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Figure 56. Exploded view of the ESI probe
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Figure 57. Replaceable parts for the ESI probe
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APCI Source

Figure 58, Figure 59, Figure 60, and Figure 61 contain diagrams of the APCI probe.
APCI probe, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . OPTON-20012
APCI probe nozzle assembly,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-60089

Ferrule, 0.016-in. ID, for 0.36 mm OD fused silica tubing, 
PEEK HPLC,. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00101-18120

Tubing, fused silica, 0.15 mm ID × 0.363 mm OD,. . . . . . . . . . . . . . . . .  00106-10498
O-ring, 0.239-in. ID × 1/16 THK, Viton, . . . . . . . . . . . . . . . . . . . . . . . .  00107-04000
O-ring, 0.312-in. ID × 1/16 THK, red silicone . . . . . . . . . . . . . . . . . . . .  00107-04500
O-ring, 0.500-in. ID × 1/16 THK, Viton, . . . . . . . . . . . . . . . . . . . . . . . .  00107-05600
Fitting, 10-32 male nut, PEEK,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  70005-20220
Fitting, APCI flange,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  70005-20250
Nozzle, APCI probe,. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-20221

APCI probe assembly  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97055-97090
Thermocouple, K-type, 1/16 × 3-in. l, stainless steel sheath . . . . . . . . . . .  00007-89207 
O-ring, 0.625-in. ID × 1/16-in. THK, Viton . . . . . . . . . . . . . . . . . . . . . .  00107-05700
O-ring, 0.875-in. ID × 1/16-in. THK, Viton . . . . . . . . . . . . . . . . . . . . . .  00107-05800 
O-ring, 1.375-in. ID × 1/16-in. THK, Viton . . . . . . . . . . . . . . . . . . . . . .  00107-05904
Heater, 250-300W, ceramic, 0.424-in. OD × 2.8-in. l  . . . . . . . . . . . .  00201-99-00011
Clip, Thermocouple . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-20176 
Tube, heater shield . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97055-20233 
Assembly, feedthrough, APCI probe . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-60087
Assembly, nozzle, APCI probe-USI. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-60089

Figure 58. APCI probe assembly (OPTON-20012)
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Figure 59. APCI probe nozzle assembly (P/N 97055-60089)
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Figure 60. Assembly drawing of the APCI probe
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Figure 61. Assembly drawing of the APCI probe
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Ion Source Interface
Ion Source Interface Assembly . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97055-60181

Contact socket for 0.048 × 0.064D pin,  . . . . . . . . . . . . . . . . . . . . . . . . . 00004-89652
O-ring, 2-in. ID × 1/16 THK, 2-033 Viton V884, . . . . . . . . . . . . . .  00107-01-00006 
O-ring, 2.625-in. ID × 3/32 THK, AS-146, Viton, . . . . . . . . . . . . . . . . .  00107-11002 
O-ring, 2.612-in. ID × 3/32 THK, 2-039 Viton,  . . . . . . . . . . . . . . . . . . 00107-12550 
O-ring, 0.325-in ID × 1/16 THK, Graphite Vespel . . . . . . . . . . . . . . . . .  97055-20442 
Plunger ball, 6-40 × 0.31, 1lb, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00201-11719 
Screw, socket, 2-56 × 3/16, stainless steel,  . . . . . . . . . . . . . . . . . . . . . . . .  00419-25603 
Screw, 4-40 × 3/8-in., socket head cap, vented, stainless steel,  . . . . . . . . .  00419-44014 
Screw, socket, 6-32 × 1-in., stainless steel,  . . . . . . . . . . . . . . . . . . . . . . . .  00419-63216 
Screw, set, socket, 6-32 × 7/8-in., alloy, A574, . . . . . . . . . . . . . . . . . . . . .  00451-63278 
Screw, 2-56 × 3/32, socket head, stainless steel, . . . . . . . . . . . . . . . . . . . .  00452-25612 
Seal, graphite source heater, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  70111-20216 
Thumbnut, knurled, 6-32, UNC . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-20033
Seal, API cone, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-20034 
Cone, API source (sweep cone), . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-20035 
Ring, contact, support,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-20503 
Capillary heater assembly,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-60176 
Bushing, nose cone insulator, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-20074 
Cage, capillary heater mount,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-20065 
Ion transfer capillary, 500 micron, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-20517 
Clamp socket,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-20203 
Ion sweep cone, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-20214 
Tube lens,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-20463
Skimmer, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-20516
Offset, 0.050-in, LTQ Lite . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97055-20459
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Figure 62. Ion source interface (front)

97055-20065

00107-01-00006

97055-20034

97055-20035

97055-2021497055-20442

97055-20517

00107-12550

70111-20216
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Figure 63. Ion source interface (back)

97055-20065

97055-20074 (3x)
00419-63216 (3x)

00107-11002

97055-60176

97055-20033 (2x)

97055-20503

Capillary Heater 
Mount Cage

Capillary Heater Assembly

Contact Support Ring

00201-11719 (4x)

00419-44014

97055-20463

97055-20516

00451-63278 (2x)

97055-20459

Contact (2x)
00419-25603 (2x)

00452-25612 (2x)

Unknown

97055-20203 (2x)
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Q00 RF Lens

Figure 64 shows the replaceable parts for the Q00 RF lens.
Q00 Device Assembly . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-60180

O-ring, 0.101-in. ID × 0.070-in. THK, Viton, . . . . . . . . . . . . . . . . . . . . 00107-02456
O-ring, 2.737-in. ID × 3/32-in. THK, Viton 884,  . . . . . . . . . . . . . . . . . 00107-15542
Plunger ball, ¼-20 × 0.53, 4lb,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00201-11716
Plunger ball, 6-40 × 0.31, 1lb, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00201-11719
Screw, socket HD, CAP, 4-40 × 3/8, stainless steel,  . . . . . . . . . . . . . . . . . 00419-44010
Cage, outer contact support,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97055-20459
Latch block, probe housing, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-20128 
Device, Combo Q00/L0, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-20502 

Figure 64. Q00 Device (RF Lens) part numbers

00107-15542

97055-20502

00201-11716 (3x)

00419-44010 (2x)

97055-20067

97055-20459

97055-20128 (2x)

00201-11719 (3x)
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Q0 and Q1 Ion Guides
Thumb screws, 10-32,. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97000-20235
Lens L1,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-20022
Gate lens,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-20482
Multipole bracket, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-20054
Q1 octapole, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-60154
Q0 quadrupole,. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-60035
Trap Mount, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-20372

Figure 65. Q0 and Q1 ion guides part numbers 

Q1 Octapole 
(P/N 97055-60154)

Q0 Quadrupole 
(P/N 97055-60035)

Lens L1
(P/N 97055-20022)

Trap Mount
(P/N 97055-20372)

Gate Lens
(P/N 97055-20482)

Multipole Bracket
(P/N 97055-20054)

Thumbscrews, 10-32
(P/N 97000-20235)
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Mass Analyzer
Mass analyzer assembly, for Ultralite,. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-60164

Mount, 3D trap . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-20372
Post analyzer, LCQ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97000-20338
Endcap, tipped . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-20717
Spacer, 3D trap. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-20718
Electrode, RF ring, DE  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97144-20043
Washer, spring, 0.33-in. ID × 0.49-in. OD, stainless steel  . . . . . . . . . . . .  00474-11618
Nut, analyzer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97000-20339
Sleeve, exit lens . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97044-20001 
Exit lens . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97000-20205
Sleeve, entrance lens . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97044-20002
Entrance lens  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97044-20003
Nipple, helium . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  96000-20117 

Figure 66. Mass analyzer exploded view 

Analyzer Nut (2)
P/N 97000-20339

Spring Washer (2)
P/N 00474-11618

Quartz spacer 
rings
P/N 97055-20718

Exit Endcap Electrode
97055-20717

Ring Electrode
P/N 97144-20043

Analyzer post (2)
P/N 97000-20338

Exit Lens
P/N 97000-20205

Exit Lens Sleeve
P/N 97044-20001

3D trap mount
P/N 97055-20372

Entrance lens
P/N 97044-20003

Helium Nipple
P/N 96000-20117

Exit Endcap Electrode
97055-20717
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Electron Multiplier
Electron multiplier assembly,. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  96000-60036

Multiplier, electron insert . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00022-02400 
Washer, wave, 0.731-in. OD × 0.588-in. ID, CS . . . . . . . . . . . . . . . . . . .  00471-50080 
Screw, panhead, 2-56 × 1/4-in., vented, stainless steel. . . . . . . . . . . . . . . . 00452-25605

Figure 67. Assembly drawing of the electron multiplier

Coil Module
RF coil and PCB Assembly, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-60218

Assembly, RF coil wound, 3D trap . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-60217 
Assembly, contact, RF detector, 10 kV . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-60174 

Divert/Inject Valve 
Divert/inject valve (Rheodyne, 2 position, 6 port), . . . . . . . . . . . . . . . . . .  00110-03-00001
KIT, rebuild, divert six-port, 7900, LTQ . . . . . . . . . . . . . . . . . . . . . . . . . . .00110-03-00002

Syringe Pump
Syringe pump,. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-98006

Turbomolecular Pump
Turbomolecular pump insert (Leybold TW 220/150/15),

(available as an exchange) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . EX00108-01-00004
Turbomolecular pump controller (Leybold TDS),. . . . . . . . . . . . . . . . . . . . . .  00108-10012

Panhead screws (3)
P/N 00452-25605

Wave washer
P/N 00471-50080

Multiplier electron insert
P/N 00022-02400
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Forepump
Forepump Kit, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  70111-62014 

Forepump (mechanical pump), E2M30, 
650 L3/min, 220V AC, (available as an exchange) . . . . . . . . . . . . . . . 00108-02655

Vacuum hardware clamp, KF-20/25,  . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00102-10020
Pump hardware centering ring, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00108-02011
Mist Filter,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00108-02-00002
Hose clamp, band,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00201-03810
Clamp, high-torque, 1 1/4-in. to 2 1/8-in., stainless steel . . . . . . . . . . .00201-99-00056
PVC vacuum hose reinforced, 1.5-in ID, . . . . . . . . . . . . . . . . . . . . . . . . .  00301-24163
Drain oil return kit,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00960-01-00007
Adapter, pump roughing line, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  70111-20210

Pressure Gauges
Convectron gauge,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00105-00501
Kit, ion gauge,. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-62001S

Vacuum Accessories
Hose and Accessories Kit, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-62007

PVC vacuum hose reinforced, 1.5-in. ID,. . . . . . . . . . . . . . . . . . . . . . . . .  00301-24163
Adapter, for mechanical pump hose, NW-40 × 1.515-in. OD  . . . . . . . . .  97055-20714
Flange, NW40, long,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00108-02-00003
Clamp, NW32/40, swing,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00108-02-00004
Ring, centering,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00108-02-00005
Adaptor, pump roughing line,. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  70111-20210
Hose clamp, band,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00201-03810
Clamp, high-torque, 1.25-in. to 2.125-in., stainless steel  . . . . . . . . . . .00201-99-00056
Pump hardware centering ring, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00108-02011
Vacuum hardware clamp KF-20/25, . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00102-10020

Vacuum Manifold O-Rings

Figure 68 shows the vacuum manifold O-rings.

O-ring, 0.31-in. ID × 1/16-in. THK, Viton . . . . . . . . . . . . . . . . . . . . . . . . . .  00107-05000
O-ring, 4.5-in. ID × 1/8-in. THK, Viton,  . . . . . . . . . . . . . . . . . . . . . . . . . . .  00107-14500
O-ring, 6.48-in. ID × 1/8-in. THK, Viton,  . . . . . . . . . . . . . . . . . . . . . . . . . .  00107-15270
O-ring, 7.734-in. ID × 1/8-in. THK, Viton,  . . . . . . . . . . . . . . . . . . . . . . . . .  00107-15544
O-ring, 5.86-in. ID × 1/8-in. THK, Viton,  . . . . . . . . . . . . . . . . . . . . . . . . . .  00107-15550
O-ring, split chamber, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-40005
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Figure 68. Vacuum pump O-rings

Vent Valve
Vent valve assembly, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-60084

O-ring, 0.468-in. ID × 0.078-in. THK, Viton  . . . . . . . . . . . . . . . . . . . . 00107-07600
Fitting, swage, O-seal, 1/4-in. OD tube, 7/16-20 . . . . . . . . . . . . . . . . . . . 00101-13510
Fitting, swage, fractional tube adapter to male pipe, NPT, 

1/4-in. OD tube, 1/8-in. male pipe size . . . . . . . . . . . . . . . . . . . . . . . 00101-01740
Filter, sintered nylon  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00201-06050
Ribbon dope, 1/4-in. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00301-16501
Valve, two-way, normal open, 24 V, 1 W, coil, 1/8-in. NPT . . . . . . . .  00110-02-00001

O-ring, 4.5-in. ID
(P/N 00107-14500)

O-ring, Split Chamber
(P/N 97055-40005

O-ring, 5.86-in. ID
(P/N 00107-15550)

O-ring, 7.734-in. ID
(P/N 00107-15554)
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PS1, +60 V (6 A), +5 V (35 A), ±15 V (14 A),  . . . . . . . . . . . . . . . . . . . . . . . .  97055-60014
PS2, +36 V (10 A), ±24 V (8.5 A), +28 V (6.7 A),  . . . . . . . . . . . . . . . . . . . . .  97055-60015
8 kV Power Supply, mounted  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97355-60003
15 kV dual Electron Multiplier/Conversion Dynode power supply,. . . . . . . . .  97055-98043
Assembly, AC power module, single mechanical pump . . . . . . . . . . . . . . . . . . 97055-60133
Assembly, I/O board, Endeavor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97055-61070
PCB assembly, surge absorber . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70005-61090
PCB assembly, interlock, Quantum. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70111-61060S
PCB assembly, adapter, L-connector, power module . . . . . . . . . . . . . . . . . . . . 97055-61080

Printed Circuit Boards (PCBs)
Source PCB (available as exchange),  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  70111-61053S
Interlock PCB,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  70111-61060S
Digital PCB (available as exchange), . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-61013S
Distribution PCB,. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-61025
Analog PCB (available as exchange), . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-61033S
Top Cover PCB. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97355-61040S
I/O PCB,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-61070S
Front Panel PCB,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-61110
Electrometer PCB,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-61170S
Low Pass Filter/Balun PCB . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97055-61421
Divert/Inject Valve PCB,. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-61140
RF Amplifier PCB, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-61180S
PCB assembly, surge absorber . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70005-61090
PCB assembly, adapter, ELCON, PMOD. . . . . . . . . . . . . . . . . . . . . . . . . . . . 97055-61080
Assembly, PCB, syringe control and status display. . . . . . . . . . . . . . . . . . . . . . 97055-61414
Assembly, PCB, single detector . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97055-61430
Assembly, PCB, RFA adapter  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97055-61150

Cables
Ethernet (Power Module) to Digital PCB,. . . . . . . . . . . . . . . . . . . . . . . . . . . .  00012-70064
Power Module wire set, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-63003
Interlock PCB to Power Module bulkhead, . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-63004
Interlock PCB 220 Vac In,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-63006
I/O PCB to Power Module Elcon adapter,  . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-63008
Power module, +36/-28 Volt RF Amp Inhibit,  . . . . . . . . . . . . . . . . . . . . . . . .  97055-63010
Convectron gauge to Power/Signal Distribution PCB,  . . . . . . . . . . . . . . . . . .  97055-63016
Status Display/ Front Panel,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-63018
Divert Valve PCB to Divert Valve,. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-63020
Manifold Flange to Power/Signal Distribution PCB,. . . . . . . . . . . . . . . . . . . .  97055-63022
RF Detect Sport to Power/Signal Distribution PCB, . . . . . . . . . . . . . . . . . . . .  97055-63024
RF Amplifier Control to Power/Signal Distribution PCB,. . . . . . . . . . . . . . . .  97055-63026
RF Amplifier Power to Power/Signal Distribution PCB, . . . . . . . . . . . . . . . . .  97055-63028
Source & Top Cover SPI to Power/Signal Distribution PCB,  . . . . . . . . . . . . .  97055-63030
Thermo Scientific LCQ Fleet Hardware Manual 153



7 Replaceable Parts
Manuals

154
Vent, Turbo & Fans to Power/Signal Distribution PCB, . . . . . . . . . . . . . . . . .  97055-63032
Daisy, Cooling Fans (3),  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-63033
Dual Dynode / Electron Multiplier Supply to 

Power/Signal Distribution PCB, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-63037
Elcon, Power to Power/Signal Distribution PCB,  . . . . . . . . . . . . . . . . . . . . . .  97055-63038
Elcon, System Signals to Power/Signal Distribution PCB, . . . . . . . . . . . . . . . .  97055-63040 
PS2 to Elcon Connector, Sled,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-63042 
PS1 to Elcon Connector, Sled,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-63044 
Cable, molded RCA, straight-to-90 plug,1  . . . . . . . . . . . . . . . . . . . . . . . . . . . 97055-98108
Analog PCB to Top Cover PCB, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-63048 
Interlock (AC Power Module) to Source PCB,  . . . . . . . . . . . . . . . . . . . . . . . .  97055-63050 
Turbomolecular pump, RS485 to Digital PCB,. . . . . . . . . . . . . . . . . . . . . . . .  97055-63052 
Analyzer Electrometer to Digital PCB,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-63056 
Coaxial, LPF to RF Amplifier,. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-63060 
RF Amp Modulation to RF Detector, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-63062 

Fans
Fan, 100 CFM, 24V dc, located on fan housing assembly 

and on the coil box,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00013-00243 
Fan, 21 CFM, 24V dc, located adjacent 

to the turbomolecular pump,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-63083 
Fan filter,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-20254 

Manuals
The following manuals for the LCQ Fleet MS detector are provided on the instrument 
control software CD.

• LCQ Fleet Preinstallation Guide (LCQFleet_Install.pdf )

• LCQ Fleet Getting Connected Guide (LCQFleet_Connect.pdf )

• LCQ Fleet Getting Started Guide (LCQFleet_Start.pdf )

• LCQ Fleet Hardware Manual (LCQFleet_Hardware.pdf )

To open the PDF files

1. From the Windows XP Start menu, choose All Programs > Xcalibur > Manuals > LCQ 
Fleet.

2. Click the PDF for the manual that you want to view.
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MS Accessory Kit
Kit, MS accessory  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70111-62034

Container, shipping, accessory kit, large . . . . . . . . . . . . . . . . . . . . . . . . . . 70111-98271
Syringe, 500 μL, gas tight, removable needle, (2 each) . . . . . . . . . . . . . . . 00301-19016
Tube, hypodermic, 28-gauge  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00106-20000
Fuse, 1.00 A, 5x20, 250 V, quick acting . . . . . . . . . . . . . . . . . . . . . . . . . . 00006-07610
Fuse, 4 A, 5 × 20 mm, 250 V, time lag  . . . . . . . . . . . . . . . . . . . . . . . . . .  00006-11420
Fuse, 0.16 A, 250 V, 5 × 20 mm. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00006-01700
Fuse, 0.4 A, 250 V, 5 × 20 mm. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00006-05080
Fuse, 0.25 A, 250 V, 5 × 20 mm. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00006-11204
Fuse, 0.500 A, 250 V, 5 × 20 mm, quick acting . . . . . . . . . . . . . . . . . . . . 00006-07608
Fuse, 3.15 A, 250 V, 5 × 20 mm. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00006-10510
Fuse, 6.3 A, 250 V, slo-blo, 5 × 20 mm, low breaking capacity,

ROHS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00006-11450
Fuse, 1.0 A, 250 V, time lag, microfuse  . . . . . . . . . . . . . . . . . . . . . . . . . . 00006-14015
Fuse, micro, 2 A, time lag, 250 V, short leads  . . . . . . . . . . . . . . . . . . . . .  00006-09102
Fuse, micro, 4 A, time lag, 250 V, short leads  . . . . . . . . . . . . . . . . . . . . .  00006-10705
Fitting, HPLC adapter, 10-32 × 1/4 PEEK. . . . . . . . . . . . . . . . . . . . . . . .  00101-18080
Fitting, ferrule, Swagelok, front, for 1/4-in. tubing (2 each) . . . . . . . . . . .  00101-10000
Fitting, ferrule, Swagelok, back, 1/4 (2 each)  . . . . . . . . . . . . . . . . . . . . . . 00101-04000
Fitting, ferrule, Swagelok, back, 1/8 (2 each)  . . . . . . . . . . . . . . . . . . . . . . 00101-02500
Fitting, ferrule, Swagelok, front, 1/8 (2 each) . . . . . . . . . . . . . . . . . . . . . .  00101-08500
Septa, Supelco Thermogreen™, LB-1, 9.5 mm (3 each). . . . . . . . . . . . . . .  00301-16999
Fitting, nut, fingertight, HPLC,10-32, PEEK (3 each) . . . . . . . . . . . . . . . 00101-18081
Fitting, HPLC, Tee, 0.02-in. orifice, PEEK  . . . . . . . . . . . . . . . . . . . . . . .  00101-18204
Fitting, HPLC,10-32, short 1-piece, 10/pkg, ROHS (6 each)  . . . . . . .00109-99-00016
Fitting, Swagelok nut, for 1/8-in. OD tubing, brass (2 each)  . . . . . . . . . . 00101-15500
Fitting, ferrule, for 1/8-in. OD tubing, short, Tefzel (2 each) . . . . . . . . . .  00101-18223
Seal, ring, graphite vespel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97055-20442
Ferrule, fingertight 2, Upchurch, (8 each). . . . . . . . . . . . . . . . . . . . . . . . .  00101-18196
Ferrule, 0.008-in. ID, Kel-F HPLC (4 each). . . . . . . . . . . . . . . . . . . . . . .  00101-18114
Fitting, fingertight 2, Upchurch (4 each) . . . . . . . . . . . . . . . . . . . . . . . . .  00101-18195
Tubing, fused-silica, 0.150 mm × 0.390 mm (3 unit of length)  . . . . . . . . 00106-10498
Tubing, fused-silica, 0.05-in. ID × 0.19-in. OD (3 ft. length)  . . . . . . . . .  00106-10502
Tubing, fused-silica, 0.10-in. ID × 0.19-in. OD (12 ft. length)  . . . . . . . .  00106-10499
Syringe, adapter kit  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  70005-62011
Tubing, red PEEK, 0.005-in. ID × 1/16-in. OD (10 ft. length) . . . . . . . . 00301-22912
Tube, Teflon, 0.03-in. ID ×1/16-in. OD  . . . . . . . . . . . . . . . . . . . . . . . . .  00301-22915
Tool, capillary removal, Quantum . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  70111-20258
Fitting, Swagelok, nut, for 1/4-in. OD tubing, brass (2 each) . . . . . . . . . .  00101-12500
Needle, corona, APCI (3 each) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  70005-98033
Adaptor, drain hose  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  70111-20971
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Special LXQ/LCQ Fleet Trap Accessory Kit
This kit is shipped with the LXQ and the LCQ Fleet MS detectors.
Kit, Accessory, special for LXQ TRAP . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97055-62045 

Cable, assembly, adapter, LC/MS interconnect . . . . . . . . . . . . . . . . . . . . .  97055-63070
Capillary, 500 μm, 4.87-in. length  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97055-20517
Kit, chemicals, LCQ. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97000-62042
Wrench, Allen/Hex, 1/4-in., BP/W-handle  . . . . . . . . . . . . . . . . . . . . . . .  00725-00022
Seal, standard needle, 5000 series . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00950-00952
Needle, D point, 26 gauge, 2-in. length, 0.24-in. D washer . . . . . . . . . . .  00950-00990
Container, shipping, accessory kit, small  . . . . . . . . . . . . . . . . . . . . . . . . .  70111-98272
Cable, assembly, adapter, LC/MS, LTQ/LXQ interconnect 

(for the LTQ, LXQ, and LCQ Fleet MS detectors)  . . . . . . . . . . . . . .  60053-63037

Metal Needle Kits
High Flow Needle Kit,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . OPTON-20004
(Recommended for LC flow rates between 5 and 400 μL/min)

Ferrule, 0.012-in. ID, Kel-F . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00101-18114
Ferrule, 0.008-in. ID, Kel-F . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00101-18116
Fitting, Fingertight 2, Upchurch. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00101-18195
Fitting, union, ZDV, 1/4-28, PEEK, black . . . . . . . . . . . . . . . . . . . . . . . . 00109-00304
Blunt-tip, 32-gauge, 50 μm ID, stainless steel needle . . . . . . . . . . . . . . . .  70111-20287

Low Flow Metal Needle Kit  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . OPTON-20005
(Recommended for LC flow rates between 500 nL/min and 10 μL/min)

Ferrule, 0.012-in. ID, Kel-F . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00101-18114
Ferrule, 0.012-in. ID, Kel-F . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00101-18116
Fitting, Fingertight 2, Upchurch  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00101-18195
Fitting, union, ZDV, 1/4-28, PEEK, black . . . . . . . . . . . . . . . . . . . . . . . . 00109-00304
Blunt-tip, 34-gauge, 30 μm ID, stainless steel needle . . . . . . . . . . . . . . . .  70111-20288

Fittings, Ferrules, Sample Loops, Unions, and Tubing
Ferrule, Fingertight 2, Upchurch. 

(for PEEK tubing and Teflon tube), . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00101-18196
Ferrule, 0.016-in. ID, PEEK, Upchurch 

(for fused-silica capillary infusion line),  . . . . . . . . . . . . . . . . . . . . . . . . . .  00101-18120
Ferrule, 0.012 in. ID, Kel-F, Upchurch 

(for high flow metal needle and low flow metal needle), . . . . . . . . . . . . . .  00101-18114
Ferrule, 0.008 in. ID, Kel-F, Upchurch 

(for Fused-silica capillary sample line), . . . . . . . . . . . . . . . . . . . . . . . . . . .  00101-18116
Ferrule, LC, 1/16 in., stainless steel, Rheodyne, . . . . . . . . . . . . . . . . . . . . . . . . .  2522-3830
Fitting, Fingertight, Upchurch,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00101-18195
Fitting, Fingertight, Upchurch,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00101-18081
Fitting, adapter, Kel-F, 10-32 × 1/4-28, Upchurch 

(connects directly to ESI probe inlet),  . . . . . . . . . . . . . . . . . . . . . . . . . . .  00101-18080
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Nut, LC, 1/16 in., stainless steel, Rheodyne,  . . . . . . . . . . . . . . . . . . . . . . . . . . .  2522-0066
Fitting, LC union, 0.010-in. orifice, PEEK, . . . . . . . . . . . . . . . . . . . . . . . . . .  00101-18202
Fitting, LC TEE union, 0.020-in. orifice, PEEK, . . . . . . . . . . . . . . . . . . . . . .  00101-18204
Fitting, adapter union, PEEK, Upchurch,  . . . . . . . . . . . . . . . . . . . . . . . . . . .  00101-18206
5 μL sample loop, stainless steel, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00110-22010
10 μL sample loop, stainless steel, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00110-22012
20 μL sample loop, stainless steel, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00110-22014
50 μL sample loop, stainless steel, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00110-22016
100 μL sample loop, stainless steel, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00110-22018
500 μL sample loop, stainless steel, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00110-22020
1 mL sample loop, stainless steel,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00110-22022
Tubing, 0.15 mm ID × 0.39 mm OD fused-silica capillary 

(APCI sample tube),  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00106-10498 
Tubing, 0.10 mm ID × 0.19 mm OD fused-silica capillary 

(ESI sample tube), . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00106-10499 
Tubing, 0.05 mm ID × 0.19 mm OD fused-silica capillary

(low flow ESI < 200 μL/min),  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00106-10502
Tubing, 0.1 mm ID × 0.363 mm OD fused-silica capillary 

(infusion line),  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00106-10504 
Tubing, 0.075 mm ID × 0.3193 mm OD fused-silica capillary 

(low flow ESI), . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00106-10511
Teflon tube (for syringe adapter assembly), . . . . . . . . . . . . . . . . . . . . . . . . . . . 00301-22915 

Chemicals Kit
Chemicals Kit,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97000-62042 

Met-Arg-Phe-Ala, 20 mg,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00301-07709 
Ultramark 1621,  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00301-12200 
Caffeine, 1 mg/mL, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00301-12310 
Reserpine, 1 g, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  00301-12901

CAUTION  Store and handle all chemicals in accordance with standard safety procedures. 
The Material Safety Data Sheets (MSDS) describing the chemicals being used are to be 
freely available to lab personnel for them to examine at any time.
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Index
A
accessory kit, replaceable parts   155
air leaks, checking for   59
analyzer region, vacuum manifold description   42
anode of electron multiplier, description   39
APCI probe

flushing   61,  72
orthogonal geometry   7

APCI source status   120
API source

control circuitry   51
description   29
ion source interface   31
maintenance overview   72
status   120

atmospheric pressure chemical ionization (APCI)   6
atmospheric pressure photoionization (APPI)

discussed   8
energetics   9
selective photoionization   10

autosampler
description   23
startup   116

auxiliary gas
description   47
flow rates, APCI   47
flow rates, ESI   47

B
Breadth Focus in Ion Tree experiment   20

C
cables, replaceable parts   153
calibration

checking   57
frequency   57

capillary-skimmer region, vacuum manifold   42
cartridge, turbomolecular pump   109
cathode, electron multiplier   38

CAUTIONS
APCI vaporizer high temperature   64
fuse replacement   131
ion source interface temperature   79,  81
nitrogen supply   58
solvent waste backing into ion source housing   86
venting ESI source   86

centroid scan   16
charge state, determined by ZoomScan   15
chemicals kit, replaceable parts   157
cleaning procedures

APCI probe, flushing   61,  72
API probe   61,  72
conversion dynode   99
electron multiplier   99
ESI probe, flushing   61,  72
fan filter   110
frequency   71
ion detection system   99
ion sweep cone   72
ion transfer capillary   63,  72
lenses L1   91
Q0 and Q1 ion guides   91
sample transfer line   61,  72
sample tube   61,  72
skimmer   79
sweep cone   63
tube lens   79
vacuum manifold   100

Communication LED
MS detector reset   118
MS detector startup   116
states   27

consecutive reaction monitoring (CRM)   14
Convectron gauge

control circuitry   51
description   46
status   120
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Index: D
conversion dynode
cleaning   99
control circuit   51
description   38
shield   38
status   120

cooling fans   47
covers

top, reinstalling   100
top, removing   91

cross sectional views
electron multiplier   40
ion detection system   40

D
daily maintenance

API probe, flushing   61,  72
ion sweep cone, flushing   63,  72
ion transfer capillary, flushing   63,  72
rotary-vane pump oil, purging   66
sample tube, flushing   61,  72
transfer line, flushing   61,  72

daily system checks
air leaks   59
disk space   60
helium supply   58
list   57,  61
nitrogen supply   58
overview   57

damping gas valve   46
damping gas, description   37
data system

LC interface   55
resetting   119
shutdown   114
startup   115

data types   15
Depth Focus in Ion Tree experiments   20
detection system

cathode, electron multiplier   38
conversion dynode   38
voltages   38

disk space, checking   60
divert/inject valve

button and LEDs   29
control circuitry   51
description   25
replaceable parts   149

E
electrical feedthroughs in vacuum manifold   43
electrometer circuit, description   53
electron multiplier

anode   39
cleaning   99
control circuitry   51
cross sectional view   40
description   38,  53
replaceable parts   149
status   120
voltage, setting   108
voltages   38

electronic assemblies
8 kV power supply   49
description   47
ion detection system   53
Low Pass Filter PCB   52
Power Entry Module   48
RF/waveform voltage generation   52
Turbomolecular Pump Controller   45

electronics service switch
component of power entry module   48
description   28

electrospray ionization (ESI)
electrospray process   5
rules for good electrospray   6
solvents   6

electrospray ionization (ESI), description   4
embedded computer, resetting   117
emergency shutdown procedure   111
entrance endcap electrode

description   34
ESI   51
ESI probe

flushing   61,  72
replaceable parts   137

ESI source status   120
experiment types

data-dependent   17
discussion   16
general MS   16
Ion Mapping   19
Ion Tree   20

F
fan filters, cleaning   110
fans status forepump status   120
fans, replaceable parts   154
feedthroughs in vacuum manifold   43
filter, for line power   48
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Index: G
fittings, replaceable parts   156
flow injection analysis   29
forepump

description   45
purging the oil   66

front panel LEDs   27
full scan type

single stage   12
two stage   13

full scan types   12
functional description

autosampler   23
data system   54
divert/inject valve   25
liquid chromatograph (LC)   23
mass analyzer   34
MS detector   26

fuses, MS detector
replacement   130
replacement (CAUTION)   131

G
gate lens   34

H
hard drive, checking disk space   60
helium damping gas   37
helium supply

checking   58
pressure   58

I
inlet gasses hardware

damping gas valve   46
description   47
functional block diagram   41
sheath gas valve   47
vent valve   46

Instrument Configuration window, opening   23
Instrument Setup window, opening   23
ion detection system

cleaning   99
conversion dynode   38
electron multiplier

gain   39
voltage setting   108

electronic assemblies   53
status   120

ion gauge
control circuitry   51
description   46
status   120

ion guides
cleaning   91
Q0 ion guide   33
Q1 ion guide   34
tube lens   31

Ion Max-S ion source   29
ion optics

removing   101
status   120

ion polarity modes   3
ion source interface

cleaning   76
description   31
disassembling (CAUTION)   79,  81
ion transfer capillary, replacing   76
maintaining   76
reinstalling   85
removing   77
replacing components   81
skimmer   31

ion sweep cone
cleaning   75
flushing   63,  72
function   31
reinstalling   65

ion transfer capillary
flushing   63,  72
function   31
heater control circuit   51
removal and cleaning   64
removing and cleaning   73
status   120

Ion Tree experiment
breadth focus   20
depth focus   20

ionization modes
atmospheric pressure chemical ionization (APCI)   6
electrospray ionization (ESI)   4
nanospray ionization (NSI)   11

L
LC/MS system

complete shutdown   113
liquid chromatograph (LC)   23

LCs   24
leaks, checking for   59
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Index: M
LEDs
Communication LED

MS detector startup   116
resetting the MS detector   118
states   27

divert/inject valve LEDs   29
Power LED

MS detector startup   116
resetting the MS detector   118
states   27

Scan LED   27
syringe pump LED   24
System LED

MS detector startup   116
resetting the MS detector   118
states   27

Vacuum LED   27
lens L0, description   33
lenses L1, cleaning   91
line filter, line power   48
line power specifications   48
liquid chromatograph (LC)

description   23
solvent flow, turning off   112
startup   115

Low Pass Filter PCB   52

M
main power circuit breaker   28
main power circuit breaker switch   112
maintenance

API probe, flushing   61,  72
API source, overview   72
fan filters, cleaning   110
frequency   68
ion source interface   76
ion sweep cone, cleaning   72
ion transfer capillary, cleaning   63,  72
ion transfer capillary, removing and cleaning   73
lenses L1 cleaning   91
overview   67
Q0 and Q1 ion guide, cleaning   91
rotary-vane pump oil, purging   66
sample transfer line, flushing   61,  72
sample tube, flushing   61,  72
skimmer, cleaning   79
supplies   70
sweep cone, cleaning   63
tools   70
tube lens, cleaning   79

maintenance, mass spectrometer   68
manuals supplied as PDFs with the software   154

mass analyzer
exit endcap electrode   34
exit lens   34
helium damping gas   37
operation   37
removing   101
replaceable parts   149
status   120

mass spectrometer maintenance procedures   68
metal needle kits, replaceable parts   156
Monitors   51
MS detector

API source   29
calibration parameters   117
covers, caution   47
damping gas valve   46
data system   54
data types   15
electronic assemblies   47
electronics service switch   48
emergency shutdown   111
fans   47
frequency of cleaning   71
functional description   26
fuses, replacing   130
inlet gasses hardware   47
ion detection system electronic assemblies   53
ion gauge   46
ion polarity modes   3
LEDs and system startup   118
mass analyzer   34
off condition   120
on/off status of components   120
operating conditions, setting   117
power distribution schematic   50
power panel   28
replaceable parts   136
reset button   118
resetting   117
RF/waveform voltage generation electronic assemblies   52
scan modes   11
scan types   12
shutdown   113
standby condition   112,  120
startup   115
top cover, reinstalling   100
tune parameters   117
turning off   120
vacuum manifold   42
vacuum system   41
vent valve   46

MS scan mode   11
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Index: N
MS/MS scan mode   11
MS^n scan

consecutive reaction monitoring   14
MS^n scan mode   12

N
nanospray ionization (NSI)   11
nitrogen supply

CAUTION   58
checking   58
pressure   58

nitrogen, rate of consumption   58

O
octapole status   120
O-rings, replaceable parts   151

P
parent   14
parent ions   11
part numbers   135
PCBs

Low Pass Filter PCB, description   52
replaceable parts   153
replacing   133

power cord, forepump   46
power distribution, description   48
Power Entry Module   48
Power LED

description   27
Failure condition   27
MS detector reset   118
MS detector startup   116
Normal condition   27
Warning condition   27

power panel   28,  112
power specifications   48
power supplies

8 kV power supply, description   49
conversion dynode power supply, description   53
electron multiplier power supply, description   53
replaceable parts   153
replacing   131

pressure levels, checking   59
printer, setting up   55
procedures, mass spectrometer maintenance   68
product ions   11
profile scan   16
pumps

forepump   45

turbomolecular pump   44
turbomolecular pump cartridge   109

Q
Q0 ion guide

cleaning   91
description   33

Q0 quadrupole
cleaning   91
description   33

Q00 RF lens
cleaning components   89
description   33
reassembling   90
reinstalling   90
removal (figure)   89

Q1 ion guide
cleaning   91
discussion   34

Q1 octapole, description   34
quadrupoles, description   33
quantitation experiments   16

R
replaceable parts

accessory kit   155
cables   153
chemicals kit   157
divert/inject valve   150
electron multiplier   149
ESI probe   137
fans   154
fittings   156
mass analyzer   149
metal needle kits   156
MS detector   136
O-rings   151
PCBs   153
power supplies   153
sample loops   156
syringe pump   150
turbomolecular pump   150
vent valve   152

replacement procedures
fuses   130
power supplies   131

reset button   112,  118
resonance ejection RF voltage   36
RF lens

Q00 RF lens, description   33
Q00, description   33
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Index: S
RF voltages
ion isolation waveform   36
resonance ejection RF voltage   36
resonance voltage   36
storage voltage   36

ring electrode, description   34

S
sample loop, replaceable parts   156
sample transfer line, flushing   61,  72
sample tube, flushing   61,  72
scan   3
Scan LED   27
scan modes

consecutive reaction monitoring (CRM)   14
scan power   11
scan types

full scan   12
selected ion monitoring (SIM)   13
selected reaction monitoring (SRM)   14
single-stage full scan   12
two-stage full scan   13
ZoomScan   15

selected ion monitoring (SIM)   13
selected reaction monitoring (SRM), defined   14
service switch   28
sheath gas

flow rates, ESI   47
pressure   47

sheath gas valve   47
shutdown

complete shutdown   113
data system   114
emergency procedure   111
MS detector   113

skimmer
cleaning   79
function   31

solvents
cleaning   80
MS detector maintenance   70

spray cone, location   65
standby mode, placing system in   112
startup

autosampler   116
data system   115
liquid chromatograph   115
MS detector   115
operating conditions, setting   117

supplies, MS detector maintenance   70
sweep gas supply port   65

syringe pump
figure   25
replaceable parts   150
Syringe Pump dialog box   24

syringe pump LED, description   24
System LED

MS detector reset   118
MS detector startup   116
status states   27

system shutdown
emergency procedure   111
non-emergency procedure   113

T
three-dimensional ion trap   34
tools, mass spectrometer maintenance   70
top cover of MS detector

reinstalling   100
removing   91

top cover plate of vacuum manifold
figure   43
reinstalling   100
removing   92

troubleshooting diagnostics   123
tube lens

cleaning   79
function   31
status   120

tubing for helium damping gas (figure)   99
Tune Plus window, opening   24
tuning

checking   57
frequency   57
tube lens offset voltage   31

turbomolecular pump
controller   45
replaceable parts   150
replacing insert   109

turbomolecular pump status   120

V
Vacuum LED   27
vacuum levels, checking   59
vacuum manifold

cleaning   100
description   42
top cover plate   43

reinstalling   100
removing   92
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Index: W
vacuum system
checking pressure levels   59
Convectron gauge   46
damping gas valve   46
forepump   45
function block diagram   41
ion gauge   46
sheath gas valve   47
turbomolecular pump   44
vent valve   46

vaporizer, heater control circuit   51
vent valve

description   46
open/closed status   120
replaceable parts   152

voltages
conversion dynode   38
electron multiplier   108
electron multiplier (cathode)   38
ESI needle   49
ion transfer capillary   31
line power specifications   48
Q0 ion guide   33
Q0 offset   33
Q00 offset   33
Q1 ion guide   34
resonance ejection RF voltage   36
resonance voltage   36
storage voltage   36

W
waveform voltages   36,  52
wiring diagram for the Q0 and Q1 ion guides   98

Z
ZoomScan   15

discussion   18
for charge determination   15
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